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CHAPTER 1 Introduction and Installation
1.1  Program Overview

PolySNAP is a software package designed to match and analyse
powder diffraction patterns utilising their full profiles. The use of the
full-profile allows for more flexible and accurate identification of
samples, even when data quality is low or preferred orientation effects
are significant.

The software provides an easy to use interface to several powerful
and novel statistical methods to rank patterns in order of their
similarity to any selected sample, allowing unknowns to be quickly
identified. In quantitative mode, given a mixture pattern and potential
pure phase patterns, it can identify which patterns are in the mixture,
and quantify their proportions quickly and easily using a non-Rietveld
based approach.

The matching procedure can be automated for high-throughput
analysis. PolySNAP allows for datasets of up to 1500 patterns to be
analysed in a single run, and provides highly flexible graphical output
to summarise and visualise the results. This highlights any unusual
data, and means that time is not wasted looking at the very many
patterns that behave exactly as expected. It can work with or without
the provision of reference patterns, and includes features such as an
automated report writer and a time/date stamped logfile to assist with
audit trail procedures. 
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1.2  Introduction

PolySNAP can be run either interactively (the default mode when
launched by a user) or automatically (the default mode when
launched via a command-line). 

Four main stages are involved in a standard program run:

1. Import and processing of data files.

2. Match all data files against all other data files.

3. Perform cluster, quantitative and other analyses if required.

4. Output results to file and graphically to screen.

A flowchart representation of the main PolySNAP processes is
shown overleaf.



Program Operation Overview
1.3  Program Operation Overview

1.4  Program Requirements

PolySNAP requires a modern, high-specification PC running
Microsoft Windows 2000 SP2 or XP SP1 or later. Additionally, a
monitor with minimum 1024 x 768 resolution at 32 bit colour depth
is needed, as is an active connection to the Internet.
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1.4.1  Note on run-times

On a 2.4Ghz Intel Xeon with 512 Mb RAM, running Windows 2000
Professional SP4, some approximate average program run-times are
shown below.

Times are assuming there are no delays waiting for data, and are
measured from launching the program to the results display screen
being displayed:

These times are approximate, and may vary depending on the
analysis options selected for a given program run - in particular,
allowing for an offset in the matching calculations will greatly add to
the run time.

1.5  Installation

If there has been a previous version of the software installed, then it
is recommended to install the new version in a different location than
the older one; do not install a new version directly over the top.

Insert the CD containing the software in the CD-ROM drive of your
computer. On the CD (normally drive D:\ on most PCs), open the
folder

PolySNAP Install

and launch the program Setup.exe by double-clicking it.

Note that to install software on Windows 2000/XP systems, a system
administrator password may be required.

No. of Patterns Time

50 10 seconds

96 20 seconds

200 68 seconds

400 5 minutes

600 15 minutes

800 30 minutes

1000 1 hour 5 minutes



Program Operation Overview
It will display a welcome window:

Followed by a dialog box allowing the user to control where the
program is installed:

The default path,

C:\Program Files\PolySNAP\

should be suitable for most environments, but a different location
may be chosen if required by clicking on the Change Directory
button (please note that running PolySNAP from a remote network
drive is not a supported configuration).

The next two screens control if a shortcut to the software is added to
the Start Menu and/or the Desktop. The final screen displays a
summary of the selected options; click Install to start the installation
process.
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Installation should then proceed automatically, and once completed,
the installer will quit. Depending on the version of Windows, a
restart may be required at this point; if so the installer will notify that
this is the case.

1.6  Launching PolySNAP

Assuming a default installation, the program may be accessed in one
of the following two ways:

• Run the shortcut to PolySNAP which the installer will have placed
on the desktop by double-clicking its icon.

• From the Start Menu, select the Programs sub-menu, followed by
the PolySNAP folder, and then the PolySNAP option. (It is usually
installed at the very bottom of the list of programs).

1.7  Registering PolySNAP

The copy of PolySNAP that is now installed needs to be registered
before it can be used. A dialog box will appear asking for a Product
Key. 

If you have purchased a copy of PolySNAP, you will have been
provided with a product code of the form:

PSNAPx-xxxx-xxxx-xxxx

Enter this code now (case-sensitive, including dashes), and click OK.

The program will now try to connect to the internet to validate the
registration. It will display a message warning you of this, and a
progress dialog box will appear letting you know that this is
happening.

You will then be asked to fill in some registration details. If you have
purchased a license, you will only be asked for your name and email
address. If you are running in a Trial mode, you will be asked for
some more details. Click OK when complete.

NB: your email address and other information will not be passed to
any third party and will not be used for any other purpose.

If you have any problems with the process, or are unable to connect
to the internet, please contact us directly at

snap@chem.gla.ac.uk



Program Operation Overview
Once this registration process is complete, the program logo screen
will appear for a few seconds, before being automatically dismissed:

The main PolySNAP window will then appear, and will by default
fill the entire screen:

You are now ready to begin working with the software.

Please note that a searchable PDF on-line version of this manual can 
be viewed at any time during the program by selecting View Manual 
from the Help menu. 

1.8  Installation Troubleshooting

Problem
Program registration was not completed, because PolySNAP was
9
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unable to connect to the internet.

Solution
If the registration process could not connect to the internet to validate
the install, then it will have displayed an error and a corresponding
unique Installation Code for your copy. Please either email this num-
ber, along with your Product Code, to snap@chem.gla.ac.uk or
using another computer visit

www.copyminder.com/activate.php
to obtain an activation code manually.

Problem
A message box displaying an error ‘51’ is displayed during program
installation. The program will not launch correctly and may display
further errors after this occurs.

Solution 
Search the Windows System Folder and its subfolders (usually
C:\WINNT for Windows 2000, or C:\Windows\ for Windows XP), for
copies of the file CCMOVE32.DLL. Move this file to a different loca-
tion (e.g. C:\temp), then re-run the program installer.

Problem
When PolySNAP is launched, a Microsoft Office Installer window
keeps repeatedly appearing and cannot easily be dismissed.

Solution
This problem occurs on a system where the currently logged in user
has never previously run any of the installed Microsoft Office appli-
cations on this machine. Keep clicking Cancel until the window
finally goes away, and then quit PolySNAP. Launch any installed
Office application, e.g. Word, and the same installer window will
probably appear. This time allow it to run to completion, and click
OK when requested. Once Word has fully loaded as normal, exit the
program and then run PolySNAP again. It should now run normally
without any further interruptions from Office.

Problem
Problems may occur with the graphics panes – for example, strange
artefacts may appear on the graphics panes in the results display
screen (such as some of the lines in the dendrogram not being visi-
ble), the program may freeze when a graphics pane is being inter-
acted with (e.g. rotated, zoomed etc.) or the program may hang when
attempting to first display the results screen at the end of a program



Program Operation Overview
run.

Solution

This problem can occur on systems that have graphics cards that are
not 100% compatible with the standard OpenGL libraries. As a
workaround, first quit PolySNAP, then go to 

Start Menu -> Settings -> Control Panel -> Display. .

Under the Settings tab, click the Advanced button on the bottom right
of the pane. In the window that appears, select the Troubleshooting
tab, and move the Hardware Acceleration slider down to one notch
above the far left hand side (“None”). Click OK, then OK again.
Restart PolySNAP and see if the problem has been resolved
11
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CHAPTER 2 Using PolySNAP: Automatic Mode
2.1  Starting Automatic Mode

2.1.1  From the command line

The executable can be launched with the following arguments, for
example from a script or batch file, or from another program:

SNAP.exe 1 <input directory> <output directory> <No. data files > |<known phase directory location>|

for example:
SNAP.exe 1 C:/input/ C:/output/ 96 C:/known/

would launch PolySNAP, set the input working directory to C:\input\
and tell the program to expect 96 data files. Output files would be
written to C:\output\, and known phases would be examined from
C:\known\. 

The presence of the known phase directory parameter is optional. If
spaces are present in a path, then that parameter should be encased in
double quotes.

Launching SNAP in this manner with any value other than 1 as the
first argument will cause the program to ignore any other arguments,
and start in the normal interactive mode. 
13
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2.1.2  From within the program

To run in automatic mode, select the Automatic Analysis option from
the File menu (this is only available when no other databases or
match windows are open). 

The options from which to choose are presented:

2.1.2.1  Run on...

This menu item gives the following options:

This allows the location of the required files to be selected on a run-
by-run basis, without having to change the default settings in the
PolySNAP program options. 

Note that setting the input folder to be the same location as the output
folder is not permitted.

The initial paths listed in this window will correspond to those
defaults found in the options window. The three main sections are as
follows:

• Select folder or database containing Sample data files



Starting Automatic Mode
This option allows the user to run PolySNAP analysis on either a
folder containing multiple individual data files, or a pre-existing
single database of patterns. 

Folder Selection: 

Clicking on the Folder... button will open the following window: 

This window allows selection of an entire folder, rather than a single
file within a folder. 

From the upper selection area any available local or network drives
can be selected, and doing so updates the lower region to display all
folders contained on that drive.

By double-clicking on a folder name, it may be opened, and any
folders contained within that folder are then shown.

To select a folder to use as the main folder, double-click on it to open
it. For example, in the screenshot above, the folder at
C:\PolySNAP\Example\ is selected.

Clicking OK results in the selected folder path being displayed in the
settings window.

File selection:

PolySNAP can also be run on a pre-existing database that could have
been produced by a previous run, or created manually using Manual
Analysis.
15
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Clicking on the Database... button will open a standard Windows
open dialog box: 

From here you can select the database file required. The file type
being opened is *.par, the standard format in which PolySNAP saves
databases.

• Use folder or database containing Known/Reference data files

When importing files, new samples can be optionally compared to
patterns of known samples. If known samples are available to be
compared, their location may be set here after turning on the
checkbox. In this case, three options are available to the user:

- to select a pre-existing single database file containing some
patterns, by means of the File... button.

- to select a folder containing one or more individual pattern files,
click on Folder... and select a folder as described above

or 

- to not select any known phase source at all, turn the checkbox back
off, and the location is set to <None>.

Copies of the selected patterns are stored in a file knownphaseDB.par
within the selected output directory. The original data files are left
untouched.

Include Known/Reference data files in main calculation add any
provided reference patterns to the main analysis, resulting in them
showing up in the dendrogram, 3D and other plots.

• Select folder to save output files

The program has to be given a set location in which to save all of the
output files created by an automatic run. This can be manually set to
any folder as required by the user (although having the output and
input locations the same is not permitted).
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Note that if an output folder is selected that already contains files
from a previous run, those files will be deleted prior to the new run
starting.

Click on Folder...to open the following window: 

From here any output folder can be selected as required; note that a
New Folder button is available to allow the creation of a new, empty
folder if required.

• Advanced Options

The options here allow additional optional processing to be
performed upon the data as it is imported. The options are to subtract
background, de-noise the signal, check for amorphous samples,
allow an x-shift between the patterns, and to wait to receive a set
number of patterns before proceeding to the matching.

Additionally, when turned on, the checkbox Mask Selected Pattern
Regions... brings up a dialog box allowing up to three independent
regions of the pattern to be masked to zero intensity. 

This allows for impurity peaks or problem background areas etc. to
be removed prior to matching. 

Only match within the range [] to [], allows a single subregion of the
full angle range to be used for comparison. This can be useful to
concentrate the analysis on a single area of interest within a larger
pattern.
17
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The processing options (Background subtraction, smoothing,
shifting, etc.) available here are discussed in more detail in the
Options and Defaults chapter.

2.1.2.2  Run on Defaults

The program will start running requiring no manual intervention,
using the default settings contained in the program options to obtain
the input directory locations and other required information.

2.1.2.3  View results... 

This option allows the results from a previous run of PolySNAP to be
displayed and examined without having to wait for all the analysis to
re-run. Selecting it will open a standard file-selection dialog box:

Locate the folder containing all of the output files from a previous
run. Inside this folder will be a database file, whose filename will be
in a similar format to Run_09-11-2002.par (the numbers refer to the
date on which the run was performed).

Select this database file and click Open. The main PolySNAP results
window will appear and display the results - see Section 2.3.

Note that certain program options - such as the facility to create an
automatic program report - are not available in View Results mode.
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2.2  Running PolySNAP

2.2.1  File formats that can be imported

Text files (filename.txt) (filename.prn)

These should be standard ASCII text files. The angle should be the x
data, and the corresponding intensities the y data. The x-y data must
be in the format:

x1 y1
x2 y2
. .
. .

etc. 

The fields must be tab-delimited.

If the first line in the file begins with either a '#' or the string 'ID: ', the
rest of that line is used as the 'Pattern Name' for the pattern. 

Any subsequent lines beginning with the '#' character are ignored.

Comma-separated value files (filename.csv)

These should be standard ASCII CSV files, containing the x-y data in
the format:

x1,y1
x2,y2
.,.
.,.

etc. 

If the first line in the file begins with either a '#' or the string 'ID: ', the
rest of that line is used as the 'Chemical Name' for the pattern. 

Any subsequent lines beginning with the '#' character are ignored.

CIF (Crystallographic Information Format) files             
(filename.cif)

The program contains a CIF-format translator that reads standard
version 2.0 Powder CIF files. Although the only data necessary for
SNAP is the x-y intensity data, the rest of the CIF information - such
as chemical names and formulae, author names and addresses etc. are
also retained in the database for reference purposes, and may be
19
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viewed from the Pattern Editor window. Additionally, unit cell
dimensions and contents are read in if present for use in Quantitative
Analysis mode.

For more information on CIF format files, see the IUCr website at:

http://www.iucr.org/iucr-top/cif/pd/index.html

Bruker Raw Format files

The program can import data from Bruker RAW format. This is a
binary file-format, so cannot be edited or viewed in a conventional
text editor. There are several different types of RAW format; PolyS-
NAP should be able to import all versions up to Version 4. 

Although the only data necessary for PolySNAP is the x-y intensity
data, much of the rest of the information stored in the file - such as
chemical names and formulae, author names and addresses etc. are
also retained in the database for reference purposes, and may be
viewed from the Pattern Editor window. Additionally, unit cell
dimensions and if present contents are read in from MDI ASCII files
for use in Quantitative Analysis mode.

PolySNAP Pattern files (filename.pat)

Patterns in PolySNAP databases can be individually exported in the 
program’s own .pat format. This format contains the original x-y raw 
data, any processed data - e.g. the profile after noise removal, marked 
peak positions and any other data fields present. Once saved as 
separate files, they can then be re-imported to the same or a different 
database at a later date.

2.2.2  Import all data files

Assuming no data files are present when the automatic mode run is
started, a screen similar to the following is displayed:

The location of the directory which the program is monitoring for
input data is displayed. The number of files expected, and the number
loaded so far are also given. It is possible to change these settings at
this stage by clicking on the Preferences button to bring up the
program options dialog described previously.

Clicking Exit Auto Mode returns the program to the usual interactive
mode, and cancels the automatic run. The user will be asked to
confirm that they did mean to select this option.
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The Match Now option overrides any settings to wait for more
patterns, and causes the program to proceed directly to the next
phase. Again, the user is asked if they mean to pursue this course of
action, as it may cause some data files to not be imported.

If all file locations were correctly set, a database file is created in the
output folder defined earlier. This contains all the imported patterns.
Any output from PolySNAP is saved in this same directory,
including the logfile, SNAPlog.txt, which describes the success or
otherwise of importing each datafile, the results of the matching and
clustering process, and other useful information.

Once files are found and imported, extra information is displayed at
this stage in the form of a list of imported files, and a graphical
representation of the most recent pattern to be imported:

The first file imported to the database is displayed by the top graph,
the most recently imported file is represented by the lower graph.
Other patterns imported can be displayed on the upper graph by
selecting the pattern of interest from the list. 

Any files which could not be imported are recorded in both the
SNAPlog.txt, and the errorlog.txt file.

2.2.3  Examine the imported data files

Once all of the expected samples have been imported, the program
examines the patterns. Several steps are performed at this stage (see
also the flowchart in section 1.3 on page 5):

1. Patterns are checked to see if they may be amorphous. This
involves calculating how much pattern would be left if all of the
21
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background areas were removed, as well as how many peaks of
reasonable intensity there are superimposed on that background.

2. If known phase files were provided, the program compares each of
the imported patterns to each of the known phases. Any good
matches are recorded and will be displayed later.

3. For patterns that did not match any of the known phases
sufficiently, quantitative analysis is performed to establish if they
might possibly represent mixtures of more than one of the known
phases provided. The quantitative analysis techniques described in
the manual analysis section are performed with an additional step
which removes each suggested component in turn, to establish if that
improves or worsens the fit to the original pattern. In this way,
patterns that are incorrectly included can be weeded out.

2.2.4  Match all data files against all other data files

Upon commencement of this phase, a progress dialog is displayed:

The various matching tests selected are then performed, and this may
take some time, so patience is required.

2.2.5  Perform cluster and quantitative analyses

Once the matching has been completed, the results are passed into
the cluster analysis module, which then starts to try to group the data
into similar clusters, and estimate their number. Again, this may take
some time.

When more than 50 patterns are being examined, a progress bar is
displayed to give some information about how far through the
calculation is:

Note that while the clustering is underway, the main screen display is
not updated in any way. Therefore, it may sometimes appear as if the
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program has crashed or frozen, as it will not respond to the mouse or
keyboard during this process. Patience is recommended at this point,
especially when dealing with larger datasets. 

2.2.6  Output results to file

Once the clustering is complete, a copy of the raw numerical results
from the matching is saved to the PolySNAP output folder within the
current working directory in the file correlations.txt; other output is
saved to the logfile. Various other output files are also created, which
are described in Section 2.6.
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2.3  Results Display

Once the analysis is complete, the display screen is loaded and
results can then be examined in a variety of ways. 

In general the display consists of a display area at the top, in which
the style of view can be altered by selecting the different tabs running
along the top of the window.

The bottom half of the results display is an area giving information
on the currently selected sample file or files. This comprises relevant
textual information relating to the selected pattern, and a graphical
representation of the pattern profile. By default, the first pattern to be
imported is displayed at first. Note that the pattern information
display is by default common to all display modes. 

Additional controls are available from the menus at the top of the
screen.

2.3.1  Display Options Overview

The various display modes available from the tab bar are as follows:

The first four displays each provide separate and different
assessments of the number and types of groups of patterns presented,
calculated using the various different methods described below. As a
result, the groups suggested in each display mode may not
correspond to the groups suggested by another. It is the responsibility
of the user to determine which of the separate methods is providing
the best results. The more the results from different methods are
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internally self-consistent, the more confidence there is in the overall
result.

Cell Display

This screen displays the results of comparing the samples with any
known phases provided, and any resulting quantitative analyses of
mixtures. (If no known phases are present, the Cell Display shows
the Dendrogram-plotted results in a different form - see
Section 2.3.5.1 for more information.).

Dendrogram

This screen displays the results of the cluster analysis of the patterns
provided.

3D (MMDS)

This screen shows the plotted results of performing metric
multidimensional scaling upon the distance matrix.

3D (PCA)

This screen shows the plotted results of performing principal
component analysis upon the modified correlation matrix.

N.B: If either the 3D (MMDS) or 3D (PCA) have two stars next to
their name, e.g:

then this informs the user which method of the two has produced
markedly better results than the other for this particular run. If no
stars are displayed, then the methods are producing relatively similar
results, in terms of their reliability.

6D Plot

This option allows a selected 3D plot to be augmented with sample
preparation information. See Section 2.4 for full details.

Validation

This tab incorporates several different displays in the one frame.
Each different output display is accessed through the pop-up menu
on the top-left corner. Most of the items here are not necessary for a
straightforward run of PolySNAP, but may prove useful in trickier
cases and to provide further checks on the other methods.
25
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Validation > Scree Plot

The scree plot provides a separate graphical analysis of how many
different types of patterns there are, based on the principle
component analysis, in order to help estimate how many separate
groups of patterns are needed to suitably describe the data. Unlike
some of the other graphical displays, it does not attempt to describe
what patterns are likely to belong to each different group.

Validation > Minimum Spanning Trees

This display presents an additional way of partitioning the patterns
into different clusters. Taking the MMDS plot as its starting point, all
of the patterns are joined together by a single continuous line, in the
order of increasing amounts of distance between them. The links are
then broken in order of decreasing distance, until the estimated
number of separate clusters has been reached. The user can then alter
the view by breaking the line corresponding to the greatest distance
between two patterns, thus creating an additional cluster, or creating
a link between the next most closely joined pair of clusters. This
process can be repeated, cutting the next smallest distance, creating
an additional cluster each time a cut is performed.

Validation > Silhouettes

Each pattern assigned to a particular cluster is given a score from -1.0
to 1.0, defining its membership of that cluster. Scores nearer 1.0
suggest strong membership, scores nearer 0 suggest weak
membership. This can be useful when attempting to determine where
to place the cut-level, and if a particular pattern should be included or
excluded from a certain cluster. Results are shown in the form of a
histogram for each cluster at the current dendrogram cut-level. If the
cut-level is manually adjusted, the silhouettes are re-calculated for
the new cluster groupings.

Validation > Fuzzy Clustering

In the standard cluster analysis routines, the results of which are
shown in the dendrogram display, a given pattern is assigned to one
cluster or another. With fuzzy clustering, a single pattern can be
assigned to more than one cluster. Using the concept of membership,
a value can be calculated for how well a given pattern fits in a given
cluster. A low membership score may suggest that that pattern does
not belong in that cluster. A single pattern having reasonably high
scores in more than one cluster may indicate a mixture. Only patterns
which fall outside a defined threshold range, and therefore are
samples that may need to be examined manually in more detail, are
shown in the fuzzy clustering output. Fuzzy clustering is only run for
datasets with under 200 patterns.
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Validation > Parallel Coordinates Plot

Validation > Space Explorer

These items allow the user to explore if the suggested pattern clusters
shown make sense when exploring the higher dimensionality of the
dataset. If the clusters break up or become intertwined at higher
dimensions, this may indicate problems with the results.

Numerical Results

This tab displays the numerical values returned from the Match All
process undertaken that compared each sample with every other
sample.

View Logfile

This tab displays all of the textual output written to the SNAPlog.txt
file during the importing, processing and analysis undertaken by the
program earlier. It is also updated automatically if the user manually
overrides any of the PolySNAP results.

Finally, the last tab, Report Writer, allows access to a screen in which
is possible to compose a report based upon the automatic run.

Each of these options are described in detail later.

With the exceptions of the Advanced displays, the Logfile and the
Report panes, all of the displays above allow the selection of one or
more sample data files; this is normally done by clicking once on the
sample of interest, which will then become highlighted. Information
regarding the selected sample will then be displayed in the Sample
Information pane at the bottom left of the window.

2.3.2  Sample Information Pane

For a selected sample, the sample information pane displays relevant
textual information on the left, and a graphical representation of the
sample profile on the right. Although this information pane is always
available by default, it is possible to hide it if more screen space is
required to examine results in the graphical display areas of the
window.
27
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Selecting Hide/Show Pattern Information from the Display menu
allows the information region to be hidden or shown as required.

The right-most region shows the current powder pattern profile; it
can be zoomed in by using the mouse to drag a rectangle over the
relevant area:

The graph pane is part of a larger area that shows information
regarding the selected sample. To the left of the graph appears an area
with text information associated with that sample:

Typical information displayed includes the data file location, the
angle range, the data points for the original raw data and once any
processing has been performed, the known phase most similar to this
pattern (if present), and finally other relevant information regarding
the sample preparation, if saved in the data file headers.
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2.3.2.1  Multiple Selection

If more than one sample pattern has been selected in a given display
screen, the pattern information pane displays a list of the patterns
selected, and shows their profiles plotted on top of each other for
easy comparison:

To identify which profile corresponds to which sample, hover the
mouse over part of the line, until a tooltip appears containing the
sample filename:

Alternatively, selecting the Show Pattern Key on Graph item in the
Display menu brings up a visual colour-coded key:

Multiple non-contiguous selection is achieved by clicking on
multiple patterns with the Control key held down on the keyboard,
for example:

Individual patterns can be de-selected in a similar manner, and their
profiles will be removed from the graph.
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Alternatively, a continuous number of consecutively displayed
patterns may be selected by holding the Shift key down and clicking
on the first and then last pattern in the desired range, for example:

When multiple patterns are plotted, selecting Toggle Mode from the
right-click menu displays all but the most recently selected pattern in
the same colour, to allow easier comparison between one particular
pattern and several others.

2.3.2.2  Additional Pattern Options

More options for examining and editing patterns and their
assignations are available from the main program menubar. When an
individual pattern is selected, the Pattern menu is available. It
contains the following options:
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Edit... 

Selecting this option, or clicking the Edit Pattern button causes the
standard PolySNAP pattern editor to appear with the current selected
pattern loaded into it:

Refer section 3.3.1 on page 97 for full Pattern Editor description and
functions.

Manual Match/Quantitative...

This submenu has the options for matching the selected sample
pattern to either the rest of the sample database, or the database of
known phases (references), if present.

This opens a standard PolySNAP Match window, allowing a manual
comparison or analysis to be performed on the selected pattern. See
section 3.4.1 on page 113 for more information on the Match
window.

View/Edit Nearest Known Phase...
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This option is only available if a comparison with a known-phase
database was done during the analysis. If so, selecting a particular
pattern and selecting this option brings up the following window:

The selected sample is plotted in green, and the known phase the
program considers to be the best match to it is shown overlaid in
blue. The actual matching statistics are displayed on the top right.

To see how well the sample compares to any of the other known
phases provided, select the name of the phase from the pop-up list,
and click Change:

The pattern overlay, and matching statistics, will update to represent
the newly selected pattern.

To retain a changed assignation of a nearest known phase, click OK,
and answer in the affirmative to the presented dialog box.

To keep the program-calculated nearest phase, click Cancel.

View Frame Image...

If the original GADDS frame file corresponding to the current
pattern is available, and was saved in the same input data directory,
clicking the View Frame button or selecting this menu item will open
the Bruker GADDS software to display the frame image.

Note that this option requires both the GADDS software to be
installed on the local computer, as well as a script file,
DisplayFrame.slm, to be placed in the GADDS scripts directory. This
should have been done by use of the option Set GADDS... in the
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program options Automatic: Advanced tab, but if this menu item fails
to work, check that this file is correctly placed.

View Sample Image...

If the original sample image file corresponding to the current pattern
is available, and was saved in the same input data directory, selecting
this menu item will launch an external image viewer program
depending on the relevant setting in the program Options dialog. If
the program is set to display sample images inline where possible,
then clicking on the image preview has the same effect:

View Pattern Using EVA

If the current pattern was imported from a RAW format file, this
option allows it to be opened in the EVA software package for
examination. Note that EVA must be set up as the default editing
software for RAW files, and be installed on the local computer.

Override Crystallinity Indicator...

This brings up a dialog box allowing the user to manually override
the program-calculated crystallinity marker setting:

The user can then choose to mark the currently selected pattern as
either Crystalline, or Non-crystalline. (The criteria for what the
program considers to constitute a non-crystalline phase were defined
earlier in section 5.6 on page 150).

It may be useful to view a list of all samples from a current run that
are marked as non-crystalline; this functionality is available from the
Tools menu option List Non-crystalline Patterns... described in
Section 2.3.17.1.
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2.3.3  General Graphical Display Pane Options

The various graphical display panes - the Cell Display, Dendrogram,
Screen and two 3D plots - all share many similarities in their options
and controls, and are hence initially described together here.

2.3.3.1  Display Controls Common to All Modes

To zoom in to a region of a graphical display, with the left mouse
button held down, drag a rectangle over the region you wish to zoom:

The screen will then redraw with the contents of the rectangle filling
the display area:

To move the contents of the display window, for example to move the
contents up to see more results than will fit in the window by default,
hold down the Alt key on the keyboard, and drag the mouse in the
desired direction of movement.
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2.3.3.2  Additional General Options of the Graphics Panes

Right clicking on the graphics pane causes the following menu to
appear:

Reset View - This feature will return to the original view of the
display if it has been moved or zoom has been activated. 

Zoom In - Will zoom in on the centre area of the current display.

Zoom Out - Will zoom out from the centre of the current display. 

Toggle Mode - This feature switches between viewing the patterns as
Pie Charts or Stacks when in Cell Display mode, or between the full
and simplified views of the Dendrogram in that mode. 

Centre Selection - The currently selected item will be centred in the
display.

Deselect all - Any patterns that have been highlighted in the display
will be de-selected with this option. 

Show Toolbar - The optional toolbar at the top of the graphics pane
can be hidden or shown with this feature. The toolbar provides access
to most of the options available through the right-click menu; for a
full description see Section 2.3.3.3.

Print - The standard Windows print dialog box will appear, allowing
the current graphics display region to be sent to a printer.

Copy - The whole of the current graphics display will be copied to
the clipboard, and then can be pasted into either the Report Writer
pane of PolySNAP, or any other standard Windows program - for
example, Microsoft Word.

Copy selection - This option allows smaller specific regions of the
graphic display to be copied. Click on Copy Selection, and then drag
a rectangle over the area to be copied: This area only will now be
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copied to the clipboard, and can then be pasted in elsewhere as
required. 

Other mode-specific display options (e.g. Show Grid/Show Labels/
Show MRP Marks are discussed under the relevant display section).

2.3.3.3   The Toolbar

The basic functions of the toolbar are illustrated below:

Reset View - This feature will return to the original view settings of
the display.

Clicking on the small arrow next to the Reset View button allows
access to the options for both Reset View and Deselect All.

Zoom In - Will zoom in on the centre area of the current display.

Zoom Out - Will zoom out from the centre of the current display. 

Toggle Mode - This feature switches between viewing the results as
Pie Charts or Stacks for Cell Display Mode.

Clicking on the small arrow next to the Toggle Mode button allows
access to the options for use on graphics panes where there are a Grid
or Labels displayed - these two options then allow them to be
switched on or off as desired.

Centre Selection - The currently selected item will be centred in the
display.

Move Left - The current display will move one unit to the left.

Move Right - The current display will move one unit to the right.

Move Up - The current display will move up one unit.

Zoom out

Change Font

Colour

Move Down

Centre Selection
Toggle Mode Print and 

Copy

Move up
Move Right

Reset View

Zoom in

Move Left

Line size
Zoom out

Change Font

Colour

Move Down

Centre Selection
Toggle Mode Print and 

Copy

Move up
Move Right

Reset View

Zoom in

Move Left

Line size
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Move Down - the current display will move down one unit.

Print - The standard Windows print dialog box will appear, allowing
the current graphics display region to be sent to a printer. 

Clicking on the small arrow next to the Print button can be further
used to access the Copy and Copy Selection options described above.

Line size - Clicking on the arrow next to the Line Size button opens a
pull-down menu with a series of options for line size numbered 1 to
5, with 1 being the thinnest and 5 being the thickest. A dot appears
next to the thickness currently selected. The line size options changes
the thickness of lines on the graphical displays which may be useful
when preparing images for publication.

Colour - This option allows the colours of both the foreground and
background to be altered to suit the user’s requirements. Note that
these will be reset on the next launch of PolySNAP:

Background: The default colour is black, simply click on the
down arrow next to the colour box and select Background:

This will now display the colour palette from which a colour
can be chosen.

The colour selected here will then be applied to the background
of the current view. Note that it may be useful to change the
colour of the background to white before printing. 
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Foreground: The foreground selection is performed in the
exact same way as the background, only this time selecting
Foreground from the options presented:

The foreground option will alter the colour of the text or axes
used in the current display.

Font - Finally clicking on the Font button will open a standard font
options dialog box:

This can be used to select the format of the text that will appear on
axes labels, plot headers and pattern labels.

2.3.3.4  The Display Menu

Further options to control the output screens are available from the 
Display menu:

Show Pattern Information, Show Sample Images Automatically, 
Show Pseudo Cell Display, Show Pattern Key on Graph and Show 
Dendrogram Colours on 3D plots are discussed elsewhere.

Show Amorphous Samples on 3D Plots
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This toggle determines if samples that are flagged by the program as
being amorphous are shown or not on the standard 3D plots. It is only
enabled when more than one pattern is labelled as amorphous. In
some cases, hiding such samples can make the plots appear quite
different - this is often especially the case in the PCA plot. 

In the examples shown here the majority of the patterns are
artificially 'flattened out' by the extreme distance between them and
the amorphous; removing the amorphous allows for a better
representation of the distances between the remaining patterns.

Show Sample Labels if Available

If the sample filenames are of the form where some form of sample
ID is contained within the filename, then that information can be
extracted and displayed to help identify the samples.

For example, with this option turned off, a typical display might
resemble:
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Whereas with the option turned on, the display would look like this:

The default for this toggle is on.

Note that all the files in a given dataset must have the same consistent
format for Well IDs to be displayed. See the Options and Defaults
section for details.

Show Graphics Toolbars

This toggles the toolbar displays which are available on some of the
graphics panes. The setting is persistent for a given run, but may be
overridden temporarily by means of the Show Toolbar option
available in the right-click pop-up menu of most of the different
displays.

Show Normalised Pattern Profiles

This option toggles the graph pane between displaying all profiles on
a common intensity scale, where the maximum value is always 1.0,
to displaying the profiles with their maximum intensities as recorded
in the original data files. The default for this toggle is off.

Show Processed Pattern Profiles

This option toggles the graph pane between displaying all profiles
with any processing - such as background subtraction or smoothing -
or in their unprocessed original form. The default for this toggle is
on.

Offset Overlaid Profiles -> on x-axis, on y-axis

The two options in this submenu may be selected independently of
one another. They control how patterns are displayed when more
than one profile is shown on the graph pane at a time.

By default, overlaid profile traces are plotted directly on top of each
other. By using these display toggles however, they may be plotted
with a slight offset in either the x- or y-axes, or both. This may enable
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differences or similarities between the patterns to be observed more
clearly. 

For example, the screenshots below show first, several directly
overlaid patterns, then the same shifted in the x, and then in the y, and
finally shifted with both options turned on:

Note: it is important to remember to check that the x-shift option is
turned off when trying to see if the peak positions of two patterns
coincide or not!

Show Current Display in New Window

This option creates a snapshot of the currently selected display screen
- e.g. the dendrogram or cell display - and shows it in a separate
floating window. This snapshot can be rotated, zoomed, resized etc.
as with any other graphics pane, but are not updated when the
changes (such as dendrogram cut level alterations) are made in the
main screen; also any changes made in a snapshot window are not
reflected in the main results display window.

Graphics card permitting, multiple floating snapshot windows can be
created, allowing comparisons to be made more easily between
different screens.
41



42
2.3.4  Cell Display

This display mode is the default display choice.

The Cell Display comprises of a pane in which the patterns loaded
are each represented by an individual pie chart. Each pie chart is
colour coordinated to group together similar patterns.

The cell display can be shown in either of two modes - as standard
pie charts (the default), or as 'stacks':

To switch between the two view modes, right-click on the display,
and select Toggle Mode from the resulting menu.

Depending on the presence or absence of known phases for a given
run, the colour-coding is obtained from two different sources.

If known phases are available...

When a database of known phases were provided to compare the new
samples to, the 'key' on the left hand side of the display shows a list
of those known phases, with the labels shown generated from the
relevant pattern filenames:

Each known phase has a unique colour assignment; and in addition
colours are shown for patterns considered to be either non-
crystalline/amorphous (Amorph.) or unlike any other known pattern
provided (Other).
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Each individual pattern that corresponds to a known phase (i.e. one
that gave good matching statistics when being compared to a known
phase) is given the same colour as that known phase - for example, in
the screenshot above, the patterns that matched well to Form B are all
the same colour of yellow. All of the patterns that match to Form B
can be selected at once by clicking on the colour in the key:

A pie that contains multiple colours (e.g. sample P21 above)
represents a pattern which is thought to be a mixture of two or more
of the known patterns, and the colours within the pie-chart again
correspond to the phases thought to comprise it. Allowing the cursor
to hover over a particular component of a mixture brings up a tooltip
describing which phase and in what amount:
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If no known phases are available...

On the other hand, if no known phases are available what appear to
be similar results are displayed:

However, there are subtle and very important differences. The colour
of the pies obviously no longer correspond to those of known phases,
the colours are now merely representative of patterns which are
similar to each other. In the example above Pies 1, 2, 3 and 4 are
similar to each other as are 5, 6, 7 and 8. Pattern 21 is dissimilar to all
the other samples, as it is a colour not shared by any other samples.

This information is generated from the cluster analysis results as
presented in the dendrogram view (see the next section). As a result
of this, a warning message is displayed that the results shown are no
longer determined separately, but are merely clustering results
presented differently:

Because clustering results are being used, the groups shown are
entirely dependant on the cut-level used on the dendrogram display.
The cut-level is discussed in more detail in Section 2.3.5.1, but it is
important to note that when no known phases are present, altering the
cut-level or otherwise editing the dendrogram display will cause the
cell display colours to be altered and updated accordingly.

This display mode can also be accessed when known phases are
present, by means of the Show Pseudo Cell Display option in the
Display menu.
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Note that once a particular well is selected, the wells on either side
can be selected in turn by means of the left and right arrow keys, thus
allowing for quickly scanning through multiple patterns.

2.3.5  The Dendrogram

The dendrogram display can be accessed by clicking on the
Dendrogram tab along the top of the display window. 

The dendrogram provides a visual means to display the results of the
hierarchical method of data classification using cluster analysis. The
dendrogram itself takes the form of a tree-diagram in which each
single terminal branch is representative of a single object (in this case
an individual pattern from the data input). 

The initial cut point is set by the program, and is shown by the yellow
horizontal line. Upper and lower confidence limits on this cut-level
are shown with yellow dotted lines where appropriate. 

Each pattern is numbered along the bottom axis of the dendrogram.
Each number is the same as in the other displays - for example,
number 1 on the dendrogram is the same pattern as number 1 in the
cell display.

Each pattern can be selected by clicking on the box above its number.
When a pattern is selected, the sample information along with its
pattern profile is displayed in the bottom half of the display window.
Multiple patterns can be selected by holding down the Control key
and clicking on different patterns.

Note that once a particular pattern is selected, the patterns on either
side can be selected in turn by means of the left and right arrow keys,
thus allowing for quickly scanning through multiple patterns.

The view of the dendrogram can be zoomed in on by dragging a
rectangle over the relevant area with the left-hand mouse button
down as with the graph and cell displays.
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The position of the dendrogram position on the horizontal axis can be
altered by holding down the Alt key and moving the mouse left or
right. This can be useful if the zoom has been used and the whole tree
no longer fits on the screen at one time.

Patterns are joined together by a series of lines. The further up the
similarity axis (y-axis) the patterns are joined, the less similar they
are. Therefore, in the screenshot above, patterns 1 and 3 are joined at
a high level of similarity (nearly 1.0), and are therefore very similar,
whereas patterns 1 and 12 are not joined until a similarity of less than
0.4, indicating a large difference between them.

Given the calculated similarity between patterns, it is then possible to
categorise similar patterns as belonging to the same cluster. This is
done by drawing a horizontal line across the display at a given
similarity level - this is called the cut-level. 

The optimum cut-level is determined by PolySNAP using a
combination of several different techniques in order to determine the
number of clusters that statistically best represents the data given.
These techniques include principle component analysis, metric
multidimensional scaling, the C-H test, gamma statistics, etc.

The cut-level is then drawn on the dendrogram, and different patterns
which are grouped together below this line are considered to be
similar enough to be thought of as being in the same cluster:

In the screenshot above, the horizontal cut-point is set at around 0.72,
and is therefore considering patterns 1, 3, 2 and 4 to be in one cluster,
whereas 13,14, 15 and 20 are in a separate and distinct one.

The different clusters are colour coded, and if no known phases are
present, these dendrogram results are used to generate a pseudo-cell
display (see Section 2.3.4). In this case the colours used here will
correspond to the colours in that display. Optionally, the same colour-
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coding can be used to help interpret the results in the various 3D
plots.

The Toggle Mode option, accessed through the right-click menu,
redraws the dendrogram with only the first, last and middle patterns
of each cluster shown. This allows easier interpretation of a crowded
display when many patterns are being analysed. Note that while
showing the simplified dendrogram, the cut-level and other
modifications cannot be made. A label is displayed on the top-left of
the display to indicate that the display is in simplified mode.

It is possible to toggle the showing of the axes on and off using the
Show Axes option, accessed through the right-click menu.

2.3.5.1  Modifying the Dendrogram

-Changing the Cut-level

If the program-calculated cut-level is not considered to be correct, it
can be overridden by the user. This is done by holding down the Shift
key and left mouse button, while dragging the mouse up or down.
The cut-line on the dendrogram display will move, and the cluster
colouring will update in real time. For example, moving the cut-level
up to around 0.1 results in the following:

Note that the colour assignations have updated accordingly. If the
user chooses to retain this change when closing the dendrogram
display or switching to another display pane, then the pseudo-cell
display will be updated accordingly, and the modification noted in
the program logfile. If the change is not retained, the previous value
is kept.

[In addition to this method, if a mouse with a scroll wheel is used, it
is possible to just click once in the display area with the left mouse
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button, and then move the mouse wheel up or down to move the cut-
level indicator.]

-Manually changing the contents of clusters

PolySNAP makes its assignation of the contents of clusters using a
combination of powerful statistical techniques. It should not
normally be necessary to override its results, but for the occasions
when this is necessary, it is possible to reassign either a single pattern
or group of patterns manually.

To do this, hold down the Shift key and click and hold down on the
vertical line attached to the pattern or sub-cluster required to be
moved:

Continuing to hold both the Shift key and mouse button, drag the unit
to the desired location. To add it to an existing cluster, release the
mouse when the cursor is over the area the sample is to be added to:

To create an entirely new, separate cluster, drag it to an empty space
between existing clusters:

To cancel a drag operation part-way through, it is only necessary to
release the Shift key.

A one-step Undo is available for this method of altering the
dendrogram, if for example a user changes their mind, or a cluster is
incorrectly joined. To do this, right click on the dendrogram, and
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select Undo from the pop-up menu. Note that only the most recent
operation can be undone.

The only way to be able to undo multiple operations is to choose not
to save the changes to the dendrogram when closing or switching the
window; that way the original dendrogram will be retained and
shown the next time the results are examined.

When changes to the dendrogram are saved, the changes and the
resulting new clusters and corresponding component patterns are
listed in the program logfile.

- Changing the Clustering Method

PolySNAP can be set to select what it calculates to be the most
appropriate clustering method for a given problem. The user can also
choose to re-run just the clustering part of the analysis to experiment
with how different individual clustering methods would affect the
results. 

Select Change Cluster Method from the Tools menu. An options
dialog box will appear:

To select an individual cluster method, deselect the Select Cluster
Method Automatically checkbox, choose from the seven options then
presented, and click OK. The recalculation process may take several
minutes on larger data sets.
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2.3.5.2  Saving and Reverting Changes

When another tab is clicked on after the dendrogram has been altered
in one of the ways described above, the following message is
displayed: 

Selecting No will cause any changes to be discarded, and the
previous version of the dendrogram, prior to any manual changes,
will be retained.

Selecting Yes causes the changes made to the dendrogram to be kept,
and also be recorded in the program logfile. Changes to the
dendrogram can also be saved at any point using the Save Modified
Tree option in the right-click menu.

Reverting to a previous dendrogram:

Because the program retains earlier saved versions of the
dendrogram, it is possible to revert to them if required at a later stage.
This function is accessed through the Tools menu option Undo
dendrogram modifications... Selecting this option brings up the
following dialog box. 

If more than one set of changes to the dendrogram have been saved,
the user is offered the choice between the original, program
generated tree, and the most-recently saved previously modified
version of the dendrogram:

Selecting Cancel retains the current version with no changes.
Selecting Original reverts to the original version. Selecting Modified
causes the current, modified dendrogram to be replaced with the
most recently modified saved changes.

2.3.6  3D Plot (MMDS) 

This option displays the results of metric multidimensional scaling
which make use of distances between objects calculated from the
correlation matrix generated by the matching process to produce a
three-dimensional spatial representation of the samples. Each point
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which appears on this spatial representation corresponds to one of the
patterns. The closer two points appear on the plot, the more similar
the patterns are, and the more different an object is to another the
further apart they will appear. Therefore groups of similar patterns
appear to cluster together.

The multidimensional scaling performed is based on calculated
proximities rather then observations. First for n patterns, we generate
an (n x n) distance matrix D based on dissimilarities, δrs = 1,2,....,n,
computed from the correlation matrix. Each object is compared
against itself and every other object. The result of an object being
paired against itself gives a dissimilarity of zero, which corresponds
to the diagonal of the matrix. The goal of this method is to derive a
set of underlying dimensions, with co-ordinates that should create a
Euclidean distance matrix, which in turn should be the same or very
close to the δrs of the original D. 

The initial view of the 3D plot shows only the X and Y axis - the Z
axis lies in projection. 

In the Display menu, the option Use Dendrogram Colours on 3D
Plots is available. When this item is selected, a check mark appears
next to it in the menu, and the individual points plotted on either of
the 3D plots are coloured to correspond to the colour groupings
shown in the Dendrogram plot - e.g. if samples 11, 12 and 13 are all
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in the same cluster according to the dendrogram, they will all be the
same colour - green: 

In the 3D plot, they will all still be coloured similarly:

Changing the dendrogram cut-level causes the colours in the 3D plots
to be updated.. A small numerical label in the top-left corner of the
display gives an indication as to the goodness of fit of these results.
Numbers close to 1.0 suggest that it is a good fit, and low numbers
suggest that caution may be required, or that the program had trouble
adequately partitioning the data.

Note that as the number of samples increases, the average GOF score
will decrease.
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The orientation of the 3D plot can be altered by holding down the
Shift key and dragging the mouse in any direction as desired; the plot
rotates as shown below:

In the above plots it can be seen that there are 4 or 5 clusters
depending on P16 and whether it can be considered to belong to an
adjacent cluster or not.

A variety of views can be achieved to gain a better understanding of
the distribution of the pattern data points in the three-dimensional
space.
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As in the other graphics screens, any particular area of the 3D view
can be zoomed in by dragging a rectangle over the relevant region: 

The powder pattern corresponding to each display point can be
selected by clicking on it, this in turn updates the pattern information
display in the lower portion of the window.

The points representing the patterns can be enlarged or shrunk to suit
any zoom level by holding down the Ctrl key and moving the mouse
either up or down. An upward movement will reduce the size of the
spheres, a downward movement will increase the size. 

The 3D plot position itself can be translated by holding down the Alt
key and then moving the mouse in any direction as required. 

The drawing quality of the spheres can be altered if needed - with
many points plotted, working with the display can be much faster if
the rendering quality is reduced (this is especially the case with
lower-powered graphics cards). To do this, with the 3D display
visible, press the F2 button on the keyboard:

Moving the slider causes the drawing of the spheres to update in real
time, so the effects of a particular setting can be easily seen. The
chosen quality setting is saved and used from that point on. The
higher quality settings can be useful when preparing screenshots for
use in reports or for publication.
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Further options can be accessed by right clicking on the display area
to show the standard pop-up menu. Options relevant to the 3D plot
include:

Find Item... 

This brings up a dialog box allowing a particular pattern of interest to
be located on the display by means of its index number, or label as
appropriate. 

Additional options allow the pattern to become automatically
selected when found - thus updating the pattern information display,
and optionally centred in the display. This is useful when dealing
with large numbers of patterns, as locating an individual pattern of
interest on a crowded plot can be difficult. 

Show Grid - the grid which appears in the 3D plot can be hidden or
displayed. 

Show Labels - the labels which appear next to the plotted points can
be turned on or off with this option. This may aid in seeing an overall
clustering pattern when the display is crowded with many points.
55



56
Show MRM Marks - the Most Representative Member in each cluster
can be highlighted if required with this option. it appears on the
display as a normal pattern with several 'spikes' coming out of it:

These spikes can be hidden or shown by means of this menu option.
Clicking on an MRM sphere brings up a dialog box containing
information about the mean pattern-pattern distance for that
particular cluster. The smaller the distance, the tighter the cluster.

Show Top View - this option brings up a small simplified overview of
the plot in the lower right hand corner. It can be useful for orientating
yourself when zoomed into the display:

Render as Dots and Transparent alter the way the spheres are plotted
as shown in the diagrams below. This can be useful to identify if for
example, a single pattern of one colour is hidden within a group of
another patterns:

Mask Group
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This option is useful in a crowded display with lots of different
clusters overlapping each other - select the Mask Group option, and
the next cluster you click on is temporarily removed from the display.
A key in the top left corner shows the colour of the hidden cluster. To
restore the cluster, deselect the option from the menu. Alternatively,
click on a different colour, and that will be hidden instead. Only one
cluster at a time can be hidden.

With the Mask Group option selected, pressing the spacebar toggles
between hiding the selecting group and showing everything else, and
hiding everything else and showing just the selected group. The left
and right arrow keys can also be used at this point to cycle through
and have each group selected in turn.

Popup Group

This option can be used to bring the whole of a particular coloured
cluster to the front of the display, so it can all be seen at one time. A
key in the upper left shows the colour of the selected group.
Deselecting this option returns the display to normal.

Drag Labels

With this option toggled on, the display is fixed and cannot be rotated
or zoomed. Therefore, it is necessary to use the normal zooming and
rotation controls to select a suitable view angle before selecting this
option. Once selected, all of the pattern labels on the display can be
moved individually by clicking on them and dragging to the required
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new location. This allows for neater diagrams to be created when
required for a report.

2.3.7  3D Plot (PCA)

The plot drawn here is based on the results from principle component
analysis of the modified correlation matrix. The use and interaction
options available for this plot are identical to those for the 3D Plot
(MMDS) described in Section 2.3.6.

2.3.8  Validation Pane - Scree Plot

The Scree plot is a 2 dimensional graph. Along the x-axis is the
Eigenvalue Number and the y-axis is made up from the eigenvalue
itself.

Eigenvalues are derived from the modified correlation matrix, which
is first normalised. The eigenvalues are sorted in descending order.

What this represents is the minimum number of clusters that can be
used to describe the entire data set being examined. The point where
the plotted line changes colour - e.g. between 5 and 6 in the example
above, suggests that just 5 clusters are needed to explain over 95% of
the variation in the data. A well behaved scree plot should have a
reasonably steep initial descent. A gradual, sloping descent indicates
difficulty in establishing the number of clusters required, so the
program-generated dendrogram cut-level should be examined
especially closely.

By holding down the Alt key and the mouse button, the graph can be
moved about the pane to any desired location. The plot can be
zoomed in by dragging a rectangle over the relevant area, and the
usual further options can be accessed by right clicking to reveal the
pop-up menu.
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2.3.9  Validation Pane - Minimum Spanning Trees

The MST display presents a different way of partitioning the patterns
into different clusters. All of the patterns are initially joined together
by a single line, in the order of increasing distance between them.
The initial view shows all of the samples connected in this manner: 

The program then cuts links between the patterns in order of
decreasing maximum distance until the estimated number of clusters
is reached. The user can then manually adjust this by clicking on the
left-facing arrow in the top-right corner, to reduce the number of
links by one, or by clicking on the right-facing arrow in the top-right
corner, to increase the number of links by one:
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This process can be repeated, cutting the next smallest distance, and
creating an additional cluster each time.

The display can be zoomed, rotated and otherwise manipulated in a
similar manner to the other 3D plots. Note that each time the number
of clusters changes the most representative patterns in each are
recalculated. Note that the colours here do not correspond to those on
the dendrogram.

2.3.10  Validation Pane - Silhouettes

For each of the current clusters as defined by the dendrogram cut-
level, this display shows a histogram. Silhouettes (Rousseeuw, P.J.
(1987). J. Computation & Appl. Math., 20, 53-65.) provide an
alternative formalism for assessing the compactness and isolation of
clusters, and also for identifying those members of a given cluster
which are well established members of the core cluster or outlying,
and thus potentially problematic. If the i-th pattern belongs to cluster
Cr then we define the silhouette, s(i) as follows:

where there are nr patterns in cluster r, ns patterns in cluster s, and dij
is the distance between patterns i and j. The values of s(i) lie between
–1 and +1. The lower the value of the silhouette, the more likely it is
that the pattern either: 
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Results Display
1.Belongs to a different cluster and you should try altering the
dendrogram cut level, or:

2. The pattern is a mixture. The MMDS and PCA plots will be useful
here to identify the closest neighbours of pattern i.

One histogram is shown for each cluster. If there are more histograms
than will fit on the screen at one time, a small down-pointing arrow
appears in the lower right corner. 

To scroll down to see the next row of histograms, click on the arrow,
or use the scroll wheel on the mouse. Similarly, an upwards pointing
arrow will appear if there are histograms above the top of the screen.

Allowing the mouse to hover over a particular column shows which
pattern numbers correspond to that score. For example, the yellow
cluster appears to have a member that has a reasonably low
membership score - mousing over it shows that this is pattern 20,
which makes sense when looking at the dendrogram, where it is the
least tightly linked member:

Note that if the dendrogram cut-level has been manually adjusted
since the previous time this display was accessed, there may be a
short delay as new silhouettes are calculated for the revised cluster
membership list.

Clicking on a column selects the patterns presented in that column,
allowing them to later be located on the 3D or dendrogram displays.
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For example, clicking on the column pictured above brings up a
dialog:

When next viewing the 3D plot or Dendrogram, press F4, and pattern
20 is then automatically highlighted on the display. This allows cross
checking between patterns that the silhouettes display may highlight
as unusual, and their corresponding position in the other results
output.

2.3.11  Validation Pane - Fuzzy Sets & Clustering

This display is superficially similar to the silhouettes, and is
navigated in the same manner. With fuzzy clustering, and unlike the
standard clustering methods used elsewhere in the program, a single
pattern can be assigned to more than one cluster. Using the concept
of membership, a value can be calculated for how well a given
pattern fits in a given cluster. A low membership score may suggest
that that pattern either does not belong in that cluster, or that it is a
mixture. A single pattern having reasonably high scores in more than
one cluster may indicate a mixture. Only patterns which fall outside a
defined threshold range, and therefore are samples that may need to
be examined manually in more detail, are shown in the fuzzy
clustering output. If this is not the case for any of the patterns, then
no output is shown - this is the ideal case, as all patterns clearly
belong to only one cluster.
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Checking the output from this calculation should therefore help to
highlight borderline or unusual cases that do not fit neatly into one
cluster or another. Such examples may possibly be mixtures, or
evidence of some other problem such as a different background or a
2θ-shift.

Pattern selection and automatic find features as described above in
the Silhouettes are also available in this display.

2.3.12  Validation Pane - Parallel Coordinates Plot

Rather than plotting our patterns in a 3D space, here we plot the first
6 dimensions of the clusters in a linear fashion, allowing the user to
see if the cluster separations evident in the first 3 dimensions still
hold together in higher dimensional space. 

By right-clicking and selecting Grand Tour from the pop-up menu,
the display can be animated for easier interpretation.

2.3.13  Validation Pane - Space Explorer

This display resembles the standard 3D plot, with the exception of an
additional option on the toolbar. 

By default, it plots dimensions 1, 2 and 3 as normal. By iterating
through the various combinations of dimensions 1 - 6 by means of
the Next and Previous options from the toobar dropdown menu, other
combinations can be accessed. The legend in the upper left corner
updates to show which dimensions are currently being plotted.

This allows the user to see if the cluster separations evident in the
first 3 dimensions still hold together in higher dimensional space. 

By right-clicking and selecting Grand Tour from the pop-up menu,
the display can be animated for easier interpretation.

2.3.14  Numerical Results

This pane is used to display the pattern correlation matrix. If there are
a large number of patterns then the entire matrix may not fit within
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the display, and scroll bars will be displayed along the side and
bottom of the table. 

If the program was run with the Allow Offsets option turned on, an
additional file, correlations_offsets.txt will also be created in the
output folder. The results from it can be seen by selecting a particular
cell, and then allowing the mouse to hover over that cell for a second,
until a 'tool-tip' appears. This contains two numbers in the form
(a0,a1), where a0 is the amount of linear offset applied, and a1 the
amount of non-linear offset applied. 

A diagonal line of 1 should be present to show the result of each
pattern matched against itself. Clicking on the 1 for each pattern will
produce the profile and information for that pattern in the relevant
area below. 

For comparison purposes two patterns can be overlaid on each other
by clicking on a number above or below the line of 1.

For example if 0.2914 is clicked on as highlighted above, the graph
of FORM A (4) and FORM B (2) will be displayed, one overlaid on
the other in the graph pane:

This allows a visual comparison to help decide if the matching results
displayed are sensible or not. If shifts were calculated, the patterns
will be displayed here with the relevant shift calculated.



Results Display
Right clicking on the matrix of results will produce the following
options: 

Clicking on Copy (or alternatively selecting Copy from the Edit
menu) will copy the contents of any selected cells to the clipboard.
To copy only part or all of the results, drag a rectangle over the
desired numbers, a blue highlight region will appear indicating the
numbers selected. Now right click to produce the options and click
on Copy.

Note that the numbers in this window are not editable in any way. 

The Show Difference Plot... option brings up a new window with a
plot showing the difference trace between the two currently selected
patterns, for example:

2.3.15  View Logfile

The results of the file import, processing, pattern matching,
clustering etc., and any subsequent changes to the results are written
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to a file in the output folder named SNAPlog.txt. It is the contents of
this file which are displayed in the View Logfile Pane:

A scroll bar appears on the right hand side of the pane to allow the
user to view all of the text, as the output is normally quite long. 

The text can be copied to the clipboard and pasted to other
applications by selecting the relevant text to highlight it and then
right-clicking in the text pane:

Click on Copy to copy the text (alternatively choose the Edit menu
and click on Copy). Note that the Cut and Paste options are
unavailable, as the logfile cannot be edited manually.

The Save As... option causes a standard file saving dialog box to
appear
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This allows a copy of the current logfile to be saved to a new file.
Select the desired location for the file, edit the filename if required.
The format for saving is an ASCII text file (*.txt)

The Print... option brings up the standard Windows print dialog box,
allowing the current selection of the logfile output to be printed. 

2.3.16  Report Writer

The report writer is an area that functions as a basic word-processor,
in which the user can produce reports containing information from
any of the output displays, or any other text or bitmapped graphics
that can be pasted from the clipboard as desired.

The pane itself initially consists of a white screen with standard text-
editing toolbar is provided at the top of the window, allowing choice
of font, font size, text style and text alignment in the usual manner: 

Right clicking on the report pane will produce the following options:

Cut - Highlight an area by holding the left mouse button down and
dragging over a relevant area. Selecting Cut causes the selection to
be removed from the screen and copied into the clipboard.
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Copy - A selected region of the report pane is copied in to the
clipboard, and can then be pasted into another application. 

Paste - An object or text which has previously been copied into the
clipboard is pasted at the current insertion point. 

Save As - Clicking on Save as...opens a standard Save As dialog box.
The report can be saved in one of three file formats:

RTF Files (*.rtf) - Rich Text Format

HTML Files (*.html)

Text Files (*.txt) - ASCII Text Format.

RTF format is recommended for most uses, as any images added to
the report are saved together within the RTF file, whereas HMTL
export produces a HTML file and separate files for each embedded
graphic.

N.B. Saving as ASCII text retains only the raw text; any embedded
images are not saved.

The Print... option brings up the standard Windows print dialog box,
allowing the current selection of the logfile output to be printed. 

See section 2.3.17.1 on page 69 for the automatic generation of
reports.
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2.3.17  Other Display Tools

2.3.17.1  Generate Report...

Selecting this option brings up a dialog box with several options to
control the automatically generated report:

The difference between the Summary and Detailed report is as
follows:

The summary report includes information as to the run start and end
time, lists the processing and matching options selected, states the
calculated number of clusters, lists the components of each cluster,
and the results of any mixture analysis.

In addition to all of the above, the detailed report also includes lists
of files imported, more detailed output on which cluster methods
were selected, and a summary of any sample preparation information
provided.

With the Include graphics output in report option selected, for
Summary mode this adds the Cell Display and Dendrogram output to
the report, and for Detailed mode it adds copies of the output from all
of the main graphics modes. The Include detailed sample
preparation information option adds a semi-colon delimited table of
the sample information to the report. This can later be converted into
a proper table in an external word processor such as Word.
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Clicking OK starts the process, during which the screen will flicker
as various displays are generated and information retrieved as
required. A message is displayed once generation is complete, after
which the report can be viewed, edited and saved in the Report pane
of the main window.

2.3.17.2  List Non-crystalline Patterns...

This option, accessed through the Tools menu, allows the user to
examine a list of any patterns that the program has marked as being
possibly non-crystalline when it has examined them.

Selecting it brings up a display window:

The upper region is a grid showing the pattern names, number of
peaks, and approximate percentage amorphous content. The larger
this value, the more likely the pattern is to have an amorphous
content.

Selecting a pattern in the list (by clicking on it once) updates the
profile display in the lower region of the window to show what the
pattern profile actually looks like. If the Show area used for
amorphous indicator calculation checkbox is selected, then a second,
green trace shows the rough profile that would be left if the program
subtracted out everything it thought was amorphous from the pattern.

If the user considers that the program has made an error in marking a
particular pattern as non-crystalline, they may override this by
clicking the Unmark button on the lower left. This action is recorded
in the program logfile.

It is also possible to do the opposite, and mark a pattern as
amorphous; for information on how to do this, see Section 2.3.2.2.
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2.3.17.3  List Mixture Patterns...

Selecting this option from the Tools menu brings up a new window:

This consists of an upper region listing all of the patterns marked as
mixtures, and a lower graph-pane region. Selecting a particular
pattern from the list causes it to be displayed in the graph pane, and a
list of which known phases are thought to make it up are listed in the
display area. Clicking the Residual button opens a PolySNAP
window to allow comparison of a simulated pattern created from the
suggested phase components, and the original sample.

N.B. this option is only available when powder patterns for known
phases were provided.

2.3.17.4  List Pattern Cluster Members...

This option is available only when the dendrogram is being
displayed, and generates a list of the current members of each cluster
suggested by the cluster analysis, according to the current saved
dendrogram cut-level. 
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If the list of cluster members is short enough, it is displayed as a
message box, which can then be dismissed:

If the list of members is too long for a standard message box, it is
automatically added to the end of the program logfile, from where it
can be copied into a report or other program as required.

2.3.17.5  Export Pattern Clusters...

This option brings up a dialog box allowing the list of pattern clusters
to be saved to a text file for use elsewhere.

2.3.17.6  List Most Representative Members...

This option is only available when either the MMDS or PCA plots
are being displayed. Note that the calculation of MRPs is specific to
the type of plot displayed, so different results may be obtained from
each of the two methods. Different results will also be obtained if the
dendrogram cut-level is adjusted manually.

A list of the pattern indexes and filenames for the most representative
patterns in each cluster to have 3 or more members is shown in a
dialog box on the screen. A copy of the list is also automatically
added to the logfile when this option is selected.

2.3.17.7  Rerun Analysis...

Note that selecting these options causes the current PolySNAP 
session to finish, and the program is restarted. It is therefore 
important to ensure that any changes to the report, dendrogram or 
other displays are saved prior to selecting it.

-Using Only Currently Selected Patterns

This option allows the user to select a subset of the current data set to
re-analyse. It closes the current PolySNAP results window, and re-
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runs the initial analysis of the patterns using the currently selected
patterns on the display. The new output is by default saved in a new
folder entitled Rerun_SelectedSamples located inside the original
output folder, although the user is given the opportunity to select a
different folder location and name. 

The standard PolySNAP Run On options dialog is displayed so that
processing options, etc. can be altered if required at this point.

Output from the original run output is not overwritten and can
therefore still be examined later using the View Results option.

At least 4 samples must be selected on the display to be able to use
this option.

- Ignoring All Non-crystalline Patterns

This option allows the user to re-analysis the current dataset minus
any patterns flagged as being amorphous. The new output is by
default saved in a new folder entitled Rerun_noAmorph located
inside the original output folder, although the user is given the
opportunity to select a different folder location and name. 

The standard PolySNAP Run On options dialog is displayed so that
processing options, etc. can be altered if required at this point.

Output from the original run output is not overwritten and can
therefore still be examined later using the View Results option.

-Using Most Representative Patterns

This option is only available when either the MMDS or PCA plots
are being displayed. Note that the calculation of MRPs is specific to
the type of plot, so different results may be obtained from each of the
two methods. Different results will also be obtained if the
dendrogram cut-level is adjusted.

This option closes the current PolySNAP results window, and re-runs
the initial analysis of the patterns using the identified Most
Representative Patterns in place of known phases. The new output is
saved in a new folder entitled MRP_rerun located inside the original
output folder. In this manner, the original run output is not
overwritten and can therefore still be examined later using the View
Results option.

The idea is that this method may help to identify possible mixtures,
however caution should be taken with this option, as it is entirely
possible that one of the patterns selected could in itself be a mixture.
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2.4  6-Dimensional Plots

2.4.1  Using the 6-Dimensional Plot

PolySNAP provides the facility to allow either of the two standard
three-dimensional plots discussed earlier to be augmented by up to
three additional user-specified dimensions, as described here.

These additional dimensions are used to represent information
recorded about each sample regarding its method of preparation.
Available information that can be plotted is by default (assuming it is
available in the pattern data files):

Mass
Total Volume
Counterion
Stirrer Rate
Sample Presentation
Solvent
Antisolvent
Initial Temperature
Isolation Temperature
Cooling Rate
Heating Rate
Reaction Time
Antisolvent Volume

The 3 additional plotting dimensions that are available to represent
these are:

Point Size
Point Shape
Point Colour

By using this approach, it can be possible to discover if there is a
connection between a particular combination of sample preparation
conditions and the resulting clusters (note however that there are
some restrictions as to which fields may be plotted as which
dimension).

To take advantage of this feature, select the 6D Plot tab. The
following options toolbar will appear:

The first option presented is to select which of the two different 3D
plots available is to be used as the basis for this user-modified plot.
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The selection is between the MMDS and PCA plots, each of which
were discussed in more detail earlier in Section 2.3.6 and
Section 2.3.7 respectively.

Once this has been done, select which information field is to be
plotted as which dimension. Up to three dimensions may be plotted
at any one time, as chosen by selecting or deselecting the checkboxes
as appropriate.

Ball Size Dimension:

The default possible information types available to be plotted as the
size dimension are: Mass, Total Volume, Stirrer Rate, Initial Temp,
Cooling Rate, Isolation Temp, Reaction Time, Antisolvent Volume
and Heating Rate.

When each pattern was imported, any sample information fields were
parsed, and the maximum and minimum values of each field stored.
This data is then used to scale each datapoint to an appropriate size. 

Colour Dimension:

The information types available to be plotted as the colour dimension
are: Mass, Total Volume, Stirrer Rate, Initial Temp, Cooling Rate,
Isolation Temp, Reaction Time, Antisolvent Volume and Heating
Rate. Dendrogram Colours are also available.

When each pattern was imported, its sample information fields were
parsed, and the maximum and minimum values of each field stored.
This is then used to plot a range of colours based on the data values.

Additionally, the final option Dendrogram Colours allows the colour
scheme of the dendrogram at the currently saved cut-level to be
applied to the plot.

Shape Dimension: 
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This is provided as a means of plotting the more textually orientated
information fields, such as solvent and counterion. Up to six different
shapes are available (sphere, cone, cylinder, tetrahedron, octahedron
and cube), allowing for up to six different solvents, for example, to
be represented on the plot.

Once the settings are complete, click on the Apply button. The
generated plot, is then shown below the toolbar:

The standard graphics controls for moving, zooming and rotating the
display etc. all apply as normal, as do the controls for selecting
individual patterns of interest, and displaying their details in the
pattern information pane.

The settings used to produce the plot are saved to the logfile for
future reference. 

Note that in 6D plot results need to be manually copied and added to
the report pane at present.

2.4.2  Editing Sample Preparation information details and
location

There is a file located by default in the program folder (usually C:/
Program Files/PolySNAP/) called sample_info_format.txt. (The
location of this file can be altered by changing the option in the
program Options window). Editing this file enables the user to
change the field names, types and order expected for info for the 6D
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plot. The user can also set program to look for info in a single file (1
line per pattern) rather than in the individual raw data headers.

If stored in the RAW headers, the program looks in the fields for
Sample Name and Comment for the information (n that order), which
should be semi-colon delimited. If a given field is unused for a
particular pattern, it should be left blank, but the semi-colon delimiter
should still be there. Fields must be in the correct order as described
in the setup file.

For example:

2.2E-5;2.0;ethanol;hexane;;100.0;50.0;2.0;0.0;180.0;residue;

If in a single file, there should be one line of numbers as shown
above per pattern.

These should be in the same order as the patterns are loaded into the
program; line 1 should correspond to Sample 1, and so on. The
program loads files in system alphabetical filename order.

# File format info

# Where is this info stored - either just HEADER 
for in data files header space or

# FILENAME full path\to\file.txt

HEADER

#FILENAME C:/test.dat

# Fields - maximum of 20 fields, 1 per line, in 
expected order

# Specify Type; units; format (format is either 
textual TEXT or numeric NUMBER)

# e.g. Mass;mg;NUMBER

# if no units just put ;;

# put END as last line

Mass;mg;NUMBER

Reactor Identity;;TEXT

Total Volume;ml;NUMBER

Solvent;;TEXT

Solvent Ratio;;TEXT

Antisolvent;;TEXT

Antisolvent Volume;ml;NUMBER

Counterion;;TEXT

Stirrer rate;rpm;NUMBER

Initial temp;deg C;NUMBER

Heating Rate;deg C/min;NUMBER

Cooling Rate;deg C/min;NUMBER

Isolation Temp;deg C;NUMBER

Reaction Time;min;NUMBER

Sample Presentation;;TEXT

END
77



78
2.5  Other Menu Items

Close Window in the File menu closes the automatic analysis results
window. The user will be asked if they wish to retain any unsaved
changes to either the dendrogram, or the report.

The Edit menu, in addition to giving access to the standard text
editing controls (Cut, Copy, Paste, etc.) also allows access to the
program defaults and preferences through the Options item.

The Window menu contains the following items:

Window List (submenu)

This submenu lists all of the currently open windows within the
PolySNAP program. Selecting a window from the list brings it to the
front.

View Error Log

This option opens a new window containing an edited version of the
PolySNAP logfile, which contains only lists of errors or problems
that have occurred during a run of the program:

It may be a useful aid in the determination of where any problems are
occurring.
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View/Edit Reference Database

This option opens the current database of known or reference
patterns (if present) in a standard PolySNAP database window:

It can then be examined, edited or used as a basis for a manual match
or analysis procedure as required. For more details see section 3.4 on
page 113.

View/Edit Sample Database

This option opens the current database of imported patterns in a
standard database window. It can then be examined, edited or used as
a basis for a manual match or analysis procedure as required.

The Help menu contains the following relevant items:

View Manual

This option opens a new window containing a PDF version of this
manual that can be searched, displayed or printed as required.

About PolySNAP
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Selecting this menu item brings up a screen describing the running
version of PolySNAP, and includes useful information such as the
version number and build date:
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2.6  Output Files

An average run of PolySNAP creates a variety of different files in the
selected output folder. This section lists and describes the most
important of them:

Run_xx-yy-zz.par

This is the database file containing copies of all of the original data
files. It can be opened and examined manually in manual analysis if
required. The file was created on the date xx-yy-zz.

Known_phases_xx-yy-zz.par

This is the database file containing copies of any individual known
phase files. It can be opened and examined manually in manual
analysis. This file only appears if known phases are being used, and
they are not already in a database file. The file was created on the
date xx-yy-zz.

SNAPlog.txt

This file is added to continually while the program is running. It
consists of a record of program operations and any user alterations to
the program-generated results. It can be viewed from within the
program, or in any text editor.

Errorlog.txt

This file is a very abbreviated version of the logfile, containing only
records of problems or difficulties encountered during data import,
processing, or pattern analysis. It can be viewed from within the
program, or using any text editor.

correlations.txt

These files contains the numerical values from the sample matching
process, where every individual pattern is compared to every other
pattern. It is these numbers which are displayed in the Numerical
Results pane of the Display window. Values can also be examined by
viewing this file in a spreadsheet program such as Microsoft Excel.

Dendrogram.dat Dendrogram_modified.dat

Dendrogram_original.dat Dendrogram_disused.dat

The output file containing data for the dendrogram display is saved
as Dendrogram.dat. If the user then makes and saves changes to the
dendrogram, the original output file is renamed
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Dendrogram_original.dat. If further changes are made and saved, the
previous version of the file is renamed Dendrogram_modified.dat.
Should the user later choose to revert to an earlier version of the
dendrogram, the appropriate file is renamed to Dendrogram, and the
current, unwanted version renamed as Dendrogram_disused.dat.
Both Dendrogram_disused.dat and Dendrogram_modified.dat retain
only the most recent changes, and may be overwritten. The original
results file is never overwritten, and can be returned to at any time.

Pie.dat and Pseudo_pie.dat

If known phases were provided, Pie.dat contains information used by
the cell display to show colour-coding and mixtures compared to
known-phase patterns. If no known phase files were provided,
Pseudo_pie.dat contains the current dendrogram groupings
reformatted for display in the cell context. If filename information
was used to label the cells with the correct well identity number, then
an additional file pie_index.dat is used to store the original output
file.

mmds.dat and mmds_coloured.dat

This file contains display information used to display the 3D
(MMDS) plot, using either the default colour scheme (3dmmds.dat)
or the colour scheme utilised by the current saved version of the
dendrogram (3dmmds_coloured.dat).

pca.dat and pca_coloured.dat

This file contains display information used to display the 3D (PCA)
plot, using either the default colour scheme (pca.dat) or the colour
scheme utilised by the current saved version of the dendrogram
(pca_coloured.dat).

Scree.dat

This file contains display information for the scree plot.

QuantitativeResults.dat  correlations_offsets.txt

The first file contains the output from the quantitative analysis of any
suspected mixture patterns. The second file contains the output of the
best calculated shift for each pattern matched.

amorphous.dat    membership.dat

mmds_na.dat       pca_na.dat 

Various files ending in .tmp
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These are various internal files used by the program.
83



84



CHAPTER 3 Using PolySNAP: Manual Analysis
3.1  Database and File Handling

In order to use PolySNAP in manual analysis mode, the user must
first either create a new, empty database and load some patterns into
it, or open an existing database. This chapter describes both these
processes.

3.1.1  Database creation

Having launched the program, select New Database... from the
Manual Analysis section of the File menu.

A standard Windows file dialog will appear:
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This will initially suggest the filename processed.par and a location
at the root directory of the C:\ drive. The filename and location can
be changed in the normal Windows manner.

Note that the .par suffix indicates the database being is saved in the
standard PolySNAP database format.

Once created, the database will be opened in a new window:

The top portion of the window provides some basic information on
the database, including its name and location, and the number of
patterns stored in it. Initially, of course, it is empty. 

The central portion of the window will list the patterns included in it.
It will be described in more detail on page 90.

The lower region consists of 5 buttons, used to access the main
functions of the program. The buttons all have corresponding entries
in the program menus.

3.1.2  Opening an Existing Database

To open a pre-existing database, select Open... from the File menu. A
standard Windows file browser will appear. Locate the database, and
either double-click on it, or click once to select it, and then click the
Open button.
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A database window will open, and the patterns loaded. Depending on
the number of patterns in the database, this may take some time.
Progress is indicated via a progress bar at the top of the window:

3.1.3  Default Databases

If you commonly open the same database each time you launch the
program, this process can be speeded up by defining the path of your
database as the program’s default. This can then be opened directly
by use of the Open Default option in the File menu, or by the
keyboard short-cut Option-D. 

The default default database is C:/processed.par. This can be
changed in the Program Options dialog, accessed through the Edit
menu’s Options... entry.

3.1.4  Recent Databases

The four most recently opened databases are stored in the Recent
Databases submenu for easy access. Selecting one of the entries
automatically causes that particular database to be re-opened.

Note that if you have moved the file since it was last opened you will
have to open it manually.
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3.1.5  Importing Files into a New Database

Once a new, empty database has been created and opened, the next
stage is to import some patterns into it. This is achieved by clicking
on the Import... button at the bottom of the database window (or
using the Alt-I short-cut, or choosing Import Patterns... from the File
menu).

A standard Windows file selection dialog will appear, and either
single or multiple pattern files can be selected for import. Multiple
files of different types can be easily selected using the shift or option
keys, or by dragging the mouse across the names to select them.

Click Open to begin the data importation process.

This version of the program can import pattern files in one of 4
formats:

3.1.6  Text files (filename.txt) (filename.prn)

These should be standard ASCII text files. The angle should be the x
data, and the corresponding intensities the y data. The x-y data must
be in the format:

x1 y1
x2 y2
. .
. .

etc. 

The fields must be tab-delimited.

If the first line in the file begins with either a '#' or the string 'ID: ', the
rest of that line is used as the 'Pattern Name' for the pattern.

Any subsequent lines beginning with the '#' character are ignored.

3.1.7  Comma-separated value files (filename.csv)

These should be standard ASCII CSV files, containing the x-y data in
the format:

x1,y1
x2,y2
.,.
.,.

etc. 
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If the first line in the file begins with either a '#' or the string 'ID: ', the
rest of that line is used as the 'Chemical Name' for the pattern.

Any subsequent lines beginning with the '#' character are ignored.

3.1.8  CIF (Crystallographic Information Format) files             
(filename.cif)

The program contains a CIF-format translator that reads standard
version 2.0 Powder CIF files. Although the only data necessary for
SNAP is the x-y intensity data, the rest of the CIF information - such
as chemical names and formulae, author names and addresses etc. are
also retained in the database for reference purposes, and may be
viewed from the Pattern Editor window (see Section 3.3.1).
Additionally, unit cell dimensions and contents are read in if present
for use in Quantitative Analysis mode.

For more information on CIF format files, see the IUCr website at:

http://www.iucr.org/iucr-top/cif/pd/index.html

3.1.9  Bruker Raw Format files

The program can import data from Bruker RAW format. This is a
binary file-format, so cannot be edited or viewed in a conventional
text editor. There are several different types of RAW format; PolyS-
NAP should be able to import all versions up to Version 4. 

Although the only data necessary for PolySNAP is the x-y intensity
data, much of the rest of the information stored in the file - such as
chemical names and formulae, author names and addresses etc. are
also retained in the database for reference purposes, and may be
viewed from the Pattern Editor window (see Section 3.3.1). Addi-
tionally, unit cell dimensions and if present contents are read in from
MDI ASCII files for use in Quantitative Analysis mode.

3.1.10  PolySNAP Pattern files (filename.pat)

Patterns in PolySNAP databases can be individually exported in the
program’s own .pat format. This format contains the original x-y raw
data, any processed data - e.g. the profile after noise removal, marked
peak positions and any other data fields present. Once saved as
separate files, they can then be re-imported to the same or a different
database at a later date.
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3.1.11  Processing

Once files have been selected for import, a dialog box will then
appear, informing you how many patterns will be imported, and
offering several data processing options:

Normally, the default settings at this stage are to perform all three
options:

• Background subtraction

• Smoothing and noise removal

• Peak finding. 

All of the processing choices are optional, although in order to
perform basic matching operations, at least the main 'Normalise
intensities (required for matching)' checkbox should be selected. 

Selecting OK will begin the import process. 

A progress bar indicates progress through the processing:

If any selected patterns cannot be loaded - for example if they are not
in the correct format, or a file is corrupted, a warning will be shown:
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In such a case, the rest of the selected patterns should still load
correctly.

Once the import procedure is completed, the list of patterns
contained in the database will appear in the centre of the database
window:

Each entry in this list corresponds to one imported pattern. The left-
most column contains the pattern name or ID associated with that
pattern, if one is known. (This is either read from the CIF data field if
present, or can be entered manually in the pattern editor - see Section
3.3.3) If no name is known, this column shows the filename.

The rightmost column lists the filename from which each pattern was
loaded.

3.1.12  Sorting Database Entries

Initially, this list of patterns is shown in the order that patterns were
added to the database. It is often more useful to see the list of patterns
sorted in order of either chemical name/ID, or individual filenames.
This is done by clicking once on the relevant column header.
Clicking again on the same header will reverse the order of the
sorting, e.g. from ascending to descending, or vice versa.

3.1.13  Exporting patterns

Individual patterns contained within a PolySNAP database can be
exported to either text or pattern format files, for easy viewing or
editing in other programs, or for transferring to other PolySNAP
databases. This means PolySNAP can be used as a general purpose
pre-processing tool for patterns that are to be used in other programs.
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Click once on the pattern you wish to export. It should become
highlighted in the list:

Then click once on the Export... button (or use the Export... option
under the Pattern menu). A standard file saving dialog box appears:

Select the desired location for the file, and edit the filename if
required. The default format for export is a .pat pattern file, but a .txt
text file format option can also be selected from the Save as type
drop-down menu at the bottom of the dialog box.

Click Save, and the file will be saved to the chosen location.

Note: This process saves a copy of the selected pattern to a separate
file, it does not remove the original pattern entry in the database.

This option saves the processed version of the pattern (i.e. the
version with smoothing, background subtraction etc. applied) if one
is present, so if the raw pattern is required, remove any processing
using the Edit window before exporting.
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3.1.14  Removing Patterns

Select the pattern or patterns you wish to delete from a database.
They should become selected in the list:

Then click once on the Remove button (or select Remove from the
Pattern menu, or press the Delete key on the keyboard). A warning
appears:

If you change your mind, select No. Selecting Yes removes the
selected pattern(s) from the database permanently. To retrieve them,
you would then have to re-import the pattern from the original data
file. (The original data files are not affected in any way by the
Remove command.)
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3.1.15  Viewing and Editing Patterns

Click once on the pattern you wish to examine. It should become
selected in the list:

Then click once on the Edit button (or select Edit Pattern from the
Pattern menu).

The Pattern Editor window should appear. This is described in detail
in section 3.3.1 on page 97.

3.2  Matching and Analysing Patterns

If you have a new, unknown pattern you wish to analyse or compare
to entries in an existing database, the first step is to import the new
pattern to the existing database.

Having done this, select it in the list of patterns, and click Match (or
select Open in Match Window from the Pattern menu).

The matching window is described in detail in Section 3.4, Pattern
Matching and Analysis.

3.2.1  Refresh Database

This feature is accessed through the menu item Refresh found in the
Manual Analysis section of the File menu. This option updates the
local copy of the database in memory by reloading all pattern
information from the copy on disc.

3.2.2  Save Copy of Database

This feature, accessed through the Save Copy of Database... Menu
item located in the Manual Analysis section of the File menu, brings
up a standard Windows Save As file dialog. The process asks for a
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new database name, and copies the pattern contents of the existing
database into the new one. Note that you cannot use the existing
database name as that file remains open during the process.

Once completed, the resulting database will be saved with the name
selected and can then be opened by PolySNAP in the usual manner.

3.2.3  Apply Processing to Database

This feature is accessed through the Tools menu item Apply
Processing...

If you wish to change the way in which all of the patterns are
processed at once, it is possible to do so without having to change
them individually, or having to re-import them from the original files.

Select Process, then select the new required processing options as
required from the resulting dialog:

The selected processing will then be applied, which for a large
database may take some time.

3.2.4  Mask Regions

This option, accessed under the Tools menu, is used to mask a
particular region of the diffraction pattern to zero for every pattern in
a database. (For more information on masking regions, section 3.3.10
on page 107) 
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Selecting this option brings up a window which displays the
currently selected pattern:

To mask a region, either enter the start and end x-values of the area to
be ignored in the text boxed on the upper left, or drag the mouse
across an area of the pattern with the left mouse button held down.
This will enter the start and end angles for the selected ranges in the
text boxes automatically.

Click Apply. By default, the region selected will be set to zero for all
of the patterns in the current database. Depending on the size of the
database, this may take some time. To apply the masking just to the
current pattern, deselect the Apply to all patterns checkbox.

The image of the current pattern will be updated to show the area
now masked.

Multiple regions can be masked by repeating this process; click Done
when complete. 

Note that applying any additional processing to a pattern after this
point will remove any masked regions. Masking can also be re-
applied or changed for an individual pattern in the Pattern Editor (see
Chapter 3).

To remove all masking from all patterns for a particular database,
select the Mask Regions menu option, and click the Reset All button
in the lower left corner. Again, this may take some time.
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3.3  Pattern Editing and Processing

3.3.1  The Pattern Editor

After selecting a pattern in the database, and selecting the Edit
option, the Pattern Editor window will appear:

Note that while the editor window is open, no other changes can be
made to the open database.

The File menu option, Close Window, closes the editor and returns to
the main database window. (The same result is achieved by clicking
the close box on the titlebar of the window.) If any changes to the
pattern have been made, a dialog box will appear asking if those
changes should be retained or not:
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Selecting Yes saves the changes and returns to the database listing
window, No discards any changes made and Cancel returns to the
Pattern Editor.

One of the other File menu option available, Export..., performs the
same function for the pattern currently being edited as the Export...
button in the main database window. Selecting it causes a standard
file saving dialog box to appear:

Select the desired location for the file, and edit the filename if
required. The default format for export is a .pat pattern file, but a .txt
text file format option can also be selected from the pop-up menu at
the bottom of the dialog box.

Click Save, and the file will be saved to the chosen location.

Note: This process saves a copy of the selected pattern to a separate
file, it does not remove the original pattern entry in the database.

This option saves the processed version of the pattern (i.e. the
version with smoothing, background subtraction etc. applied) if one
is present, so if the raw pattern is required, remove any processing by
turning off all processing options and clicking Process before
exporting.

Finally, the option Export Peak List brings up a save dialog box,
allowing the peak list for the current pattern to be saved to an ASCII
text file for use in other programs.
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3.3.2  Graph Pane

The lower part of the window, where the pattern is displayed, is
called the graph pane:

The x-axis is normally displayed as a 2θ range and the y-axis an
intensity. For positive data, all values are normally scaled to between
0.0 and 1.0 for use in PolySNAP, unless no processing has been
performed at all upon the data.

Individual peaks in the graph pane are marked by peak markers,
which are seen as a single large dot at the top of the peak. (For more
information on peak markers, See “Find Peaks” on page 104.) 

Clicking and dragging to draw a rectangular box on the graph pane
using the left mouse button causes the graph to zoom in into the
selected region, for example:

It is possible to zoom in repeatedly using this method. Clicking on
the graph with the right mouse button causes a pop-up menu to
appear:

Options in this menu are:

• Reset View - selecting this after the graph scale has been changed
returns to the default zoom level.

• Remove Peak - if the click was in the vicinity of a marked peak,
the marker will be removed.
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• Add Peak - the nearest maxima to the click location is marked as a
peak on the graph.

• Set Peak Threshold - sets the y-value of the current mouse posi-
tion to the minimum allowed peak height.

The same options are also available from either the Graph or
Pattern menus respectively. The central region of the Pattern Editor
contains the pattern information controls in two tabs: Basic and
Advanced.

3.3.3  Basic Pattern Information

At the top left corner is the pattern name/ID text box. If no name has
been read in for the pattern from the data file, this will normally read
"(Unknown)". This name can be edited by clicking in the text box,
and deleting or adding text as required. It is recommended that
pattern names do not exceed 256 characters. Standard text-editing
commands, such as Cut, Copy and Paste are all available from the
Edit menu. This field is used by default to identify different patterns
in the database and match windows.

Below this is the Formula field, which is also an editable text field. If
formula information is present in the datafile, it will be read in and
displayed automatically. Otherwise, it would need to be entered
manually. This field is not required for operation of the program, but
may be useful for reference.

Below that is a text field displaying the path and filename of the
original data file the pattern was obtained from. If this path is longer
than 100 characters, it will be truncated, and only the right-most 100
characters will be displayed. To see the entire path, leave the mouse
cursor hovering over the text for a few seconds to see a 'tool tip'
containing the full path. 

Next is the range the current pattern spans on the x-axis (normally in
degrees.)
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Following this is the number of raw data points in the pattern: this
corresponds to the number of data points read from the original data
file. 

The number in brackets after this is the resolution of the raw data
calculated using:

 (End angle - Start angle) 
No. of raw data points

This corresponds to the magnitude of the x-difference of the
difference between two adjacent data points.

Next to this is a similar indicator for the processed data. The
processing referred to is the basic processing undergone by every
pattern imported into a PolySNAP database. This involves scaling
the intensity data between 0.0 and 1.0, and interpolating the data
(using 5th order polynomials) so that all of the patterns in the
database are the same standard data resolution. This is normally 0.02
degrees per datapoint, or 50 data points per degree. 

Below this is noise indicator for the pattern calculated in the wavelet
domain, using the MAD estimator (see section 3.3.8, References). A
larger number corresponds to a more "noisy" pattern.

The wavelength field reads in a value for the wavelength at which the
data was recorded, either from a CIF or RAW data file. If another
import format was used, or the information was not present in the
file, the default value is used. In this situation, the legend 'Default
Used' appears next to the wavelength value to warn the user that it
may require to be changed manually.

This can be done by either selecting a standard value from the
scrolling list, or by choosing the 'Custom' option at the bottom of the
list of choices, and entering a numerical value in the adjacent text
box. The pattern display is updated for a new standard wavelength
immediately, and for a custom one after the changes to the pattern
have been saved.

The final pattern information display only appears when the pattern
is being edited was originally imported from a CIF or RAW data file.
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Any other data fields that were imported with the data are able to be
examined via the list obtained by clicking on the small disclosure
triangle:

Only the first line of each data field is displayed in the list; if viewing
of a multiple line field is required (for example, an author’s address),
select it from the list. A button will be enabled beside the pop-up
region, labelled Details: 

Clicking this produces a dialog box containing the full text of the
field:

The final region of the of this pane contains the pattern processing
options:

Although patterns will normally have been processed automatically
upon import, it is easy to override those general processing options
for an individual pattern using these controls.

The operation of these controls maybe most easily illustrated upon a
pattern that had no processing performed upon import. Such data
would look something like the diagram below:
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A raw data plot is generally shown in green on the graph pane when
processing has been applied. Blue represents the processed profile. It
is this processed profile that is used throughout the rest of the
program for matching and analysis.

3.3.4  Background Subtraction

Checking the Subtract Background option under Processing Options,
followed by clicking the Process button, causes a second pattern to
appear on the graph pane, generally in blue:

This is the same pattern as the raw data one, but with any unwanted
background removed. This process is achieved by best-fitting several
linked polynomials to the base of the raw data pattern, and then
subtracting them from it.

If results from this are unsatisfactory, this processing option can be
switched off by simply unchecking the box, and clicking the Process
button again.

If the actual curve that has been subtracted is required to be
examined, select the Show Background Curve option in the Pattern
menu. A new window opens, and the calculated background region is
then outlined in blue above the green raw pattern data. 
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The same pattern with background subtracted:

3.3.5  Smoothing

Selecting the Smooth option, and clicking Process causes the pattern
to be smoothed using a wavelet-based SURE thresholding procedure
(see section 3.3.8, References). This allows obvious noise to be
removed without the loss of small or fine peaks.

For example, a detail is shown below of the same region of the same
pattern, before and after smoothing has taken place.

The upper green line is the original unsmoothed profile, and the
lower blue is the same after smoothing has been performed.

To alter the amount of smoothing applied to the individual pattern
being examined, move the slider to the right to increase, or to the left
to decrease it. The display is updated automatically.

The amount of smoothing performed by default can be controlled by
changing the 'Smoothing Factor' value in the program Options
dialog.

3.3.6  Find Peaks

Finally, selecting the Find Peaks option, followed by clicking the
Process button tells the program to use a simple first-derivative peak
search algorithm to locate the main peak maxima in the pattern.
These are then marked with coloured circles on the graph pane.
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For example:

In order to stop small, unwanted peaks being marked, a peak
threshold level can be set, via the slider on the right hand side of the
window:

The default value is 0.05, meaning that no peaks will be marked
below 5% of the maximum peak height. A global default value for
the peak threshold can be set in the Options dialog (see Chapter 5.6,
Matching Options). This value is used when processing multiple
patterns automatically on import. Changes made to the threshold
level in the pattern editor override the global value for the individual
pattern in question.

For example, note the differences in the number of marked peaks for
the same pattern as above, but with the peak threshold level set to
zero:

Individual peak markers can be removed by clicking on them once to
select them (a differently coloured border will appear round the spot
on the graph pane), followed by either clicking the Remove Peak
button, or by selecting the Remove Peak option from the Pattern
menu. After a peak is removed, the peak immediately to the right of it
becomes automatically selected.

It is also possible to remove a peak by clicking on its entry in the
Peak List box to select it, and then clicking the Remove Peak button.
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The number of peaks field reports how many points in the pattern
have been marked as peaks. These are shown by round dots on the
profile displayed on the graph pane.

A scrolling list of all the marked peaks showing their x-position and
corresponding y-value is displayed on the right-hand side of the
pattern editor window:

Clicking on a particular peak in this list causes it to become selected,
and the corresponding peak marker to be highlighted on the pattern
itself to aid in identification.

3.3.7  Notes on processing

Although the processing options (such as subtracting the
background) can be made on a pattern by pattern basis, best results
are obtained in the matching and analysis sections of the program
with databases whose constituent patterns are all processed in a
consistent manner. For example, two otherwise identical patterns
may appear very different if one has been smoothed and background-
subtracted, and the other has not. Consistency in how patterns are
processed generally leads to the best matching and analysis results.

3.3.8  References

Wavelet SURE thresholding is discussed in:

Donoho, D.L.; Johnstone, I.M.; (1994). Adapting to Unknown
Smoothness via Wavelet Shrinkage. Technical Report, Department of
Statistics, Stanford University.

3.3.9  Advanced Pattern Information

The advanced tab has two main regions: one allowing the ability to
mask sub-regions of the pattern, and the other to enter additional
information and thus calculate various constants for the pattern.
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3.3.10  Masking

The upper section in the advanced pane contains the controls to mask
selected regions of a pattern.

If a pattern contains a spurious peak or unwanted standard, or for
some reason the user wishes to only compare a certain region from
the pattern, this option allows a chosen sub-range to be set to a
particular value. (This is generally zero, although non-zero values
may be useful when a high background signal is present.)

To use this option, first decide on the angle range to be masked. Enter
the start and end angles in the relevant boxes. The value in the
magnitude box sets the signal to that value over that range.

Masked regions can also be applied in one step to every pattern in a
database using the Mask Regions... option. This can be found under
the Tools menu, when the database window is frontmost. See Section
3.2.4, Mask Regions.

In the example below, the user wishes to mask the central of the three
main peaks:

As it is at approximately 35° 2θ, the start angle could be 34°, and the
end angle 36°. There is no noticeable background, so the mask value
can remain as zero.
107



108
Clicking the Apply button results in the following:

Notice that the peak is still visible in green. This shows that the
original data - the unprocessed pattern - has not been modified.
However, there is no peak visible in blue - it has been removed from
the processed pattern. It will not appear in the Match window or
other regions of the program which only make use of the processed
pattern profile.

Multiple regions in the same pattern can be masked by repeated
application of the same technique.

To reset all masking, and make the processed profile available again,
click the Reset All button. The same effect is obtained by re-
processing the pattern using any of the standard controls in the Basic
tab.

3.3.11  Additional Pattern Information

This section of the pattern editor contains fields for entering other
information that is known about the sample.

This information is used to calculate various useful constants and
numbers about the pattern. The information calculated here is
required if you wish quantitative analysis to return results as a weight
fraction. 

The first time the Advanced tab is used for a pattern, the Unit Cell
Contents field is taken to be the same as the Formula field from the
Basic tab. However, they are saved separately in the pattern, and
changes to one do not affect the other. The Formula field is
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completely free format, whereas the Unit Cell Contents field has a
fairly strict format, as described below.

The unit cell contents should be entered in the form:

<Atom Symbol><No. of that atom><Space or comma><Next atom symbol ... etc. 

For example, the following entries would be valid:

C3 H8 02
C3,H8,O2
Al O3 H
c3 H8 o2

Non-integer values are permitted.

The following entries would not be valid, for the reasons described:

C 3 H 8 O 2 

-has spaces between the element types and the number.

C3H8O2

-has no spaces at all between each separate entry!

Al(OH)3

-Contains brackets.

Any invalid entries should result in an error: 

Note however that it is possible to enter a string that does not
generate an error message, but that does not produce correct results.
For this reason, entries in this field should be checked carefully. Also
please note that entries are not checked for chemical sense during
calculation.

The field Z represents the number of formula units per unit cell. It
should be a numerical value greater than zero. It can be non-integer.

The fields for unit cell dimensions ( a, b, c, α, β, γ ) all expect
numerical non-zero entries. The angles should be in degrees, and the
lengths in angstroms (Å).
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Once all known information is entered, click the Update button.
Depending on what information was provided, some or all of the text
fields at the bottom of the pane will update with new values.

For example, with the following information entered:

Clicking Update results in the following results:

As in this case all of the fields have been successfully calculated, this
pattern could potentially be used as part of a quantitative analysis
resulting in a weight fraction being calculated.

3.3.12  Additional Calculation Information

For reference, the items above are calculated as follows:

• Unit Cell Volume:
Given unit cell lengths a, b and c in Å, the volume V is then:

• Density:
Given the molecular weight MW in atomic mass units, the num-
ber of formula units per unit cell Z, and cell volume V in cubic
angstroms, the density ρ may be calculated by:

• Linear Absorption Coefficient:
Given the cell volume Vc, and the total photon interaction cross-
section σi in barns/atom for each atom in the unit cell, the linear
absorption coefficient µ  is calculated by:

• Mass Absorption Coefficient:
This is calculated by dividing the linear absorption coefficient µ
by the density, ρ:

µ∗ = µ / ρ

ρ MW Z 1.66××
V

------------------------------------=

1

1 n

i
iVc

µ σ
=

= ∑
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• The database of atomic information is contained in the file
SNAPdb.dat, which should be located inside the folder containing
the SNAP.exe program itself. The format is discussed below:

3.3.13  Atom Info Database Format

There are 11 lines per entry:

Line 1: Format(a3,i4,2x,a12)
Element symbol, charge or oxidation state, full element name

Line 2,3: Format(6f12.6/6f12.6) 
X-ray atomic scattering factors in parameterised form: 
        a1     a2        a3     a4     a5     c   
       b1     b2      b3     b4    b5     0

 Sources:
 - Fit parameters of all atoms/ions (with the exception of O1-)
from publication "New Analytical Scattering Factor Functions
for Free Atoms and Ions", D. Waasmaier & A. Kirfel, Acta Cryst.
1995, A51, 416-431)

 - Fit for O1- based on the tabulated values of Table 2 (D.Rez, P.
Rez & I. Grant, Acta Cryst. (1994), A50, 481-497). 

- Fits for all other atoms/ions based on the tabulated values of
Table 6.1.1.1 (atoms) and Table 6.1.1.3 (ions) (International
Tables for Crystallography, Vol. C, 1992)]
f(atom)=a(1)exp[b(1)]+a(2)exp[b(2)]+a(3)exp[b(3)]+a(4)exp[b(4)]+a(5)exp
[b(5)]+c]

Line 4: Format(f12.6)
Neutron scattering cross section.

Line 5: Format(i6)
Flag for the source of the electron scattering factor.
[In some cases, values for atoms have been 'filled in' for ions. In
this case the key is the same except the flag is negative (e.g. flag
is -1 if have used scattering factors for a neutral atom from Smith
& Burge for an ion).]

Line 6,7: Format(5f12.6/4f12.6) 
Electron scattering factors in parameterised form:
        a1 b1 a2 b2 a3 b3 a4 b4 c
 f(atom)=a(1)exp[b(1)]+a(2)exp[b(2)]+a(3)exp[b(3)]+a(4)exp[b(4)]+c
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Line 8: Format(7e12.4) 
µ ( for the following radiations:
        Ti,Cr,Fe,Co,Cu,Mo,Ag
All ions have the same µ value as the neutral element. µ values
are taken from International Tables Volume C 193-199

Line 9: Format(7f12.6) 
df'  for the following radiations:
        Ti,Cr,Fe,Co,Cu,Mo,Ag

Line 10: Format(7f12.6) 
df'' for the following radiations:
         Ti,Cr,Fe,Co,Cu,Mo,Ag
All ions have the same df' and df''  as the neutral element. df' and
df'' are taken from International Tables Volume C 219-221.

Line 11: Format(2f12.6) 
Covalent radius, van der Waals radius.

Note: Many Covalent radii and most van der Walls radii are 
approximate. The ions are given the same van der Walls radii as 
the neutral atoms. For heavy atoms there is very little knowledge 
of these parameters

In addition to the items specified above, information is taken 
from the following sources:
1. “New Analytical Scattering Factor Functions for Free Atoms 
and Ions”, D. Waasmaier & A. Kirfel, (1995) Acta Cryst. A51, 
416-431.

2. Rez, D, Rez, P. & Grant, I, (1994) Acta Cryst. A50, 481-497.

3. Smith, G.H. & Burge, R.E. (1962) Acta Cryst. 15, 182-186.

4. Doyle, P.A. & Turner, P.S. (1968) Acta Cryst. A24, 390-397.

5. Jiang, J.S. & Fang-Hua, L. (1984) Acta Physica Sinica 33, 
845-849

6. A Bondi, (1963) J. Phys. Chem., 68, 441-51. 

Note: The 'Format' described above refers to Fortran-style fixed 
format numbers. For example if the format is (3I4,2F8.2), the 
program expects to find 3 integers, each of 4 characters, followed 
by 2 floating point numbers, each of which total width 8 charac-
ters (including the decimal point, with 2 places after it).
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3.4  Pattern Matching and Analysis

3.4.1  The Match Window

After selecting a pattern, and clicking the Match option, the Pattern
Matching window appears:

The two main active modes of the program are accessed from this
central window.

3.4.2  Graph Pane

The pattern being matched appears in red the graph pane in the lower
part of the window. It can be zoomed in and out in the same manner
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as in the Pattern Editor, by using the mouse to drag a rectangle over
the relevant area:

3.4.3  Results Pane

The central part of the window is a scrolling list where any matching
results are displayed. This results pane contains, from left to right,
the following fields:

The first field contains the number of the pattern, where No. 1 is at
the top of the list. Clicking once in this leftmost column for a
particular pattern entry results in a coloured dot appearing, and the
corresponding pattern being shown in the graph pane, superimposed
upon the matched pattern. The spot is the colour the pattern is
displayed on the graph pane. 

Clicking the same column again removes the pattern from the graph
pane.

The next field is the Name/ID field. This normally shows the
chemical name, but if this is "(Unknown)", it shows the short-
filename of the pattern instead.
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Next is the Rank value calculated for each pattern. This is obtained
by summing the results from the four different matching tests, in a
user-defined manner. By default the two are combined in a one to one
ratio - see Section 3.4.8.2, Rank Weightings.

The Parametric field displays the result of the parametric correlation
coefficient.

The Spearman field displays the result of the Spearman non-
parametric correlation coefficient.

The Kol-Smir field displays the result of the Kolmogorov-Smirnov
non-parametric statistics test.

The Para Peaks field displays the result of the parametric correlation
coefficient, applied to marked peak regions only.

These individual tests are described in detail later.

The first two tests are applied to the entire full profile (i.e. every
single datapoint) of each entry in the database. Consequently, they do
not require any peak markers to have been located in the individual
patterns. The last two tests are performed only upon individual
marked peaks that coincide between the sample and database
patterns.

3.4.4  Status Bar

Above the results field is the Status Bar display:

The left side of this displays any status messages or errors. The right
hand side consists of a progress bar. This indicates how far through
the matching process the program is at any one time.

3.4.5  Mode-independant Controls

The upper-right portion of the window contains the matching
controls. These are common to all of the operational modes:
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Information display:

The top section contains the chemical name for the selected pattern
(if known). The Edit button allows direct access to the Pattern Editor
for the current pattern. This means that, for example, peaks could be
added or removed at this stage.

The bottom section shows the name and location of the database the
user is matching the unknown pattern against.

If either of these are too long to be displayed in the space, then the
details are truncated, but the full information can be accessed by
resting the mouse cursor over the appropriate region for a few
seconds to reveal a 'tool tip' containing the full details.

On the far right hand side are the window controls:

Close - closes the window and returns to the database display. If any
matching has been done, and results from it have not been saved,
then the program will check if the user wishes to save them to a file.

Save Results - once a matching calculation has taken place, this
option allows the tabled results to be exported to a either an ASCII
text or Microsoft Excel compatible file. Enter the filename and select
the filetype from the list in the standard File Save dialog box. This
option is also available from the File menu. (N.B. only the results
from the most recent matching run will be saved by this method,
hence separate saves would be required to keep results from multiple
runs.)

Print - brings up a standard Windows Print dialog, and causes the
current contents of the graph pane to be sent to your selected printer.
This option is also available under the Graph menu.

Note that printing to a postscript printer may be very slow as every
single datapoint (usually several thousand) is sent to the printer.
Much faster results can be obtained with a non-postscript printer, for
example an inkjet.

The remaining controls in the window are the mode-dependant
controls.

The user can switch between the two matching modes by means of
the tabs in the top left of the window:
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3.4.6  Pattern Matching

The first tab represents the Pattern matching program mode: 

This process involves the repeated comparison of pairs of datasets,
the sample and the database patterns.

The sample pattern is the pattern that is being compared to the rest of
the patterns in the database. For each pattern, a comparison is made
as follows:

1. The full profiles of the patterns are compared on a point by point
basis using the non-parametric Spearman rank-order coefficient test.
The result from this appears in the results column headed
‘Spearman’. A score of 1.0 represents a perfect match, 0.0 the worst
possible match, and -1.0 a negative correlation (see Section 3.6,
References).

2. A parametric Pearson equivalent of the Spearman test is then
applied, both to the full intersecting profile (results shown in column
Parametric), and to individual corresponding peaks (results shown in
column Para Peaks). 

3. If any peaks have been marked in the sample and database
patterns, the probability of correlation between the two is also
calculated using the Kolmogorov-Smirnov test (see Section 3.6,
References).

4. The range of each peak to be tested is taken to be the intersection
of the two peaks ranges, calculated by tracing their shoulders until
either the intensity falls below a set threshold, or the intensity starts
to increase again. 

5. The pattern with the greater number of peaks is taken as a
reference, (its number of peaks = m).

The Kolmogorov-Smirnov test is then performed on each of these
peaks, and a probability value p returned for each one. This is 1.0
where peaks are identical and zero when a peak is matched against no
peak.

Then K-S value for the overall pattern is: 
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(p1+p2+p3+…+pm)/m

which returns a value between 0 and 1.0. Note that the test results for
each individual peak can also be examined in the Single Peak Viewer
- see Section 3.4.8.6, Match Peak.

6. Results are reported in the Kol-Smir column, where a result of 1.0
corresponds to a perfect match. This is also true of the Para Peaks
result, which is calculated in a similar manner.

7. Finally, a Rank value is calculated for each database sample after
comparison, comprised of a weighted mean of each of the available
statistics. These weights are user-definable - see Section 3.4.8.2,
Rank Weightings.

3.4.7  Non-quantitative Peak Matching:

Click the Match button (or press F1). Matching will commence.
Progress is indicated by the progress bar and status bar:

Once matching has completed, the results will be displayed in the
results pane:

The best overall match is shown at the top of the list, which is sorted
by default in descending order of Rank. The best match is always the
pattern you are matching against. This provides a useful check that
everything is operating correctly, since the unknown pattern matched
against itself should give a perfect match in all four tests.

i.e. it should have a 

                              Spearman of 1.0 

                              Parametric of 1.0

                              Kol-Smir of 1.0

                              Para Peaks of 1.0

and a rank (calculated from 0.5×Spearman + 0.5×Parametric) of 1.0
(assuming default weightings).
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To view a pattern overlayed on the matched pattern, click once in the
leftmost column of that pattern (the third row in the example below):

Clicking once in this column for a particular pattern results in a
coloured dot appearing, and the corresponding pattern being shown
in the graph pane, superimposed upon the matched pattern using the
colour of the spot. 

Clicking the same column again removes the pattern from the graph
pane. Up to seven different patterns can be displayed at once in this
manner. To remove multiple displayed graphs in one step, a Remove
Overlaid Graphs option is available from the Graph menu, or the
pop-up menu obtained by right-clicking on the graph region.

The sort-order in which the results are displayed can be changed by
clicking the header of the column on which you wish the results
sorted. Clicking the same header again causes the results to be sorted
in that same column, but in the opposite order i.e. repeatedly clicking
on one header causes the sort order to switch between ascending and
descending.

If the top few patterns appear to be a really bad match, the chances
are that the list has been sorted in descending order. Click again to re-
sort.
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3.4.8  Advanced Options

3.4.8.1  Refine linear/non-linear offset

Selecting the Refine linear/non-linear offset checkbox causes an 2θ-
axis offset to be computed when comparing patterns.

For example, if two patterns are very similar, except that one is offset
by +0.3 degrees along the 2θ-axis from the other, selecting this
option should reveal this.

The maximum amount by which patterns are allowed to be offset can
be changed from the default of 0.4 degrees by changing the values in
the Advanced pane of the program Options dialog box. The program
attempts to maximise the correlation between patterns by varying the
values a0 and a1 in the equation ∆2θ = a0 + a1 sin θ, although cos θ or
sin 2θ may optionally be used instead.

After turning the option on, click Match to begin the matching. This
process will be much slower than the default matching, as many
more calculations are being performed for each pattern.

Once complete, the results are displayed as before, with one
difference. There is now an additional column on the far right - Offset
used: 

This corresponds to the amount of offset (a0, a1) required to
maximise the correlation coefficients for each pattern.

As a shift of up to about one degree can be possible when dealing
with patterns of the same substance recorded with different
experimental conditions, and this option may be useful to reveal
matches between patterns that at first appear to be different.

Note that at present the shift only applies to the profile based tests
and that this option can slow down the operation of the program
substantially. 
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3.4.8.2  Rank Weightings

For patterns of a particular type, it may be the case that one particular
correlation coefficient proves to be more useful than others. 

In order to relate this fact to the overall ranking of pattern matches, it
is possible to change the way the overall rank is calculated. 

Normally, this is of the form:

Rank = w1×(Parametric score) + w2×(Spearman score)

+w3×(Kol-Smir score) + w4×(Para Pks score)

where w1 and w2 are the rank weightings, normally both 1.0. By
varying these weightings.

It is possible to alter the overall rank order of the matched patterns,
for example:

Once the weighting have been altered, the Apply button is activated.
Clicking it applies the new rank weightings to the current list of
matched results:

If rank weightings are changed from the default values before a
match has taken place, the new values are used automatically when
the results are displayed.
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3.4.8.3  Limit x-axis range...

Turning on the Limit x-axis range checkbox has the effect of limiting
the analysis calculation to a subset of the entire x-axis range of the
unknown pattern. This can be useful if a particular feature of the
pattern is causing problems for the calculation.

The default values in the textboxes are the full range of the unknown
pattern, although these can be changed by either:

1. Typing in the desired start and end angles of the required range
into the textboxes, or:

2. Zooming in to the desired range by clicking and dragging a zoom-
rectangle on the graph pane. The start and end ranges of the 2θ-range
of the zoomed region of the pattern will be automatically placed in
the textboxes.

To use this feature, turn the checkbox on, enter the desired start- and
end- details, and click the Calculate button.

3.4.8.4  Difference Plots

When comparing two very similar patterns it can be useful to get a
different kind of visual feedback as to their similarity. One such
feedback method is the difference plot, which subtracts the selected
database pattern from the unknown pattern and displays the
remainder. This feature is accessed by first clicking once to select a
database pattern from the list of match results, and then either
selecting Show Difference Plot from the Pattern menu, or clicking
once with the right-hand mouse button to access the results pane pop-
up menu:
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Selecting the Show Difference Plot option brings up the following
window:

The Print button outputs the graph pane to the local Windows printer.

The Close button returns to the main Match window. 

The Export button saves the difference profile to an ASCII text file.

3.4.8.5  Match All

This option is only available for a maximum of 1000 patterns in a
database. It matches every pattern in the database against every other
pattern in one step, and displays a matrix of results. 

Please note that with this large number of patterns the matching
process will take some time to complete, and this will be exacerbated
if the allow x-offset option is enabled.

Clicking the Match All button produces a dialog in which to select
the individual tests to be used:
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Select the tests of choice, their required weightings and enter the
highlight cut-off value (any results greater than this value will be
highlighted in the results table).

Clicking OK initiates the matching process. This may take some
time, as n2/2-n matching tests are being performed (where n is the
number of patterns in the database). When over 50 patterns are being
matched, a window with a progress bar is displayed. When complete,
the results are displayed as follows:

The results pane is automatically vertically enlarged to show more of
the results. To toggle between this enlarged size, and the standard
size, click on the grey region between the results table and the graph
pane.

Any test scores that are above the cut-off level selected in the
preceding dialog box are highlighted in bold. This procedure may
reveal hitherto unnoticed correlations between different patterns in a
database.

All the matching results obtained against upd3-004 are shown in the
first column, upd3-005 in the second, and so on. By looking at the
intersections between patterns, an idea of the similarities between
any two database patterns may be obtained.

To view a particular correlation of interest graphically, click once on
the grid square containing the result. For example, the patterns upd3-
005 and upd3-008 have a match score of 0.9251 in the above result.
Clicking on the square containing the 0.9251 results in the two
patterns of interest being superimposed on the graph pane below to
allow visual comparison.

If the option to refine pattern shifts was selected, after clicking on a
given correlation, holding the mouse steady for a second brings up a
tooltip containing the calculated best offset for the two patterns, in
the form (a0, a1) as discussed above.
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3.4.8.6  Match Peak

Individual corresponding peaks can be easily compared in this mode.
This can be particularly useful to spot very small differences between
otherwise almost identical patterns: click once in the results list to
select the pattern you wish to compare the unknown pattern with.

Then click the Match Peak... button (or select Show Peak
Comparison from the Pattern menu). The window will appear for the
first of the matched peaks:

Clicking Next Peak closes this window and opens another for the
next peak common to both patterns. Cancel returns to the match
window.

Detailed results of the Kol-Smir and Parametric Peaks test results are
shown on an individual peak basis in this window (these individual
values are combined to give the result for the whole pattern displayed
in the main match window results pane).

3.5  Quantitative Analysis

The second tab represents the second of the main program modes:
Quantitative Analysis:
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This is used with patterns of mixtures to estimate their percentage
composition from pure component patterns contained in the
matching database. Note that for the method to work successfully,
patterns corresponding to all pure phases in the mixture must be
present in the current working database.

3.5.1  Standard Quantitative Analysis:

Click the Calculate button (or press F3). Analysis of the selected
unknown pattern will commence. Prior to analysing, a pattern
matching calculation is performed.

The progress and status bars indicate this:

Before showing that analysis is taking place:

Note that this process may take some time, depending on the number
of patterns included in the calculation. The progress bar is not
updated during the calculation of relative proportions, so patience is
required as the calculations are very processor intensive, and may
take several minutes. The screen is not updated or redrawn while this
is happening.

Once analysis has completed, the results will be displayed in the
results pane:

Note that the headers have changed. Although the first 6 columns are
the same as before, there are 3 new columns:

1. Offset used:

The offset given to a particular pattern that gave the best match;
see section 4.4.2.1

2. Scale % or Weight %: 

Displays what proportion of the mixture is accounted for by an
individual database pattern. This is normally displayed as a scale
percentage i.e. what percentage of the mixture pattern does each
individual phase constitute?
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If all the required advanced pattern information has been entered
(see Section 3.3.11, Additional Pattern Information), the program
converts this scale percentage to an actual percentage of the mix-
ture by weight. In this case, the column heading is changed to
Weight %. 

Note that this information must have been entered for ALL phases
in the mixture to be able to calculate a weight fraction.

3. Std Dev.

The standard deviation of the percentage composition calculation
reported for each pattern.

By default, the maximum number of patterns that will be reported as
included in a mixture is 6, although this is easily changed. (see
section 5.6, Matching Options)

As before, patterns can be displayed over the unknown pattern by
clicking once in the leftmost column:

This can provide valuable visual feedback for the user to check if the
suggested constituents of the unknown mixture are indeed correct.

To view a phase pattern on top of the mixture pattern scaled to the
percentage result suggested, check the Scale Graphs checkbox, and
then click on the pattern to display it in the usual way. If the Scale
Graphs option is checked, and the Show Difference Graph option is
selected, the individual phase pattern will be subtracted from the
mixture pattern scaled to the relevant %. The amount of scaling
performed is shown in the difference graph window:
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Additional feedback on the results is given by the calculated error on
the suggested percentage, and by how good the matching results of
the Spearman, Parametric and Kol-Smir tests were for each phase.

Occasionally if an incorrect pattern has been suggested by the
program, this may be shown by extremely low values of the
Spearman, Parametric and Kol-Smir tests, and such patterns can be
marked to be ignored during subsequent runs - see 3.5.2.2, Exclude
patterns...).

3.5.1.1  Automatic Missing Phase Detection

The program examines the results from the analysis, and based on the
calculated error and residual trace can suggest if the result does not
account sufficiently for all of the unknown pattern intensity:

This would occur in a case where not all of the phases present in a
mixture pattern were in the database being used.

Selecting Yes in the above dialog causes the program to simulate a
pattern corresponding to the intensity unaccounted for by the current
results. (This simulated pattern is equivalent to the pattern obtained
by saving the positive intensity trace from the Residual window; see
Section 3.5.2.6, Residual Window for more details.)

The calculation is then re-run to include this simulated missing
phase, and results re-calculated:

Note that results cannot be calculated in terms of weight fraction
when simulated missing phases are included.

After doing an analysis, and choosing to include a missing phase,
when the user closes the match window, the program checks to see if
the simulated phase should be retained in the current database or
discarded.

If the pattern is retained, it shows up in the database window with a
name of  'Simulated Missing Phase', although this can of course be
altered in the Edit window later.
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The settings used by the program to determine if a missing phase
may be present can be controlled by the user; see section 5.3.10 on
page 144.

3.5.2  Advanced Analysis

3.5.2.1  Refine linear/non-linear shift

This option works as described in Section 3.4.8.1, Refine linear/non-
linear offset.

3.5.2.2  Exclude patterns...

Selecting the Exclude Patterns checkbox can be extremely useful to
narrow down the number of patterns to be considered as components
of the unknown pattern. It does this by excluding patterns that are
below user-set thresholds on any of the matching tests to be included
in the quantitative calculation. 

The default values may be easily altered by changing the relevant
values in the text boxes. The best values to use can change depending
on the type of data being considered. 

Generally, the best approach is to perform a standard analysis with
defaults to begin with, and see if any poorly matching patterns have
been included. The results from this will then give a feel for what
values the cut-offs should be set at. This option also has the side
benefit of speeding up the process as less patterns are used.

To use this option, turn on the checkbox, enter the desired values, and
click the Calculate button as normal.

3.5.2.3  Limit x-axis range...

Turning on the Limit x-axis range checkbox has the effect of limiting
the analysis calculation to a subset of the entire x-axis range of the
unknown pattern. This can be useful if a particular feature of the
pattern is causing problems for the calculation.

The default values in the textboxes are the full range of the unknown
pattern, although these can be changed by either:
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1. Typing in the desired start and end angles of the required range
into the textboxes, or:

2. Zooming in to the desired range by clicking and dragging a zoom-
rectangle on the graph pane. The start and end ranges of the x-range
of the zoomed pattern will automatically be placed in the textboxes.

To use this feature, turn the checkbox on, enter the desired start- and
end- details, and click the Calculate button.

3.5.2.4  Ignore selected pattern

If a particular pattern included in the list of suggested results is
known to be incorrect, it can be excluded from the calculation, by
clicking once on it in the results pane to select it, and then by either
right-clicking to bring up the results-pane pop-up menu, using the
Mark/Unmark Pattern as Ignored option in the Pattern menu.

Select Mark/Unmark this Pattern as Ignored. A large, bold X will
appear next to the pattern name in the first column, to indicate it is
being ignored for the purposes of the calculation.

Once a pattern has been selected as ignored, click the Calculate
button again to re-run the calculation, which will be performed
without any the ‘Ignored’ patterns.

If the pattern was incorrectly marked as ignored, it may be unmarked,
by simply repeating the above procedure, and selecting Mark/
Unmark this Pattern as Ignored once more. The large X will
disappear.

It is possible to mark multiple patterns to be ignored by repeating this
process with different selected patterns.
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3.5.2.5  Ignore All patterns except.

In situations where the particular constituent patterns of an unknown
mixture are known, but only the relative percentages of each are
unknown, it is useful to be able to only include the correct
components in the calculation. This not only speeds up the process
but can generally improve the accuracy of the results.

The simplest way to achieve this is to first mark all of the patterns in
the database to be ignored, and then un-mark the individual patterns
that are known to be present in the mixture.

To achieve this, right-click on the results pane to bring up the pop-up
menu, or use the Pattern menu: select Mark/Unmark all Patterns as
Ignored from the options presented. A black bold X will appear in
the first column of the results pane next to every pattern shown. (N.B.
if any patterns have previously been marked as ignored, these will be
un-marked by this process).

Next, individually unmark the patterns that are to be included by
selecting them singly, and selecting Mark/Unmark this Pattern as
Ignored from the pop-up menu. Then select Calculate as normal.

To unmark all of the marked patterns simultaneously, select Mark/
Unmark all Patterns as Ignored again from the pop-up menu. All
patterns that were marked as ignored will become unmarked, and
vice-versa.

N.B. If the patterns that have been marked and unmarked become
confused, it is possible to reset all of the patterns in the database to
the default state of all being included in a calculation, by closing the
match window and then re-opening it.

3.5.2.6  Residual Window

To see if the suggested results are correct, or if they include a pattern
not present in the mixture, or if they miss out a pattern that should be
there, the residual window constructs a calculated pattern made up
from the various individual patterns suggested as mixture
components, in the proportions calculated.
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Clicking the Residual button brings up the following window:

The upper window overlays the original mixture pattern (in blue)
with the calculated one using the suggested results (in red/brown).

The difference between the two profiles is shown in the bottom
window. Large negative peaks in this correspond to incorrect peaks,
and would suggest one or more of the suggested constituent phases
are incorrect. Positive peaks here would represent peaks in the
original pattern not accounted for in the suggested results.

The simulated mixture pattern can be saved to an ASCII text file
using the Export Simulated button. The difference plot can be saved
to an ASCII file using the Export Difference button.

In the latter option, two different formats are available from the pop-
up list at the bottom of the Windows Save dialog. The first (Full
residual) saves the difference profile as it is shown in the window,
with some peaks negative and some positive. The second (Positive
residual) ignores any negative peaks and saves only positive ones in
order to make a pattern comprising only intensity not accounted for
by the current pure phases.

Exported difference profiles can be re-imported and treated as new
patterns, and further quantitative analysis can be performed using



References
them if required. This can be done manually or by using the Add to
Database option. 

3.5.3  Other Options

Edit this pattern

Having performed a match or analysis procedure, it may be that one
pattern listed in the results table is of particular interest. It is possible
to view the Pattern Editor window for such a pattern directly, by first
clicking once on the pattern of interest in the list, and either selecting
Edit from the Pattern menu, or Edit this Pattern from the pop-up
menu.

Either option brings up the editor dialog allowing detailed
information about a pattern to be viewed or edited.

Match against this pattern

Having performed a match or analysis procedure, it may be that one
pattern listed in the results table is of particular interest, and the user
my wish to perform an additional match or analysis with that pattern.

It is possible to open another Match window for such a pattern
directly, by first clicking once on the pattern of interest in the list, and
either selecting Match from the Pattern menu, or Match against this
Pattern from the pop-up menu.

Either option brings up a new Match window. The original Match
window is still open and may be viewed as desired. As many Match
windows as required may be open at the same time.
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CHAPTER 4 Using PolySNAP: Quality Control
4.1  Introduction

This option is designed for situations where the stability of a material
is being monitored over time; for example as part of a production line
system, or for periodic checks for alignment or other issues compared
to the last time a standard sample was collected.

A certain number of Reference patterns must be available; these are
patterns that for the purposes of the analysis are considered to be a
good representation of what is expected to be seen.

Various Sample patterns are then imported and compared to those
reference patterns, and any that vary significantly from the ideal are
noted and highlighted.

The results are displayed graphically with 'good' sample patterns
shown within the surface of reference patterns, and 'bad' sample
patterns appearing outside it. The tolerance for what is considered
worth warning the user about can be adjusted to suit.

4.2  Worked Example

The best way to illustrate the value of this mode of operation is
through a worked example. The data for this example can be found in
the quality folder, within the tutorial folder installed along with the
program.
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Selecting Quality Control from the Automatic mode menu brings up
the following control window:

The user simply identifies a folder containing the new sample
patterns to be checked, and a folder containing some pre-existing
reference patterns to compare them to. In this case we select
tutorial\quality\samples and tutorial\quality\references accordingly.

The specification of an output folder is also required; C:\temp for
example.

The lower section shows the current setting of the Quality
Threshold value in the program Options window, Automatic:
Advanced pane:

This acts a 'strictness' control. The lower the number (ranging from 0
to 1.0), the less far the sample patterns are allowed to vary from the
centroid position of the reference patterns before they are highlighted
as potentially a problem.



Worked Example
Clicking OK brings up the standard PolySNAP data loading window.

During the analysis phase of the calculation, a warning dialog is
displayed if any of the sample patterns are considered to be outwith
the set threshold; in this case:

A simplified version of the standard PolySNAP results window is
then displayed, showing just two tabs, the 3D Plot and the Logfile.
By default the pattern information pane is hidden, but this can be
137



138
shown by selecting Show Pattern Information from the Display
menu.

The main plot can be interacted with like the standard 3D plots. The
red spheres are the new sample patterns, and the reference samples
are represented by the shaded green area. Sample patterns within this
shaded zone are considered to have passed the analysis, whereas
samples outwith it, such as P21 in the above example, have failed.

Clicking on the Logfile tab brings up a PolySNAP audit trail log,
which notes details of the patterns imported, and highlights any
thought to be suspect.



CHAPTER 5 Program Options and Defaults
5.1  Accessing Options

The options menu can be accessed at any point from the Edit menu.

The Options window is comprised of four tab sections which can be
selected from the top of the window.

These are each described in turn below.

Note that that ‘Manual’ settings do not affect Automatic Analysis
runs and vice versa.
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5.2  Manual Analysis: General Options

When the Options window first opens it displays the Manual
Analysis section first by default.

This first tab is split a general section and a processing section.

5.2.1  General Section

Double-clicking Database Lists

The first option controls whether double-clicking a pattern entry in
an open database window brings up the match window or the pattern
editor window. By default this is set to being the Pattern Editor.

Graph Drawing

Decides whether the patterns are displayed in a high-quality, but slow
to draw mode, or a faster but lesser quality mode. The slower option
is the default.

Use Bold Grid Lines checkbox controls if a black grid shown behind
patterns on the graph, or if light-grey lines are used. The latter is the
default.

The two Data Display checkboxes control whether the patterns are
displayed as read in from their original data files, or flipped in either
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the x or y axes. These options may be useful when examining
different types of non-powder diffraction x-y data.

5.2.1.1  Results Display

This section contains a toggle to switch between displaying the
Chemical name/ID or the Filename of patterns in the Match window
and other results lists.

5.1.1.3 Processing Options

The next section controls which of the three main processing options
are turned on by default in the window which appears when patterns
are being imported. A default wavelength can be selected - either one
of the standard ones from the pop-up list, or a custom value entered
into the text box. The default value is CuKα.

5.1.1.4 Smoothing Factor

Varying the number in this box controls the amount of noise removal
performed by the wavelet smoothing. The larger the number, the
smoother the resulting pattern. Be careful of oversmoothing and
losing valuable information. 1 is a good default value in most cases.

5.1.1.5 Default Peak Threshold

The next control changes the default peak threshold. Only peaks
whose maximum intensity are above this cut-off value will be
marked as such. The default value of 0.05 can be changed by
dragging the slider left or right. The corresponding numerical value
for the threshold is shown to the right of the slider.

5.2.1.2  Default Pattern Database Location

The final region lets the default database be located and selected.
This is the database that is opened when the Open Default option is
selected from the File menu.

To change, click the Change... button. A Windows file selection
dialog box will appear. Locate and select the database required, and
click Open.

The file and location selected should be displayed in the window. In
the example shown above, the default is processed.par which is
located at C:\.
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5.3  Manual Analysis: Advanced Options

The second tab, Advanced, contains the more in depth matching and
quantitative analysis controls.

5.3.1  Default Match Options

This section controls the default values for the Rank Weightings in 
the Match Window.

The default values are: Spearman 0.5, Parametric 0.5, Kol-Smir 0.0, 
Para Pks 0.0. 

5.3.2  Default Match All Options

This section controls which matching tests and what corresponding
weightings come up by default in the Match All settings window.
Initial values are to use the Spearman and Parametric tests, each with
a weighting of 0.5.

Note that it is recommended that the sum of any weights used is 1.0.

5.3.3  Optimise x-shifts

This section controls how patterns will be shifted in an attempt to
maximise the correlations between them. By default the program
attempts to maximise the correlation between patterns by varying the
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values a0 and a1 in the equation ∆2θ = a0 + a1 sin θ, although cos θ or
sin 2θ may optionally be used instead by selecting the relevant item
from the drop-down menu.

The values of a0 and a1 that may be entered here represent the
maximum values that will be allowed by the program during the
refinement.

5.3.4  Report a maximum of n components

The maximum number of patterns that PolySNAP suggests as being
constituents of an unknown mixture can be easily changed by the
user. By default, it reports a maximum of 6 components. This default
can be changed to any integer between 1 and 15. Note that this must
be done before a match window is opened in order for any changes to
take effect.

5.3.5  Matrix tolerance

The second controls what proportion of the patterns that do not
contribute significantly to the overall pattern are ignored. This should
be a number between 1 and 0. The default is 1x10-5. 

5.3.6  No. of refinement loops

The Refinement loops field controls how many loops of refinement
the program performs. This should be an integer between 1 and 3. If
it is 1, all patterns are included. If it is 2, all patterns are used, then
only the top 15 are included the second time around. If it is 3, then all
patterns, then the top 15, then the top N, where N is the number of
components selected above, are included.

5.3.7  Ignore pattern below...

This (default is 0.001) controls how much of each database pattern is
treated as background upon inclusion in the calculation. This is done
to simplify the problem and reduce the effect of background noise.

5.3.8  Hide zero % components in results

With a database containing a large number of patterns, performing an
analysis usually results in a few patterns contributing towards a
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mixture, with the rest being ranked at 0.0%. This option hides any
patterns that are not considered contributors to the mixture.

5.3.9  Calculate Weight Fractions if possible

This checkbox allows the program to automatically display analysis
results as a weight fraction rather than proportional to scattering
power, if all the necessary pattern information is available.

With it turned off, a scale percent is reported even if all pattern
information is present. (See section 3.3.11 on page 108 for
information on what details are required to calculate a weight
fraction).

5.3.10  Suspect Missing Phases...

These controls set the values beyond which the program considers
that missing phases may be present in a mixture (see section 3.5.1.1
on page 128 for more information). 

The two criteria used are the size of the largest calculated error on the
quantitative results, and if the residual intensity trace has any peaks
above the default minimum peak height.

In addition, if the Automatically Recalculate for Missing
Phases option is checked, the program will recalculate to include
missing phases automatically, without consulting the user first. The
default value for this is to consult the user.

5.3.11  Use raw rather than processed profile for residuals...

Thiis checkbox determines whether the original pattern profiles, or
the processed profiles (e.g. with background subtracted, etc.) are
used to construct the simulated pattern in the Residual window.
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5.4  Automatic Analysis: General Options

5.4.1  Default File Locations

5.4.1.1  Default Directories 

If no working input directory has been specified via a command-line 
argument or other input method, the program uses the directories 
specified here as its default. To alter any of them, click on the Browse 
button to bring up a directory selection window: 

Selection of a new working directory is carried out by first selecting
the correct drive letter from the pop-up menu at the top, and then
navigating to the desired folder via the lower navigation box. To open
a folder to see what other sub-directories it contains, double-click on
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it. When the desired folder has been located, double click on it to
ensure it is selected, and click OK. 

Ensure these settings are correct, as problems here may prevent the
program from running correctly in automatic mode. Note that setting
the input and output directories to the same location is not permitted,
and will generate an error.

5.4.2  Data Import and Processing 

The settings here control what processing, if any, is performed on the
raw patterns being imported. The same options are applied to all
patterns being imported, so it is worth experimenting to find the best
combination of settings to work with particular types of data.

5.4.2.1  Wait to receive [ ] data files, checking every [ ] seconds:

If not set otherwise by means of a command line argument, the
program looks here to see how many data files it should expect to
receive before completing importing. The default is 96, any integer
between 1 and 1500 is acceptable. Note that at least 4 patterns are
required to be able to do any cluster analysis.

The latter number sets how often SNAP looks in the input directory
specified above to see if any new data files have appeared. The
default is every 0.05 seconds, and any numerical value between 0.01
and 60 (i.e. 1 minute) is acceptable. Note that between each check,
the interface will be unresponsive, as the program is sleeping to
conserve system resources. As a result, it make take up to the time set
here for the program to respond to user input.

5.4.2.2  Time-out after [ ] minutes with no new data:

If no new data files have been found [ ] minutes after the last file was
imported, the program stops waiting for data even if the number of
data files expected has not been met. The default is 5 minutes, a
numerical value between 0.5 and 720 (12 hrs.) is required.

5.4.3  Processing Options

The next region of the dialog box controls which of the main
processing options (e.g. background subtraction and smoothing) are
applied by default when patterns are being imported. For full
descriptions of these options, see section 5.2 on page 140. 
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5.4.3.1  Minimum Peak Intensity Threshold

This control changes the default peak threshold. Only peaks whose
maximum intensity are above this cut-off value will be marked as
peaks, and therefore included for comparison in the peak-based tests.
The number of peaks marked can also be used as an indicator of
crystallinity of a sample. The default value is 0.05; the acceptable
range is from 0 to 1.0.

5.4.3.2  Smooth Data and Smoothing Factor

Varying the number in this box controls the amount of noise removal
performed by the wavelet smoothing routines. The larger the number,
the smoother the resulting pattern. Be careful of oversmoothing and
either losing valuable information, or introducing artifacts into the
signal. The default value is 1.

5.4.3.3  Powder Data: Background Subtraction

Selecting the first checkbox performs the standard powder
background subtraction as used in Manual Analysis. The second
checkbox, Strict subtraction, applies an additional pass that is
intended for use when there is a large amorphous contribution to the
patterns that is required to be removed. It should be used with caution
as the possibility of removing more pattern than is required is more
likely.
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5.5  Automatic Analysis: Advanced Options

The first three options headed Advanced Calculation options all open
new options window and so are described separately in section 5.6 on
page 150, section 5.7 on page 153 and section 5.8 on page 154.

The other miscellaneous options listed below include controlling
how PolySNAP will show the display window after the analysis has
been completed. 

Require Admin privileges to change program settings - with this
option on, only a user that has Administrative privileges on the local
machine is permitted access to the program Options. Note that
Admin privileges are required to toggle this option.

Auto-save copy of report to: <file location> - With this option
checked, the a copy of the current report is automatically backed up
to the designated location whenever a automatic report is generated
by the user (Section 2.3.16). To change this location, with the
checkbox selected, click once on the name of the file. A standard
folder-selection dialog box will appear. The location displayed will
update to reflect the new selection.

Warn before deleting any output files - with this option selected, the
user is always warned when selecting an output folder that already
contains files from a previous program run. The older files will be
deleted if the user continues. If the related option, Allow logfile to be
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deleted, is off then logfiles and errorlogs are merely appended to on
subsequent runs, rather than started afresh.

Display sample images inline if present - with this option on,
PolySNAP automatically resizes the graph pane in the Display
window to show a small preview of the sample images (if present).
With this option off, the images may still be viewed using an external
graphics program. Sample images are expected to be in the same
input folder as the data files, with the same filename, differing only
by having a .jpg file extension.

Show graphics toolbars when available - in the results display
window, several of the graphics panes have toolbars to allow quick
access to commonly used functions. This option sets if they are
displayed by default or not.

Warn when areas of low signal are detected - this option brings up a
warning dialog box when the program detects large areas of a pattern
that appears to have little or no signal in it. For example, if a pattern
has been collected to 55 degrees, but has no peaks above 30, when
this option is turned on the program will suggest masking the region
above 30, which may reduce the noise and improve the results of the
calculation.

Pie/Stack display: Show [ ] pies per row - For a display puposes the
number of pies in a row can be altered to suit the users needs. e.g. for
a run of 12 samples the number entered may be 6, which would
create 2 rows of 6. The minimum value is 2 and the maximum value
is 199. If the value is set to -1, the program makes its own judgement
as to the best number to display for a given run to fit in the display
window, and this behaviour is the default.

Set GADDS... - clicking this button brings up a dialog box in which
to enter the location of the script directory for the Bruker GADDS
Pilot software. Entering the correct location (by default,
C:\saxi\gadds\scripts\) and clicking OK copies a file,
DisplayFrame.slm, to that directory. The presence of this file in the
correct location permits the integration between the PolySNAP
display window and the GADDS software (see Section 2.3.17).

Extract label from filename in the pattern in the form - With this
option on, sample ID information contained be parsed and used to
identify the pattern on the Cell Display and Dendrogram Display.
With the first option, Label.pat, the entire unique part of the filename
is used (though only the final 7 characters are displayed; the full label
can be seen in a tooltip by hovering the mouse over a sample). With
the second option, xxx_Label.pat, only that portion of the filename
after the final underscore character is used as a sample label. The
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third option, xxx_Label1_Label2.pat uses the information after the
final two underscores as the label, and ignores any previous part of
the filename. 

Look for sample preparation info in external file: with this option on,
the program looks for a file in the input directory called <input>.dat,
where <input> is the name of the containing directory.

Use format information for 6D plot from: - clicking this option
allows the user to select a different sample_info_format.txt file. The
default format file is installed with the program in its Program Files
folder. If an alternative location is selected here, it is used until a
different location is selected. 

For more information on the sample_info_format file, see
Section 2.4.2.

Quality Control Mode - see “Using PolySNAP: Quality Control” on
page 135.

5.6  Matching Options

Clicking the Matching button from the Automatic Analysis Advanced 
Options window will open the Matching Options window.

The matching performed by PolySNAP is equivalent to the Match
All function in Manual Analysis - all of the loaded sample patterns
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are compared to each other, and a correlation matrix produced. It is
this correlation matrix that is analysed further by the cluster analysis
and related routines in PolySNAP.

Therefore, matching is the key phase of the analysis, and a suitable
selection of tests and weightings is often the deciding factor between
a useful or less viable analysis. These settings should not normally
need to be altered in day-to-day usage of the program.

Any combination and weighting of the four tests listed may be
employed, however note that the combined weights of the tests to be
used must sum to 1.0 if sensible results are to be obtained. It is not
recommended to mix Kol-Smir and Para Peaks with Spearman and
Parametric.

The tests available are:

Spearman - with a weight of [ ] - this can have any value between 0
and 1.0. The default value is 0.5.

Parametric - with a weighting of [ ] - this can have any value
between 0 and 1.0. The default value is 0.5.

Kol-Smir - with a weighting of [ ] - this can have any value between 0
and 1.0. The default value is 0.5.

Para Peaks - with a weighting of [ ] - this can have any value
between 0 and 1.0. The default value is 0.5.

All of the above options can be selected by clicking on the check box
beside each. By default only the Spearman and Parametric tests are
selected with equal weightings. 

The Allow linear and non-linear x-offsets shift section allows the
program to calculate if a small x-axis shift of up to the selected
amount will improve the matching results. This option is very slow,
and can add considerably to the run time, so should only be turned on
if needed. 

Two types of offset are allowed for: linear, and non-linear. By
default, the program to attempt to find the coefficients a0 and a1 for
the equation a0 + a1 sin θ, such that the matching result between two
patterns is maximised. The user can also select to use cos θ or sin 2θ
instead by means of the drop-down list. The a0 term corrects for the
zero point error. The cos θ option corrects for varying sample heights
in reflection mode, the sin θ option corrects for transparency errors
or, for example, transmission geometry with constant specimen-
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detector distance, or the sin 2θ option provides transparency and
thick-specimen error corrections.

Note that the calculated offsets are then saved for reference in a file
in the output folder named correlations_offsets.txt. They can also be
investigated interactively through the Numerical Results pane (see
Section 2.3.14). 

The values in the text-boxes correspond to the maximum shift
amount allowed in either the + or - direction, in terms of the
coefficients a0 and a1.

Comparing to Known Phases

Where known phases are provided, mark sample as unknown/
possible mixture when its match rank is less than [ ] 

If known phases are provided, each sample is compared to the known
phases on import. If the best match to a known phase is below this
cut-off level, the sample is marked as being a possible unknown, and
also then has quantitative analysis performed upon it. This option can
have any value between 0 and 1.0; the default value is 0.78. 

Detecting non-crystalline samples

Patterns that are imported are examined and marked as possibly non-
crystalline when both of the two conditions below are met:

No. of peaks is less than [ ] - this can be any value between 0 and
100. The default value is set at 2. This can be overridden by the
program if less than two peaks are present, but they have high
intensity values.

Amorphous value is greater than [ ] - this can have any value
between 0 and 100. The default value is set at 95. The amorphous
value used above is a measure of the percentage of a pattern that is
considered to be amorphous as opposed to crystalline. 

Fourier Power Spectrum Indicator is less than [] - as an additional
check, the power spectrum of the Fourier transform of the pattern
profile is examined to see how much signal is present at higher
frequencies. If there is no signal about the default value of 120, the
pattern is marked as amorphous if the peak setting requirements
above are also met. 

Peak counting is done after applying smoothing factor [] - this sets
how much the pattern is smoothed as part of the amorphous pattern
identification calculation; the default is level 5; with very noisy data
this should be reduced to 1 or 2 to prevent he occurrence of false
positives.
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Separate out non-crystalline samples in dendrogram display

The final option controls how the program behaves when it
encounters a pattern marked as possibly non-crystalline. With this
option checked, such patterns are not included when constructing the
dendrogram, and so stand out as individual patterns not connected to
anything on the right hand side. With it turned off, amorphous
samples are not distinguished from other samples in any way.

Patterns that are marked as possibly non-crystalline are highlighted
as such in the results display for the cell layout; see Section 2.3.4 for
more information.

5.7  Quantitative Options

Clicking on the Quantitative button from the Automatic Analysis 
Advanced Options window opens the Quantitative Options window.

Run quantitative analysis on patterns that are not similar to any
known phases provided - This option can be activated or deactivated
by clicking on the check box, and controls whether or not the
program performs quantitative analysis on samples it considers to be
possible mixtures. 

Perform analysis on all files regardless of similarity - normally, the
program only attempts quantitative analysis of samples that do not
much sufficiently well to any of the known phases, and ignores
samples that do match above a certain threshold. With this option on,
it will attempt to perform analysis on all input samples. Note that this
may result in spurious results, so use with caution.

It is possible to limit the maximum number of phases the program
will suggest as possible components in a mixture with the option:

Limit number of possible phases in a mixture to [ ]

This can have any integer value between 1 and 15. The default value
is 6; if the initial number of results returned is greater than the value
set here, only the top x results are reported (where x is the value
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entered here). The results which are reported can be further filtered
by means of the following two options:

Ignore any results below [ ] percent - can have any value between 0
and 100. The default value is 5%. This sets the smallest percentage
value which will be returned as significant; anything below this
cutoff level will be ignored.

or where the error on the largest result is greater than [ ] percent -
can have any value between 0 and 1000. The default value is 100.
This sets the level for the error value calculated for each phase. If the
error on a particular phase exceeds the amount entered here, it is not
considered as a possible phase in the mixture pattern. 

Use SVD-based analysis routines - by default, stepwise regression is
used to calculate the proportions of pure phases in a mixture;
selecting this option returns to the less accurate method used in
earlier versions of PolySNAP. This may be useful to recreate results
obtained from a previous version.

5.8  Clustering Options

Clicking on the Clustering button from the Automatic Analysis
Advanced Options opens the Clustering Options window.

Select Clustering Method

The program can use up to five different clustering methods to
attempt to explain the data provided. By default, the Group Average
Link method is selected.

Optionally, the program can use all of the methods, and then apply
various internal tests to automatically select the method which
produces the most self-consistent results. The disadvantage to this is
that program run-time may be dramatically increased as a result.
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The overall method employed is agglomerative hierarchical
clustering, using a distance matrix derived from the PolySNAP
match results correlation matrix. Initially all the patterns are assigned
to individual clusters which are then joined one pattern at a time.
When two clusters are so joined, a measure of the distance between
them is needed, and each clustering method has its own way of doing
this. 

In general, when two clusters i, j are combined, a new distance
between the cluster and an existing cluster k is calculated as:

The parameters αi, αj, β, and γ are different for each clustering
method used:

Single Link Method: 

Complete Link Method:

Weighted Average Link Method

Centroid Method:

Group Average Link Method:
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Advanced Options

Match 3D Plot Orientation

By selecting this checkbox the MMDS and PCA plots are both
rotated so as to be as closely in the same orientation to each other as
possible. This is to make for easier comparison. By default this
option is turned off.

With Scaling

Selecting this checkbox scales the plots up or down if necessary in
order that they take up roughly the same volume of the cube. Again
this option is available to make comparison easier.By default this
option is turned off.

In addition to the output methods displayed graphically in the main
PolySNAP output window, the clustering algorithms also all output
textual information to the logfile for the current run of the program.
This may be found in the program output folder with the name
SNAPlog.txt. The detail level of the text output can be modified by
the two checkbox options:

Verbose and Debug Mode Output

The Verbose and Debug Mode options control the level of output the
cluster analysis section of the program writes to the logfile for each
run. In normal program usage, both options are turned off.
Occasionally it may be useful to see more detailed information on the
clustering results, in which case Verbose option may be turned on. 

The Debug Mode option causes the program to output all of the
working matrices generated during analysis to the logfile, to aid in
debugging or solving very difficult problems. Note however that use
of this option can cause the logfile to become very large - possibly up
to tens of megabytes in size. It should be used with caution, as usage
of this option may also slow the execution of the program, especially
when large numbers of patterns are being analysed.

The two cut-offs for fuzzy clustering determine which patterns are
displayed in the fuzzy clustering output. As the fuzzy clustering is
only interested in outliers, only samples which score either below the
low cut-off, or above the high cut-off value are shown in the output.



Reset All
5.9  Reset All

There is a Reset All... button located at the bottom of the options 
window. Clicking this button resets all of the program options to their 
default settings. This option cannot be undone.
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CHAPTER 6 PolySNAP Tutorial
6.1  Introduction

This tutorial has been designed to guide the user through a few
examples using PolySNAP with typical data that might be
encountered in general use. It is not intended as a replacement for the
full program manual, but as a basic introduction to actually using the
program. It should therefore be read in conjunction with the manual
itself for a more detailed explanation where necessary.

The tutorial requires the user to have already installed PolySNAP, be
familiar with Windows-based interfaces. The data files used in the
tutorial are installed along with the software, and can usually be found
in the  tutorial  folder in C:\Program Files\PolySNAP.

.

6.2  Simple Automatic Pattern Matching

To gain experience with PolySNAP, a simple run using 21 X-ray
powder diffraction patterns is performed. The example assumes the
program defaults are used, and any more advanced options are
unnecessary.

To begin, launch the PolySNAP program from either the icon on
Windows desktop or via the shortcut in the Windows Start menu.

6.2.1  Selecting Input and Output Folders

Once PolySNAP has been launched the user is presented with an
empty window that contains only a menu bar. From this, the first step
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is to define the input folder containing the necessary patterns and the
output folder where the results are to be placed.

From the File menu, select Automatic Analysis and the Run on...
option. The following dialog box should appear.

1. To define the input folder containing the sample data files, click 
the Folder button in the top section of the dialog box. A folder-
selection dialog box will appear.

2. Select the drive containing the tutorial data from the pop-up
menu at the top. In this case, select C:.

3. Navigate to the folder C:\Program Files\PolySNAP\tuto-
rial\PS_simple_txt\. Ensure that the last folder of the desired path
(i.e. PS_simple_txt) is selected by double clicking it (the folder
icon should appear 'open').

4. Click OK. The selected path should be displayed in the upper
portion of the dialog box. Check it is correct; if it is not, repeat
the previous step.

5. In the Run PolySNAP on... dialog box again, ensure that the cen-
tral section of the dialog box has no defined folder, indicated by
the word '<None>'. If this is not the case, uncheck the checkbox
labelled Use Folder or Database containing Known/Reference
data files. The use of this setting will be explained later.
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6. The output folder where the result files are to be placed must be
defined. Click the third Folder button in the next section of the
dialog box. A folder selection dialog box will appear as before.

7. Select the local hard disk on your machine, which in this case is
C:. (Alternatively any other drive you wish to use for the output
data may be selected.)

8. Navigate to the folder you wish to place the output files. e.g.
C:\output\. If required use the New Folder button to create a new
folder. Ensure that the last folder of the path is selected by double
clicking it (the folder icon should appear 'open'). Note that you
cannot use the same directory for both input and output.

9. Click OK, and check that the desired path is displayed correctly.
10. Leave the Advanced Options settings to their default values (all

should be off except for Check for amorphous samples).
11. Finally, in the Run PolySNAP on... dialog box click OK.

The pattern files from the specified input folder will now be loaded
into PolySNAP.

6.2.2   Pattern Matching the Different Powder Patterns

PolySNAP is now in automatic mode, and proceeds by reading the
sample files from the specified input folder, and loading these into a
database located in the output folder.

Each pattern is loaded in turn, with the first pattern profile shown on
the top right and the most recently loaded profile below it. When all
21 patterns have been loaded the process will stop. 

The program now examines the input files, checking for amorphous
samples, matches the data files against one another, and then
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performs cluster analysis. When complete the results window will
appear.

6.2.3  Viewing the Results in the Cell Display

There are now a number of ways to view and examine the PolySNAP
results. The first of these, and default view displayed is the Cell
Display, which visually represents the contents of each sample cell.

Each cell (shown as a disc) represents a different pattern from the
input folder, with colour being used to denote the suggested grouping
of compounds. In other words, similar samples are given the same
colour. In the lower part of the window the sample information and
pattern display of the selected cell is available. The first sample cell
is selected automatically when the window is first opened.

1. In the Cell Display click on cell FORMD1. The associated full
pattern profile of pattern D1 is now displayed in the lower region
of the window beside the sample information. In this particular
case the information available is limited, so many of the fields are
blank.

2. Hold down the shift key and click on cell FORMD4. The cells
from D1 to D4 are now selected, and the sample information
pane now disappears, leaving only an extended view of the pro-
files of patterns D1, D3 and D4 overlaid to allow a visual com-
parison. From this view they are all obviously the same
compound.

3. From the Display menu select Offset Overlaid Pattern Profiles
and click on y-axis. This will now display the multiple patterns
with an offset along the y-axis of the plot, when any further cells
are selected.
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4. Hold down the control key and click on cell MIXT_2. The display
now includes this new fourth pattern, and to allow an easy com-
parison are displayed overlaid with an offset along the y-axis.

5. Zoom into the area between around 15° and 20° by holding down
the left mouse button and dragging a box over the desired area.
When the mouse button is released, the graph region is redrawn
to show just the selected area. Zooming in and out smoothly can
also be accomplished by clicking in the display and then holding
down the control key while moving the scroll wheel of the mouse
(if available).

6. To move around the area and position the view more accurately,
hold down the Alt key and left mouse button simultaneously
while dragging with the mouse - the display updates in real time.

These zoom and movement functions are the same for all graphical
displays within the PolySNAP program.

To check which of the plotted profiles correspond to which sample,
'hover' the mouse over part of the plotted line; a tooltip appears with
the sample filename in it.

This closer view of the overlaid patterns makes it easier to see that
the top pattern (MIXT_2) is noticeably different from the other
patterns - note the extra peak around 14° for example - and may not
actually belong to this group of compounds.

7. Reset the view with a right click of the mouse in the graph pane
and selecting Reset View from the pop-up menu.

6.2.4  Viewing the Results by Dendrogram

In the PolySNAP window there are a series of tabs just below the
menu bar, each of which display a different view of the data. Select
the tab labelled Dendrogram.
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The partitioning of the data into groups that were displayed in the
coloured cells is carried out by the cluster analysis of the sample
data. In PolySNAP there are five different methods of clustering
available, each of which tend to give slightly different results. The
program computes the best, in the sense of the most internally
consistent, dendrogram method and displays the results from that
(although the user can choose to view the results from the other
methods and overrule the selected one if required).

A dendrogram provides a visual display of the results from the
hierarchical method of data classification using cluster analysis. The
dendrogram itself takes the form of a tree-diagram in which each
terminal branch (coloured box) is representative of a single pattern
sample.

The higher up the similarity scale two samples are connected by a
horizontal line, the less similar they are. Hence samples FORMA1
and A3, with a similarity value of around 0.9 are very similar,
whereas samples FORMA1 and FORMC1, which are only joined
much further up the tree by a horizontal line with a similarity value of
around 0.4, are quite different.

In this dendrogram there are 6 separate clusters, each distinguished
by its own colour. These are the same colours displayed earlier in the
cell display and throughout most of the other PolySNAP displays.
The number of clusters are defined by the yellow cut-line which in
this case was initially set to 0.744. The calculation of this level is via
a number of statistics. The confidence levels on this choice of cut
position are shown by the yellow dotted lines either side. Selecting a
cut-line for a dendrogram is a difficult procedure, and the results
must be treated with caution. The program-calculated level therefore
should always be carefully examined by the user to see if looks
sensible.
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Adjusting the cut level upwards creates fewer separate clusters, and
effectively reduces the discrimination between differences; adjusting
the cut-level downwards creates more separate clusters.

1. In the dendrogram click on the yellow square cell FORMD1. The 
pattern profile of the sample is displayed.

2. Using the control key, also select cell MIXT_2. These are the two 
patterns that appeared different from one another when they were 
overlaid in the cell display. 

Looking at the position of the cut-line it is seen to be only very
slightly above the similarity line between cell MIXT_2 and the other
yellow cells. It can also be seen that another group (the dark blue and
light blue samples) has only just been split by it. With the confidence
levels indicated by the yellow lines being between 4 and 7 clusters, it
is possible that the present level is not ideal.

3. To manually adjust the cut-line, either click in the Dendrogram 
area and use the scroll wheel or hold down control and the left 
mouse button while dragging up or down. Move the cut-line 
down slightly so that it is still above the lower confidence line but 
so there are now 7 different clusters. Notice that the assigned 
colours change, and that cell 20 is now in a cluster of its own.

4. In the dendrogram area click the right mouse button and select 
Save Modified Trees...., to ensure that the changes are retained.
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5. From the Tools menu select List Pattern Cluster Members.... A 
dialog box will appear containing a list of the clusters.

This dialog box displays the different clusters with their sample
numbers and actual file names. From the file names used in this
demonstration example it can be seen that the samples are now all
properly grouped, with the two mixtures separate from the rest.
Notice in the dendrogram display that these two mixture patterns are
quite dissimilar to anything else, having a low similarity connection
value to their neighbours.

6.2.5  Viewing the Results by 3-D Plot

The samples can also be viewed by making use of the distances
between objects derived from the correlation matrix to give a
representation of the data in three dimensions. There are two
methods used for calculating the resulting 3-D plots: these are Metric
Multi-Dimensional Scaling (MMDS) and Principle Component
Analysis (PCA). They both give different views of the samples
because of the differences in calculation and will therefore give
slightly different results. The control of each plot is the same so only
the MMDS will be described here in detail.
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Select the tab 3D Plot (MMDS) (or PCA if you wish).

The initial view shows only the x and y axis, while the z axis lies in
projection. Each point represents a sample. The position on the plot is
taken from the MMDS calculation. The colour of each sample is
taken from the dendrogram display to allow easy comparison of the
results from these different methods. Allowing the mouse to hover
over a sample displays the sample label in a tooltip popup.

Samples that are similar are plotted close to one another, so are seen
to clump together in groups. Note that different coloured samples can
also be close, this shows that they also have similarities. This can be
seen by the yellow group being very close to the green sample, which
is pattern MIXT_2 and, when comparing to the dendrogram display,
is only separated from the yellow group by the current level of the
cut-line.

Also notice the number plotted at the top-left of the display, in this
case, 0.96. This is a correlation coefficient measuring the quality of
the 3D representation to the original data. The closer to 1.0 it is, the
greater the reliability of the results. This value tends to decrease
when larger data sets are used.

Use the following methods for exploring the 3-D plot.

Action Control

Rotate the 3-D plot Drag while holding shift key 
and left mouse button

Move plot laterally Drag while holding alt key and 
left mouse button
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The 3D plot is useful to spot patterns that are quite different from the
others, as they tend to stand out on their own and are not easily
grouped. Also, cases where the colours (from the dendrogram) and
the positions (from the MMDS) of the samples appear to contradict
each other are the samples that should be looked at manually in more
detail.

6.2.6  Creating a Report describing the results

A basic report of the calculated results can be automatically
generated using PolySNAP. This contains the information gained
from the data and optionally the graphical views of the results that
have been obtained.

1. Select the Report Writer tab.
2. From the Display menu, deselect the option Show Sample Labels 

If Available
3. From the Tools menu select Generate Report.... A dialog box will 

appear.
4. Select Summary Report. Deselect the checkbox labelled Include 

detailed sample preparation information, and then click OK. The 
report will now be generated and screen shots taken. This may 
take a few moments.

Alter size of spheres Drag up or down while holding 
control key and left mouse but-
ton

Zoom on centre Click in area, hold shift key and 
use mouse scroll wheel

Zoom on area Hold left mouse button and 
draw box over area

Select a sample Click on sphere

Select multiple cells Hold control key and select 
additional cell

Alter rendering quality Press F2 and adjust scale

(lower values are better for 
slower graphics cards)

Centre view Right click mouse and select 
Centre Selection

Reset view Right click mouse and select 
Reset View
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5. A Dialog box will appear confirming that "Report generation is 
now complete." Click OK.

The report begins by detailing when the calculations were done, who
was the user and on which computer. It then continues with the
settings used for the analysis and a summary of the results, including
the cell display and dendrogram. If the Full Report option had been
chosen, a more detailed report is presented, including output from all
of the main graphic displays. The report may be edited, or additional
information can also be added to the report manually, as in a standard
word processor, by using the simple formatting tools supplied.

For example, to add one of the profile plots to the report, select the
tab for that graph, right-click in the graph area or draw a box over the
desired area and choose Copy from the pop-up menu. Then select the
tab to return to Report Writer, click in the report at the point where
you want the image to be inserted, right-click and select Paste from
the pop-up menu.

6. To save the report, click the right mouse button and select Save 
as....

7. A dialog box will appear. Use this to navigate to a suitable folder 
where the data can be saved and select a file name. e.g. C:\out-
put\PolySNAP Report.rtf.

The report is now saved as an RTF file and can be opened and edited
in any standard word processing package.

To end this session select Close Window from the File menu. If
prompted to save changes to the report, select No because this has
already been done.
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6.3  Automatic Quantitative Pattern Matching 
using Known Phases

A more sophisticated pattern match might include a database of
known phases for comparison purposes. These are patterns that have
been previously identified and can be used to decide whether the
sample is a previously known substance, a mixture of known
materials, or something completely different.

6.3.1  Selecting the Input, Output and Known Phase Folders

To begin, the user should start with the empty PolySNAP window
containing the menu bar, as in the previous example.

From the File menu, select Automatic Analysis and the Run on...
option. The following dialog box will appear.

Set the input, output and known phase folders as before, except this
time we will additionally select a folder containing some known
phases prepared earlier.

1. To define the input folder containing the sample data files, click 
the Folder button in the top section of the dialog box. A folder-
selection dialog box will appear.

2. Select the drive containing the tutorial data from the pop-up
menu at the top. In this case, select C:.

3. Navigate to the folder C:\Program Files\PolySNAP\tuto-
rial\PS_simple\. Ensure that the last folder of the path
(PS_simple) is selected by double clicking it (the folder icon
should appear 'open').
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4. Click OK. The selected path should be displayed in the upper
portion of the dialog box. Check it is correct; if it is not, repeat
the previous step.

5. The known phase folder containing the known sample data files
must be defined. Turn on the checkbox labelled Use Folder or
Database containing Known/Reference data files. Click the
Folder button in the that section of the dialog box.

6. Select the drive containing the tutorial data, in this case D:.
7. Navigate to the folder C:\Program Files\PolySNAP\tuto-

rial\PS_simple\known\. Ensure that the last folder of the path (i.e.
known) is selected by double clicking it (the folder icon should
appear 'open'), and click OK. This folder contains an example
pattern of each of Form A, B, C etc.

8. The output folder where the result files are to be placed must be
defined. Click the third Folder button in the bottom section of the
dialog box. A folder selection dialog box will appear as before.

9. Select the local hard disk on your machine, which in this case is
C:. (Alternatively any other drive you wish to place the output
data may be selected.)

10. Navigate to the folder you wish to place the output files. e.g.
C:\output\. If required use the New Folder button to create new
folders. Ensure that the last folder of the path is selected by dou-
ble clicking it (the folder icon should appear 'open').

11. Click OK, and check that the desired path is displayed correctly.
12. Finally, in the Run PolySNAP on... dialog box click OK.

The pattern files in the specified input folder are now loaded into
PolySNAP, which proceeds to the matching and analysis phase
automatically after loading the 21 datafiles. 

When complete the results window will appear, with an initial view
of the Cell Display as before.
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6.3.2  Viewing the Results

The input files are now displayed in the Cell Display as in the first
tutorial example. However, it now looks a little different with cells
MIXT_1 and MIXT_2 being shown as pie charts.

Unlike the previous run, the colours here are not taken from the
dendrogram plot, but from comparing each sample in turn to the
provided known phases. Samples such as MIXT_1 and 2 that do not
give high matching correlation coefficients to any of the known
reference patterns are tested to see if they are mixtures, and if so,
quantitative analysis is performed. The results from this are
displayed in pie-chart form, the colours of each slice corresponding
to the pure phases listed in the key on the left hand side.

Another change to the view is the sample key - it now shows the
known phases FORM A to FORM E. By clicking on the colours of
the key all the samples matching the designated phase are selected.
For example, clicking on the red box labelled FORMA, cells A1 to
A4, as well as MIXT_2 are selected, as they are all of the samples
thought to either be, or contain, Form A. The key titles are taken
from the reference phase filenames.
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Select the tab labelled Dendrogram. This view is exactly the same as
in the first example, including cell 20 being contained within the
yellow group.

The reason for this difference between views is that the cluster
analysis does not take the known phases into account. Only the
results shown in the Cell Display are directly affected by them.
Because of the way they work, the dendrograms and other methods
merely show the similarity between samples without taking account
of the known phase information.

With the quality of data available for this sample the predicted
mixture composition is not very good, and the quantitative results
should therefore be taken as a very approximate measure, certainly
not accurate to any more than around 10% at best. This approximate
value could however be useful as a starting point for a more rigorous
analysis later.

6.4  Identification of Amorphous Samples

The first two tutorial examples of this tutorial have covered simple
PolySNAP procedures. This part will cover some of the more
advanced options available that include pattern matching while
allowing for a 2θ-shift, and automatic identification of non-
crystalline samples.

6.4.1  Loading Pattern Data from a Database

This time, instead of loading in the patterns from their original raw
data files, PolySNAP will be run on a pre-existing database that
already contains the patterns. This saves time on import, and also
would allow for additional processing to have been applied before
the analysis was run. To begin, the user should start with only the
empty PolySNAP window containing only the menu bar as before.
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From the File menu, select Automatic Analysis and the Run on...
option. The following dialog box will appear.

1. To define the input database containing the sample data, click the 
File button - not the Folder button this time! - in the top section 
of the dialog box. A file-selection dialog box will appear.

2. Select the drive containing the tutorial data, in this case D:.
3. Navigate to the folder C:\Program Files\PolySNAP\tuto-

rial\PS_advanced\, select the file PS_advanced.par, and click 
Open.

4. Ensure that no known phases are used by making sure the rele-
vant checkbox is turned off.

5. Define the output folder where the result files are to be placed. 
Click the third Folder button in the bottom section of the dialog 
box. A dialog box will appear.

6. Navigate to the folder you wish to place the output files. e.g. 
C:\output\. If required, use the New Folder button to create new 
folders, ensuring that the last folder of the path is selected by 
double-clicking on it (indicated by the folder icon being in an 
open position). Click OK.

7. Leave the Advanced Options settings at their default values.
8. In the Run PolySNAP on... dialog box click OK.

The pattern files in the specified database are now loaded into
PolySNAP, where it checks for amorphous samples, matches the
patterns with one another, and performs a cluster analysis. This may
take a little time to complete, but once finished the results window
will appear with an initial view of the Cell Display.
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6.4.2  Analysis of the Results

The 35 samples contained within the database are now presented in
the Cell Display.

The program is using the last few digits of the filename of each
sample to label them. Selecting pattern number 25505, the pattern
information display shows that it has been labelled as a non-
crystalline sample, which seems reasonable given its profile.

The other two patterns, 25506 and 26702 are similarly labelled for
the same reason. Identification of such amorphous samples is done
on the basis of checking to see if any signal (corresponding to peaks)
would be left after subtraction of the entire amorphous hump. The
method tends to err on the side of caution. 
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Looking at the Dendrogram tab:.

It is seen that three non-crystalline labelled patterns are placed on the
far right of the diagram with a zero similarity to the rest. This is
deliberate, in order to remove them from the main clusters. There
also appears to be one main grouping of the data - within which some
patterns seem much more closely grouped than others. Compare this
to the 3D (MMDS) plot:

Again, the three non-crystalline samples are quite separate from the
rest of the patterns. Both the dendrogram and 3D plots suggest a
loose grouping of the rest of the patterns, suggesting there may be
some differences between them.

Using the control key, click two patterns which are on opposite sides
of the main (yellow) group from each other, for example patterns
9401 and 69403. Examining their profiles, it appears that in addition
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to some preferred orientation issues, there seems to be a noticable 2θ-
shift between the otherwise relatively similar profiles:

Generate a full detailed report of the data including the graphics by
selecting the Generate Report option from the Tools menu.

This completes the initial analysis of the data, but the 2θ-shift in
some of the samples could be examined in more detail. From the File
menu select Close Window.

6.4.3  Reprocessing the Data allowing for an x-shift

When collecting powder diffraction data from a diffractometer the
sample or instrument alignment can result in linear or non-linear
shifts along the x-axis of the resulting pattern. This can especially be
a problem with the Bruker GADDS systems if the sample height
varies from sample to sample. This can give rise to systematic errors
in the pattern matching unless it is accounted for. However, to allow
for this is a time consuming process and should therefore not be used
unless such a shift is suspected - it is switched off by default. 

A general expression for the shift is:

(6.1) 

where the a0 coefficient corresponds to a linear (zero-point) shift
described earlier, and the a1 coefficient a non-linear component
[Zevin & Kimmel, 1995]. The requirement then is to find values of a0
and a1 that results in a maximum matching correlation result between
two patterns.

The same data as in the previous run will now be examined again.
Unlike the last time, the program will vary the x-offset parameters to
attempt to maximise the match result. 

Define the input database, known phases and output folder as before:

1. From the File menu, select Automatic Analysis and the Run on... 
option. Define the same input database as used before in the pre-
vious run of PolySNAP. 
D:\polysnap_tutorial\PS_advanced\PS_advanced.par.

2. Select None for the known phases directory.

∆ 2θ( ) a0 a1 θsin+=
175



176
3. Ensure that an appropriate output folder is selected. e.g. C:\out-
put\.

4. In the Advanced Options area, turn on the Allow x-shift calcula-
tion (sin theta) checkbox.

5. In the Run PolySNAP on... dialog box click OK.

The same data as before is now run allowing x-shifts on the patterns.
The time required to process this will take much longer than a normal
run of PolySNAP. For this data the calculation will take
approximately ten times longer than before - so prepare to be patient!

When finished, the initial output should look similar to the previous
run:

Now look at the 3D MMDS plot. Previously, it looked like this:

Now, with the option to calculate the best-offset value for each
pattern turned on, it looks like this:

The three non-crystalline patterns are still quite separate, but the rest
of the patterns have condensed together as a result of allowing for the
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2θ-shift, showing that a large part of the differences between the
pattern profiles was due to variation in sample heights during data
collection. The program still separates them out within this grouping
due to the preferred orientation problems.

Similarly with the dendrogram display, the similarity values between
the patterns are much improved. The remaining differences appear to
arise from preferred orientation effects, which are quite noticable in
some cases. For example, overlay the profiles of samples 401 and
69403: 

Create an auto-report on the run. This report will not have detailed
any manual changes that might have been made to the dendrogram
cut level. Therefore any information that has been changed can be
included by adding them manually or copying from the Logfile pane,
which details all the calculations and changes made during the
PolySNAP session. Note that the use of an x-offset calculation has
been noted in the output, as has the identification of the non-
crystalline samples.

In cases where there are a larger proportion of amorphous samples in
a dataset, it may be helpful to remove these samples and re-run the
analysis without them to give a clearer idea of what is going on. This
can be done automatically by selecting the Tools menu item Rerun
Analysis, and from the sub-menu selecting Ignoring All Non-
crystalline Samples.

A dialog box appears giving the opportunity to select an output folder
for the new run.

Selecting Use Default creates a new sub-folder in the current output
directory called Rerun_NoAmorph. A new analysis is performed, and
a new results display window is opened as before. Note that this time,
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there are no amorphous samples visible in either the dendrogram or
the 3D plots.

6.5  Using additional information: the 6D Plot

There are a number of methods for analysing groups of powder
diffraction patterns, some of which were detailed in the previous
examples. However, these methods only concerned the powder
diffraction pattern itself and not any other associated data that may be
available. For example, this additional information can include
sample preparation details such as the solvent used, concentration,
pH, volume, temperature, etc., and up to three of these can be
incorporated into the 6D-plot at one time.

6.5.1  Selecting Input and Output Folders

To begin, start with only the empty PolySNAP window containing
the menu bar.

From the File menu, select Automatic Analysis and the Run on...
option. 

Define the input and output folders as follows:

Input Folder: C:\Program Files\PolySNAP\tutorial\PS_6D-plot\

Known Data Files: <None>

Output Folder: As previous run.

Click OK. The pattern files in the specified folder are now loaded
into PolySNAP, which carries out pattern matching and cluster
analysis of the data as before. Once complete, the results window
will appear with a view of the Cell Display. 
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6.5.2  Analysing Results using 6-D Plots

The 16 patterns samples contained within the input folder are
presented in the Cell Display, where it can be seen that there seem to
be five different types of pattern.

When an individual pattern is selected it can now be seen that not
only is there a view of the pattern profile, but there is also textual
pattern information (on the left), and an image of the actual sample
well (on the right).

The sample information shown is embedded in the pattern data file,
but the source for the crystal well image is a separate JPEG-format
file (with an identical file name as the pattern data file), contained
within the input directory. Clicking on the image preview opens it
full-size in a separate window.

Select the tab labelled 3D Plot (MMDS). The following display
appears:
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This view displays several distinct main clusters with the cells spread
out along the x-axis. By selecting the cells individually, and
examining the sample information pane, it can be seen that there
appears to be a correlation between the solvent used in preparing the
samples, and the different groupings of patterns. For example, all of
the red samples are ones that were prepared with ethanol as solvent.

This information can be viewed more easily in a graphical manner,
by enhancing the 3D-plot by plotting additional information on it, in
the form of extra dimensions. For example, we can plot the different
types of solvent used in terms of different shapes, and different
reaction times in terms of different sizes of each plotted point.

1. From the main toolbar select 6D Plot.... At the top of the frame 
several options are presented.

2. Set the Plot option to MMDS.
3. Make sure the Ball Size option is checked, and select to plot 

Reaction Time.
4. For the Ball Colour option, select Dendrogram Colours.
5. Ensure Ball Shape is selected and set to Solvent.
6. Click Apply.

It can also be seen that while the plotted points are in the same
positions and colours as before, there are now several different sizes
and shapes on the display. Note that the different shapes are clustered
together - spheres are next to spheres, cylinders are next to cylinders,
etc. Select one of the sphere-shaped patterns by clicking on it. Note
that the solvent used in all of the patterns plotted as spheres is
ethanol; whereas all the patterns plotted as cylinders, for example,
used hexane. While this information was available before, it is easier
to spot trends in the data when viewed in this manner.

From the different sizes of shapes plotted, it can be seen that there
were three different reaction times used in this set of experiments.
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This may be seen more clearly by replotting the display, using colour
instead of size to represent the different amounts.

Deselect the Ball Size option, turn on Ball Colour and set it to plot
Reaction Time, and ensure Ball Shape is still set to Solvent. Click
Apply.

The new plot now looks like this:

The different colours - green, grey and striped, represent the differing
reaction times used. It is interesting to note that the two patterns 4
and 8 come up as separate colours - and hence times - from the rest of
the patterns they are plotted close to.

Switch to the Dendrogram tab. From the Display menu, uncheck the
option Show Sample Labels If Available. Notice that pattern 8, in
yellow, seems more separated than any of the rest of the yellow
patterns.
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We need to consider if the cut-line is positioned correctly. Switch to
the Validation tab and check that Scree Plot is selected in the pop-up
menu in the upper left corner.

The scree plot is one of the many methods used for estimating the
cut-level of the dendrogram, and can be a useful visual aid for the
user. It is derived from the eigenvalues of the pattern correlation
matrix. To interpret the scree plot the gradient between the values
(number of clusters) need to be analysed. Where the eigenvalues are
very different from one another there will be a steep gradient
between clusters. This is one of the methods used to select the
number of clusters. 

For this dataset the number of clusters suggested from this is between
4 and 5, because it is here that the plotted line changes colour, and the
gradient starts to level out. 5 clusters corresponds to the current cut
level; 4 would correspond to raising the cut line such that the green
and blue patterns were considered part of a single cluster. 

In cases such as this where the graphic displays may not give a clear-
cut solution, it can often be useful to examine the detailed statistical
output from the analysis. This is shown in the Logfile tab. Switch to
it, and scroll to the very bottom of the output. Scroll back up slowly,
until you see the output from the cluster analysis. One section of it
reads as follows:

 Summary of the estimates of cluster numbers:

 From principal components analysis (non transformed matrix): 5

 From principal components analysis (transformed matrix):     4

 From multidimensional metric scaling:                        4

 From the gamma statistic using single linkage:               5

 From the Calinski-Harabasz statistic using single linkage:   5

 From the C-statistic using single linkage:                   5

 From the gamma statistic using group averages:               5

 From the Calinski-Harabasz statistic using group averages:   5

 From the C-statistic using group averages:                   5
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 From the gamma statistic using the Ward method:              5

 From the Calinski-Harabasz statistic using the Ward method:  5

 From the C-statistic using the Ward method:                  5

 From the gamma statistic using complete linkage:             5

 From the Calinski-Harabasz statistic using complete linkage: 5

 From the C-statistic using complete linkage:                 5

 

 Maximum estimate is 5

 Minimum estimate is 4

 Combined weighted estimate of the number of clusters is 5

 The median value is 5

This suggests that 5 is indeed the correct number of clusters.

Go to the Dendrogram view, and select patterns 8 and another of the
yellow patterns. Consider their overlaid profiles - the similarity
between them suggests that the program was correct in its initial
placement of the cut line, and the reason 8 is separated somewhat
from the rest appears to be down to an x-shift.

6.5.3  Manual Matching

Select pattern 7. To get a better idea of what is going on with
particular patterns, sometimes it is useful to compare them manually
to the rest of the patterns. From the Pattern menu, select Manual
Match/Quantitative, and from the resulting sub-menu, select against
Sample database. A new window will appear. 

This window, the manual match window, has the selected pattern
shown in the bottom half. The upper half has the controls for the
manual matching. Click the Match button, and the selected pattern is
compared to each of the other patterns in the database in turn.
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The results are then displayed in a table in the centre part of the
screen. The most similar pattern to the selected pattern is that pattern
itself, which appears at the top of the list, with perfect correlation
scores of 1.0 in each of the 4 tests displayed. The results are sorted in
descending order of Rank value, which a user-controllable
combination of some of the individual matching tests. By default, it
is the average of the Spearman and Parametric tests.

Click on the number 2 in the first column of the second row. The
corresponding profile for that pattern is shown overlaid on the
original to allow visual comparison.

This pattern is the most similar to the selected profile, but has quite a
few obvious differences. This is reflected in the relatively low scores
that the pattern gets in each of the matching tests. This pattern
corresponds to pattern 11 on the dendrogram earlier, which that
method also identified as being most similar.

Click again at the same place in the first column to make the overlaid
pattern disappear. Now click on the number 3 to see what the next
most similar pattern is. This corresponds to pattern 3 on the
dendrogram display, part of the green cluster. 

Notice that the numerical results are much lower than for the
previous pattern, which supports the choice of the program to place
these patterns in separate clusters. 



Manual Matching: Working with Databases
To examine the differences between them on an individual peak-by-
peak basis, click the Match Peaks button. 

A small window appears showing the first two coinciding peaks, and
individual matching tests results between them. Clicking the Next
Peak button repeatedly moves through the marked peaks on the
selected patterns. Click Cancel to dismiss the window.

6.6  Manual Matching: Working with Databases

The rest of the examples in this tutorial demonstrate the manual
analysis section of PolySNAP. This mode can be accessed from the
Manual Analysis section of the File menu. 

The first thing to do is to create a new database of patterns with
which to work.

We first need to create a new database, which will initially be empty
We will then load some powder patterns into it, and work with them.
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Choose New Database from the Manual Analysis section of the File
menu. A standard Windows file dialog box appears, and you are
invited to choose a name and location for the new database.

Enter tutorial1 as the database name, select a location (C:/ for
example), and click Save. The dialog box disappears, and a new
window opens inside the PolySNAP workspace. 

This is our new empty database; its filename is displayed in the
window title bar. Like any other window, it can be moved around the
screen by clicking and dragging on the title bar, and can be re-sized
by dragging at the edges of the window.

The filename and your selected location appear in the Database
Information section of this new window. 

The number of patterns in this database is also displayed - as
expected, it is currently zero.

Several buttons are arranged along the bottom of this window. Most
of these are unavailable as there are no data files in the database. The
only one that is available for use is the Import button.

We now need to bring some pattern data files into the database. 

Click the Import button. We need to navigate to where the data is
stored. Locate the folder 
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C:\Program Files\PolySNAP\tutorial\manual_data

Once in the correct location, a list of different files in the folder that
the program recognises is listed. 

We want to open all of the files in this particular folder, so hit
control-A on the keyboard to select them all, and then click Open. A
new window appears with the pattern processing options. 

These will be discussed in more detail later, so leave them with their
default values for the moment and click OK. A progress bar appears
at the top of the database window to allow progress to be monitored.
As there are only a few patterns in the folder, this process should only
take a couple of seconds.
187



188
Once importing has finished, the patterns will be listed in the main
part of the database window:

If the window is too small to see all of the patterns, the scroll bar on
the right hand side can be used to view the rest, or you can drag the
window border to enlarge the window.

Each entry in the list represents one pattern file that has been
imported. 

Initially, the patterns are listed in the order they were imported. The
list can be sorted by either Pattern Name/ID, or Filename, by
clicking on the headers at the top of the list.

If some of the chemical names here look very similar to filenames
this is because the ASCII files we have imported do not contain any
chemical name information, so the filename is used instead. The
actual chemical name, if known, can be added manually later.

You can select a particular pattern in the list by clicking once on it.
When you do so, the other buttons along the bottom of the window
become activated.

The Import button has already been used. The Export button lets you
make a copy of a particular database entry to a separate file, in either
ASCII text or PolySNAP pattern format.

Remove deletes the selected pattern or patterns from the database. 

Experiment with these options by exporting a pattern to a separate
ASCII text file under the name exporttest.txt. Make sure to note
where you saved it! Then try importing the file you have just saved.
Finally, select the exporttest.txt pattern in the list and delete it from
the database using the Remove option. 

Removing patterns from the database does not in any way affect the
original data files which are left intact and unchanged throughout all
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operations performed using PolySNAP - the program works on a
copy of the data only.

The Match and Edit options will be dealt with in following sections,
so leave them be for the moment.

Now quit the program by choosing Exit from the File menu. All
windows will close. Note that any changes made to a database are
automatically saved, so there is no need to manually save any
changes before closing.

Relaunch the program again in the same manner as before. We want
to return to the database we have just been working with. You could
select Open Database from the Manual Analysis section of the File
menu, navigate to where the database was saved, select it and click
Open, but there is a much easier way.

The program keeps a record of the last four databases used in the
Recent Databases submenu of the Manual Analysis section of the
File menu. Open this now; one of the entries should be the

tutorial1.par database we were using earlier. Select it from the menu,
and it should start to open automatically.

Next, we want to examine some of the patterns we have just imported
in more detail.
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6.7  Editing Patterns

Select the pattern nh4no3.txt from the list in the database by clicking
once on it. Click the Edit button, and the Pattern Editor window
appears.

Several useful pieces of information about the pattern you have
selected are displayed in this window, and a plot of the pattern itself
is shown at the bottom.

The chemical name or pattern ID can be changed here by editing the
current name ("NH4NO3 -70 to 149°C Courtesy of Fraunhofer ICT")
in the white text box.

Details such as the pattern filename, its start and end angles, and the
number of data points are also displayed.
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There are three check boxes labelled Processing Options just above
the region where the pattern is displayed. To begin with, click once in
each of the checkboxes, so that they are all turned off:

Then click Apply. The graphing region should now look like this:

As you can see, the data has been scaled along the y-axis to run from
0.0 to 1.0. This operation is performed for all data being imported
into PolySNAP in order to allow for suitable scaling between
different data sets.

The raw data has also been interpolated from its original resolution,
to the PolySNAP standard 0.02 degrees. Again, this is for
consistency between patterns.

You can zoom into the pattern display, by clicking and dragging a
rectangle on the region you wish to see more closely:
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The view will then change to just the selected region:

To return to original view, right-click anywhere on the pattern
display, and select Reset View from the resulting pop-up menu.
Multiple zooms are possible by repeating the process.

Now click the Subtract Background checkbox, and then click Apply.
The pattern display should change:

The green line represents the raw pattern data. The blue line shows
the same pattern after the background level has been subtracted. To
see what the program considered to be background before
subtractions, select Show Background Curve from the Pattern menu.
A new window will open showing the subtracted background curve
where the blue line now represents what is subtracted as background.
Once you are finished looking, click Close to close this window and
return to the standard view.

Now click the Smoothing checkbox, so both it and the Background
Subtraction boxes are checked, and click Apply again.

The graph pane will be updated, and any noise in the pattern will be
smoothed out (shown here zoomed in).
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Finally, check the Find Peaks option, and click Process.

The pattern display will update, and several small blue circles should
appear on the top of the larger peaks:

These mark the location of what the program considers peaks. There
is a minimum peak height below which any peaks are ignored. This
is set as a default to 0.05, which is why the smallest peaks are
unmarked.

A list of the peaks the program has found is shown in the upper right
corner of the pattern editor:

This lists the peaks found in order of increasing Bragg angle, and
displays the corresponding intensity for each.

If the program has missed a peak you believe should be included, it is
easy to add manually. Note that peak locations are added to the blue,
processed pattern line, not the green, raw data line on the graph
profile.
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For example, if we wish to add the small peak that is located at
around 54°, just right-click once at the point on the graph where you
judge the peak maximum to be:

Then select Add Peak from the resulting pop-up menu. A round blue
peak marker should appear at the top of the peak, and an entry for it
should be added to the peak list:

If this does not appear, try clicking as close as possible to the top of
the peak. It may help to zoom in to the area of interest.

It is also possible to remove peaks you believe to be incorrect. For
example, say we wish to delete the marker from the peak around 18°:

Right click as close to the peak marker as possible, and select
Remove Peak from the pop-up menu that should appear. The peak
marker, and its corresponding entry in the peak list, should vanish.
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If the Remove Peak option is unavailable from the pop-up menu, you
have not clicked close enough to the marker. Zoom in to make this
easier, and try again. 

Finally, it is possible to adjust the minimum peak height threshold to
include less of the smaller peaks. Look at the slider just below the
peak list - it should be set to 0.05.

Drag the handle on the slider until it is set to about 0.25. 

Several additional peaks that were marked before should now show
up without peak markers, as they are now below the new minimum
threshold of intensity.

Finally, return the slider to 0.05. The peaks that previously became
unmarked should show up again.

Now click on the Advanced tab in the top-left of the window. 

The top section revealed allows us to mask selected regions of the
pattern to be ignored during matching or analysis processes. This
may be useful where a particular peak is negatively affecting results.
Say we wish to mask the peaks in the region of the pattern between
15° and 25°. Enter the start and end angles of the region to be masked
in the relevant text boxes. 
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Examine the blue processed pattern in this region to determine its
average background level – in this case, a value of zero should
suffice, so enter 0.0 in the level text box, and click Apply.

The change in the pattern should be quite noticeable – while the
green line of the raw data is untouched, the blue processed data line
no longer has any peaks or features between the ranges we have
entered:

Now repeat the process and mask the peak at approximately 90°
using the same method.

Once finished, return the pattern to its initial state by clicking Reset
All.

The rest of the Advanced tab options will be discussed in the
Analysing Mixtures section later in this tutorial.

Choose Close Window from the File menu to dismiss the editor
window. The program will check if you wish to retain any of the
changes made in the editor. At present you do not want to keep any
changes, so click No. You are returned to the main database window.

Feel free to look at some of the other patterns in the database in the
editor window, and investigate the various processing options.



Matching Patterns
6.8  Matching Patterns

Assume that you have just obtained a new, unknown, powder pattern.

You want to find out what pattern in your existing database it is most
similar to - and hence possibly identify what substance it may
represent.

First, close any currently open database or editor windows.

Now, go to the Manual Analysis section of the File menu, and select
Open...

Open the pattern database you created earlier, c:\tutorial1.par.

A new database window will open, and the pattern data will be
loaded into it.

The first step would normally be to import the unknown pattern into
this existing database in order to examine it. In our case however, it is
already loaded in the database.
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Locate the pattern Unknown.txt in the scrolling list of patterns in the
database, click once to select it, and then click on the Match button.
The main program match window will appear.

Our unknown pattern is displayed in the graph pane in the bottom
half of the window. Note that the pattern name and the database we
are using are listed at the top right. On the top left of the window are
the matching and analysis controls contained within two tabs –
Pattern Matching and Quantitative Analysis. The default tab is
Pattern Matching, which is what we wish to do first.

Click on the Match button. A progress bar appears as the program
runs through various tests in order to compare our selected pattern to
every other pattern in the database. Once matching is complete, the

centre section of the window fills with the numerical results, sorted
by the column in bold type, Rank.



Matching Patterns
To sort the results by a different column, click once on that column’s
header. To change the sort order, e.g. to sort a column ascending
instead of descending, or vice versa, click the header again. For the
moment, click on the Rank header to re-sort by this column, and
ensure the largest value (normally 1.0) is at the top of the list.

Look at the pattern associated with this value. This is what the
program considers the ‘best match’ to our unknown. If it looks
familiar, that is because it is – it is the Unknown.txt pattern itself.
Because it is in the database, it is compared to itself. If this does not
result in perfect match scores, there is a problem somewhere, so this
is a useful check. 

More interesting is the next entry down in the list. The next best
match has a rank value of above 0.9, quite close to the perfect score
of 1.0. The individual test scores reading along the row reflect this:
all close to 1.0. The rank value is calculated by default by summing
the Spearman and Parametric test scores and dividing by 2.0.

To see these scores reflected visually, we can overlay the best-match
pattern with the unknown pattern. Click once in the left-most column
of the pattern you wish to overlay (the one with ‘2’ in it in this case).

The ‘2’ is replaced by a coloured dot, and a pattern in this colour
appears in the graph pane. It is obvious the two patterns are very
similar. Click on the coloured dot in the left-hand column once again
to remove the extra graph.

This suggests our unknown sample is aspirin.

Experiment with overlaying different graphs on the unknown; this
helps to get a feel for how the pattern scores correlate to similarity
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between patterns. Several patterns can all be overlaid at once on the
graph; to clear them all in one go select Clear Overlaid Graphs from
the Graph menu.

6.9  Analysing Mixtures Manually

Using PolySNAP, open the database file quant.par in the tutorial data
folder. (Normally found in

 C:\Program Files\PolySNAP\manual_data)

It contains four patterns – one mixture, and the three pure component
phases.

We will use the program to quantify the amounts of each phase in the
mixture. Select the mixture from the list of patterns, and click Match
to bring up the match window.

Go to the Quantitative Analysis tab, and click calculate. After a few
seconds when a progress bar is displayed, the program should display
its answers.
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These are in a similar form as before, except that there are two
additional columns – Scale % and Std Dev – the amount of each
phase in the mixture, and the error on the calculation.

There are various ways available to see if the programs suggested
percentages are sensible. First, check the Scale Graphs box on the
upper left. 

Then click on the left-most column of the results table for one of the
phases. 

As before, this overlays the selected pattern over the mixture, but is
now scaled to the percentage intensity suggested by the programs
analysis. The pattern should hopefully look sensible. 
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Another option is to click the Residual button, which brings up a
window with two graph panes. 

The upper one superimposes a simulated mixture pattern, made up of
combining the pure phases in the amounts suggested by the program,
on top of the original mixture. The bottom panel is then the
difference between the two. This difference plot helps show up either
missing phases or extra intensity which is not part of the mixture. If
required, it can be output to a file to be imported as a new pattern at a
later date. In this case, the small amount of residual intensity suggests
the calculated answer is quite good.

Click Close to dismiss the window.

So far, we have quantified the mixture in terms of how much of each
of the pure phase patterns are required to make it up. A more useful
number in the real world would be in terms of the weight of each
phase used in the mixture.
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In order to calculate this, we need to add some additional information
to each of the pure phase patterns. To do this, first select the database
quant.par from the list of open windows in the Window menu. 

This brings it to the front. Now select the first pure phase pattern:
Phase 1. Click Edit to bring up the pattern editor window, and click
on the Advanced tab.

We need to enter information into the lower region of this window, in
particular the chemical formula of the phase, its unit cell dimensions,
and the number of formula units per unit cell. 

Using the information in the table, enter the relevant details for this
phase, and click Update. The fields showing molecular weight and
absorption coefficients and so on for this phase should update. If not,
be sure to enter the formula in the form

       <Atomic Symbol><No. of atoms> <AtomicSymbol><No. of atoms> etc.

(The allowed formats for formula entry are discussed in more detail
in section 3.3.11, Additional Pattern Information in the main program
manual).

Repeat for the other two phases.

Phase Formula a b c α β γ Z

Phase 1 Al2 O3 4.7592 4.7592 12.992 90 90 120 6

Phase 2 Ca F2 5.4649 5.4649 5.4649 90 90 90 4

Phase 3 Zn O 3.2501 3.2501 5.2071 90 90 120 2
203



204
Once all sets of information have been entered and updated, go to the
program Options dialog box in the Edit menu. 

Go to the Advanced tab, and make sure that the Calculate Weight
Fractions when all information is present option is checked. Then
close the Options dialog by clicking OK.

Click on the mixture pattern database entry to select it, before
clicking the Match button to bring it up in the main match window.

Return to Match window, and in the Quantitative Analysis tab, click
Calculate again.

This time, the results table should be slightly different – the results
should be headed Weight % rather than Scale %. If not, go back and
check that all of the three pure phases has had the extra information
added successfully.

If successful, the weight fractions should be close to:

Phase 1 – 2%

Phase 2 – 66%



Conclusion
Phase 3 – 32%

which are the correct answers.

6.10  Conclusion

This completes the basic tutorial. There are many other features and
options in the program that should allow much more complex
problems to be examined. Each of these are described in the full
program manual, which should be consulted for more information.
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CHAPTER 7 PolySNAP Release Notes
Please report any bugs or problems encountered that are not already
listed in the ‘Known Problems’ sections below via email to
snap@chem.gla.ac.uk

Version 1.7.2 - Build 3-4-07

Data files load much more quickly using the default settings than in
previous versions.

Updated copyright information in the Automatic Report Writer.

Fixed a problem where 'Rerun analysis…' options were not working
in Default mode.

A bug where paths entered at the command line would not work
correctly if the were enclosed in quotes has been rectified.

Fixed an issue in countries using the comma as a decimal point where
shifted patterns were not being displayed correctly in the Numerical
Results pane.

The 'Find' option for a selected Silhouette or Fuzzy Cluster is now F4
(previously F5).

A 6D-plot issue where the first two 'shapes' were shown as the same
shape has been fixed.

Selecting patterns from the Key in the Cell Display, and then
choosing 'Rerun Selected Samples' now works as expected.
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Entering information in the Advanced tab of the Pattern Editor is
now much easier, as tabbing between fields now works as expected.

The main Run On... dialog box has been slightly re-arranged.

A new program splash screen and window background are displayed.

The program version number is now displayed in program title bar.

The program, documentation and website now use the new Bruker
logo.

The main clustering analysis code is now more efficient and uses a
smaller memory footprint.

Version 1.7.1 - Build 1-3-07

Feature Additions

When x-shifts have been refined, clicking on an entry in the
numerical results pane of the Results window now shows the relevant
two patterns superimposed with the calculated optimal shift value.

A new feature highlights areas of a dataset where there is little or no
signal or marked peaks, and whose removal may improve the results
of the analysis (this notification can be deactivated by deselecting the
'Warn when areas of low signal are detected…' checkbox is the
Automatic: Advanced section of the program Options dialog box).

A new option has been added to force quantitative analysis to be
attempted on all input samples regardless of how similar they are to
the reference phases. This can be selected via the 'Perform analysis
on all samples regardless of similarity’ checkbox in the Options:
Automatic: Advanced / Quantitative options  dialog box.

Bug Fixes

Fixed a bug where a dialog box would repeatedly appear and could
not be dismissed when using the automatic report writer.

Quantitative results were not previously correctly showing up in
View Results mode; now they are.

Version 1.7.0 - Build 14-2-06

Feature Additions
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A new program operating mode has been added - Quality Control
mode. This allows the user to investigate if new samples are within a
user-specified cut-off of similarity to known reference materials - e.g.
for taking several samples over time to monitor production. Results
are shown on a 3D plot, with the references shown as a 3D surface; if
new samples are within this surface, they pass; if they fall outside the
surface, they fail, and the user is warned.

A new option in the Run On... dialog box allows reference phases to
be included in the main calculation - rather than keeping them
separate as before, they will also now show up on the dendrogram,
3D plots etc.

Two new tools have been added to the Validation pane - Parallel
Coordinate Plots and Space Exploration. These allow the user to
check that the suggested clustering remains valid in higher-
dimensional space. As a result of these additions, the Tools menu
option to Export Results for ClusterVision has been removed as it is
no longer required.

A new option in the Options dialog to Use Sample Preparation
information from an external file rather than the data file headers has
been added. When it is turned on, PolySNAP will look for a
<foldername>.dat file in the current data input folder; if that doesn't
exist, PolySNAP checks as before in the sample_info_format file for
a different file location; if that fails it then looks in the file headers.

If a database containing reference phase patterns with their unit cell
contents known is provided, PolySNAP can now calculate the weight
% for quantitative results as well as the scale %.

A new option allows the user to decide if the calculated simulated
mixture patterns used for checking quantitative results output are
constructed from the original raw profiles, or with processed (e.g.
background-subtracted) profiles. The default is to use the original
raw profiles.

A new Mask Regions dialog in Manual Mode (accessed through the
Tools menu) allows easier selection of multiple pattern regions to be
ignored during matching.

A new option has been added to the Matching Options dialog box,
allowing the user to set how much the pattern is smoothed as part of
the amorphous pattern identification calculation; the default is level
5; with very noisy data this should be reduced to 1 or 2 to prevent he
occurrence of false positives.
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To aid the clarity of interpretation, patterns on the dendrograms are
no longer drawn with a white border round them for very large data
sets.

ASCII data where the angle range runs from high to low can now be
correctly imported.

It is now possible to use the control-key to select multiple items on
the cell display key.

As a result of the use of a new, more flexible copy-protection system,
the License menu item has been removed from the Help menu as it is
no longer needed.

A copy of all of the PolySNAP tutorial data is now automatically
installed along with the program itself in a subdirectory of the main
program folder; normally C:\Program Files\PolySNAP\tutorial

Bug Fixes

A bug where the incorrect mu value for sulphur was being used in
absorption coefficients calculations has been corrected.

Combining peak-based and profile-based tests when also allowing an
x-shift no longer causes an incorrect correlation matrix to be
generated.

An issue where the residual pattern was not calculated correctly after
quantitative analysis when there were zeroes in the error column has
been fixed.

A problem introduced in PolySNAP v1.6.4 where it was no longer
possible to copy text from the numerical results pane has been
resolved.

A problem where reported errors on quantitative results were were
off by one when patterns in the results list had been marked as
ignored is now fixed.

A bug in the absorption coefficient calculation that could cause a
crash under certain circumstances has been resolved.

It is now possible to correctly manually match a sample pattern
against a reference database using the option in the auto-mode
Display window.

Version 1.6.4 - Build 29-9-05

The PolySNAP manual and other documentation has been



Version 1.6.3 - Build 4-7-05
comprehensively reorganised.

A new PolySNAP logo and program splash screen has been
introduced.

The user can now set the location of the sample_info_format.txt file
(used to specify parameters for 6D plots) in the Advanced pane of the
program Options window.

A bug that prevented more than 500 entries being displayed in the
Numerical Results display has been fixed.

A bug that prevented dendrogram colours being overlaid on 6D plots
has been resolved.

An issue where RAW v4 format files did not have their 'Comment'
and 'Chemical Name' fields read correctly was fixed.

Calculations of mu-star for quantitative analysis are now correct in
cases where different phases have different values of Z.

PolySNAP now supports basic read support of Bruker RAW files in
the new 21 CFR Part 11 compliant format.

Version 1.6.3 - Build 4-7-05

The basic menu structure has been simplified to clarify program
operation; the 'PolySNAP' sub menu is now named Automatic
Analysis, and all manual options are in the new 'Manual Analysis'
submenu. 

The tabs in the program Options dialog have also been renamed to fit
this new pattern.

The menu item 'Run Automatically' has been renamed 'Run on
Defaults'.

The 'Run On' dialog box now includes details of which shift method
is currently selected (sin theta, sin 2theta or cos theta), and also if the
'Strict' background correction option is turned on or not.

In unlocked demo copies, a new dialog box reminds users when the
demo will expire and how to register their copy.

More detailed information about the checking for amorphous
samples is now included in the logfile.

If no known phases were provided, the menu item to match against
them is now correctly disabled.

The user is now correctly informed if the fuzzy clustering did not
find any problems with a data set.

The requirement that a user have Administrative privileges to change
program settings is now off by default.

An issue where the Strict background subtraction could be turned on
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without first selecting the 'normal' subtraction has been fixed.

A bug where re-running silhouettes caused the graph pane to
disappear has been resolved.

Location of known phases are now reported correctly when they have
come from a database file, not a folder.

A bug in manual quantitative analysis where the presence of an
ignored pattern was preventing weight fraction calculation has been
resolved.

The Average Link method has been removed from the Clustering
options dialog box as it is the same as Group Average Link.

The program now checks if there are any other copies of the program
already running & exits if so.

A bug where selecting patterns to overlay from the numerical results
pane could cause a crash if shifts had been calculated has been
resolved.

A new graphics toolbar option has been added allowing line sizes to
be changed on the graphical plots.

Any changes made to the graphics colours are now reset when the
program is closed and opened again.

Version 1.6.2 - Build 27-5-05

A bug where the program would refuse a valid registration code if it
was entered after the initial time-limited demonstration period had
expired has been corrected.

Version 1.6.1 - Build 27-4-05

The splash screen has been updated to replace the University of
Glasgow logo with the new WestCHEM logo. Additonally, a list of
relevant references for the software has been added to the About
screen, which can be copied to the clipboard by right-clicking on
them.

The calculated % crystallinity is now output to the logfile for all
patterns, not just those considered to be amorphous.

Version 1.6.0 - Build 4-3-05

Feature Additions
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The Display menu now features the option Show Current Display in
New Window, which opens a copy of the current main graphics
display (e.g. dendrogram or 3D plot) in a separate new window. This
new display window can be resized, zoomed into etc., but changes
made here are not reflected in the main display; it is only a snapshot
of the current view which can be used to view several different
displays at once for comparison purposes. This menu item can be
used multiple times to open as many new display windows as are
required.

A new option in the initial Run On... settings dialog allows for the
selection of a restricted subset of the full angle range. With this
option selected, only this range of the patterns will be used for the
matching comparison.

A new sub-menu Tools -> Re-run Analysis... gives access to the
existing using Most  Representative Patterns option, as well as two
new options: Using Only Currently Selected Patterns, which takes
the current user selection of at least 4 samples on the display, and
performs a new analysis on just those items, and Ignoring All Non-
Crystalline Patterns, which performs an analysis of all samples in the
current run that were not flagged as possibly amorphous. Both the
latter two options give the option to select a location to store the new
output files in; the default location is a sub-folder of the current
output folder.

The way samples are labelled in the display has been drastically
changed. New options allow the format of a label in the filename to
be  set - either the full filename, or various subsets of it may be
selected. If the label is longer than 7 characters, only the last 7
characters are displayed; the full label may be shown by hovering the
mouse over the display until a tooltip appears. Labels are now always
off by default on the 3D plots, but can be accessed at any time by the
tooltip method described above. Finally, the menu item Show Well
Identity if Available has been retitled Show Sample Labels If
Available, to better reflect their new flexibility.

It is now possible to import data from ASCII text files with the .UXD
extension.

Bug Fixes

When the system locale is set to use the comma as the decimal
separator, ASCII files containing commas within the values for angle
or intensity are now correctly read in.

A bug where the fact that an x-axis shift was calculated was not
recorded in the automatic report writer has been fixed.
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An issue where manually matching against a reference phase
database gave incorrectly scaled Rank values has been resolved.

A bug that could cause a crash in certain situations where the View
Mixtures option was selected has been fixed.

Version 1.5.4 - Build 10-1-05

When zoomed into the dendrogram display, and changing the
selected pattern by means of the keyboard, it is now possible to
navigate across the entire dendrogram, not just the currently visible
portion.

An issue where nonsense results were generated in the quantitative
analysis when a pattern start angle was less than 0 has been resolved.

Version 1.5.3 - Build 5-11-04

A bug where quantitative results were not being calculated correctly
has been fixed.

An issue where the report-writer pane did not resize correctly when
the Pattern information screen was hidden has been fixed.

Version 1.5.2 - Build 15-9-04

Feature Additions 

An additional technique to help identify amorphous samples has been
added. This uses a Fourier Transform Power Spectrum to determine
if a given pattern has any useful structure. New options have been
added to the Advanced Matching Options dialog to control this. As
an experimental feature, it is turned off by default.

When using reference phases, the generated known phase database
file is now created in the program output directory, and not the
reference data directory as before. This approach means we need
only read access to the data, and not read-write to be able to use
known phases.

The Hide Group menu option has been renamed Mask Group, and is
now available for the dendrogram display as well as the 3D plots.

When a particular cluster grouping is selected using the Mask Group
option in the 3D plot, pressing the space bar toggles between hiding



Version 1.5.2 - Build 15-9-04
just that selected group, or hiding all of the other groups instead
while showing only the selected group.

It is now possible to show the colours from the Dendrogram as part
of a Modified 3D Plot (6D Plot), by selecting Dendrogram Colours
from the Ball Colour drop-down list.

Selecting two patterns to be overlaid in the main results window now
automatically shows the Rank correlation coefficient for the two
patterns in the Pattern Information pane titlebar.

The Toggle Mode option in the right click menu on the pattern graph
now displays all but the most recent pattern in the same colour, to
allow easier comparisons between a particular pattern and multiple
other samples.

An additional option in the 6D Plot allows the dendrogram colours to
be used as the Colour field for a plot. This is accessible from the
Colour drop-down menu item Dendrogram Colours.

The option to mask selected pattern regions from the Run On...
dialog box has been turned from a button into a checkbox. Selecting
the checkbox brings up the settings dialog. This makes it easier to see
if masking will be used for a given data set or not.

If appropriate, the installed serial number and the demo expiry date
are now displayed on the program splash screen.

The report writer has been updated to display additional program
references.

Bug Fixes

The program should now behave more reliably on international
systems when the system locale decimal separator symbol is set to
something other than "."

An issue where the use of the F5 key failed to locate patterns on the
graphic displays after a zoom or rotate operation was resolved.

A bug where patterns of different data ranges were not masked
correctly has been fixed.

Some issues that prevented the program being run in command line
mode were resolved.

Some issues that prevented the program running correctly when the
output folder was set to be on a remote network drive have been
fixed.
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A problem where the 6D plot did not fill the screen when the pattern
information pane was hidden was fixed.

An issue where the labels in the cluster member listings were not
output in the correct order in the logfile has been resolved.

Version 1.5.1 - Build 1-4-04

Feature Additions

The ability to display a colour-coded key for which patterns are
which on the graph display has been added; it may be toggled by
means of the item Show Pattern Key on Graph in the Display menu.

A new option has been added to the preferences to set the number of
datafiles above which label display will be off by default on the 3D
plots; this helps to prevent confusion when large numbers of patterns
are being plotted. The default is 60.

The ability to import data from the MDI ASCII output format has
been added.

The ability to hide or show the dendrogram axes has been added; it
may be toggled using the right-click menu item Show Axes.

A new option in the dendrogram and 3D plots allows the user to
locate a particular pattern by either pattern index, or pattern label.
This option, accessed via the right-click menu item Find Item...
brings up a tooltip to show where on the display the particular pattern
is located. The located item can optionally be selected and centred in
the display.

The new find pattern option is also integrated with the silhouette and
fuzzy clustering results display. Clicking on a silhouette selects the
corresponding patterns, after which repeatedly pressing the F5 key
3D plots are visible highlights each of them in turn. This allows
outlier or other suspicious patterns to be easily located.

An option to change the equation used to try to refine pattern offsets
has been added; as well as the default of D2q = a0 + a1 sin q, it is now
possible to select D2q = a0 + a1 cos q and D2q = a0 + a1 sin 2q as
alternatives, giving more flexibility to deal with different data
collection geometries.

Several program output files have been renamed to make them more
self-descriptive and consistent.



Version 1.5 - Build 20-3-04
References to the PolySNAP software have been added to the
automatic report writer.

The Advanced tab has been renamed the Validation tab to better
reflect its usefulness.

The default sphere size on the 3D plots is slightly smaller than in
previous versions.

Bug Fixes

Several bugs relating to updating the 3D plot colours after the cut-
level was altered have been resolved.

A bug where pattern selection was not possible on the 6D plot has
been fixed.

A bug where known phases were not displayed on the Cell Display
when Well IDs were showing has been corrected.

The program manual has been reorganised to give greater
prominence to the PolySNAP sections, and the installation chapter
has been rewritten to reflect the new installer mechanism.

Version 1.5 - Build 20-3-04

Feature Additions

PolySNAP can now work with up to 1500 patterns in a single run.

A new option has been added to the Run On... dialog allowing up to
three independent regions of the pattern to be masked at the start of a
standard program run. This makes this facility much more easily
available than in previous versions. 

Several new graphics options are available in the various 3D plots.
These include the ability to render the spheres with either partial
transparency or as dots, allowing any hidden features to be more
easily spotted. Facilities to employ a clipping plane, as well as to hide
or bring forward a selected colour group, make dealing with complex
plots and large data sets more practical. The ability to manually drag
pattern labels on 3D plots into different positions has also been
added, allowing for the creation of more professional looking plots
when creating diagrams for use elsewhere. These features are all
accessed through the right-click pop-up menu.
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A new tab, 6D Plot, has been added to make access to the multi-
dimensional plot easier. A more intuitive interface also acts as a key
as to what dimension is representing what information field. Once
created, a 6D plot now is not deleted automatically, so it is now
possible to switch between the other displays and the 6D plot without
having to redraw it each time. The Tools menu option previously
used to access this feature has been removed.

Another new tab, Advanced, has been created and contains several
options that may not be required in a straightforward program run,
but that could be useful in trickier cases. The Scree plot has been
moved here. New plots include Minimum Spanning Trees, Silhouettes
and Fuzzy Clustering. MSTs give a different way of splitting up the
patterns into different clusters, based on the maximum distances
between samples. Silhouettes and Fuzzy Clustering can give
information about particular members of clusters that should perhaps
be looked at in more detail - borderline cases, or possible mixtures.
New options in the clustering advanced options pane give upper and
lower cut-off values for the fuzzy clustering. Full details on these
new plots, their meaning, and how best to utilise the information they
give, can be found in the full program manual.

A new Tools menu item, List Most Representative Patterns…now
gives a list of the patterns considered to be the most representative in
each cluster. A list is displayed on the screen, and is also
automatically added to the logfile. Note that the results depend on the
current dendrogram cut-level, and also that different results will be
obtained depending on if the MMDS or PCA displays are selected
when this option is chosen.

A new Tools menu item, Rerun Analysis using Most Representative
Patterns… takes the current list of MRPs, and uses it to create a
known phases database using those patterns. The entire analysis is
then re-run for the current dataset, but now additionally using the
MRP known phases for comparison. The output from this re-run is
saved inside a new folder called MRP_rerun, which is created inside
the original output folder. This may help to identify possible mixture
patterns. However, caution should be used when examining the
results, as it is entirely possible one of the MRP patterns could be a
mixture itself.

A new Display menu item, Show Amorphous Samples on 3D Plots,
toggles whether or not samples flagged as amorphous are plotted.
This can make quite a difference to plots in some cases - especially
the PCA - as it often removes extreme outliers and therefore makes
seeing the actual clustering simpler.

When several profiles are displayed on the graph plot, control-
clicking to deselect one of them on the cell, dendrogram or 3D



Version 1.0.5 - Build 13-11-03
displays now correctly results in the relevant profile being removed
from the graph plot.

A new setting in the program Options dialog box, Extract Well ID
from Filename toggles if the last 3 or 4 characters of the pattern
filename (after a separating underscore character) represent the Well
ID of the pattern, and are parsed and used to identify the pattern on
the Cell Display and Dendrogram Display. 

The Dendrogram cut-level is now drawn as a solid yellow line; the
upper and lower confidence lines are now dotted yellow lines to help
increase their visibility.

The format of the report has been changed very slightly to output the
list of clusters including a separation colon, in order to make turning
it into a table in Word later more feasible.

If the user selects an output folder that already contains PolySNAP
output files, they are now warned before the older files are deleted.
An option to turn off this warning is available in the program options.
Additionally, an option to start each logfile afresh rather than
appending to any existing file is also available.

The Tools menu option List Pattern Clusters has been renamed to
List Pattern Cluster Members.

Program options are now saved in a file, snap.ini, in the program
directory (normally C:\Program Files\SNAP). This means settings
are persistent across multiple users on the same machine, and can be
more easily edited by hand if necessary allowing for simpler
troubleshooting.

Entries in the error logfile are now time and date-stamped. Some list
entries in the main logfile are now tidier.

Bug Fixes

An issue where an amorphous sample may sometimes appear by
itself on the left-hand side of the dendrogram rather than on the right
has been corrected.

Version 1.0.5 - Build 13-11-03

Feature Additions and Bug Fixes

Identified an issue that occurs on machines with Office 2000
Professional installed, when logged in as a non-administrative user,
219



220
who has never run an Office program on that particular computer,
and PolySNAP is run for the first time. The Office Installer pops up
repeatedly at various points when running PolySNAP, and great
persistence is required to dismiss it. This appears to be an issue with
the MS Office program, and the current workaround is to launch any
Office program, e.g. Microsoft Word, once and then exit it, before
launching PolySNAP for the first time. If this is done once, the
problem does not reoccur. For more information, see Microsoft
Knowledge Base Article Q298385: 

http://support.microsoft.com/default.aspx?scid=kb;EN-US;Q298385

An issue where the list of clusters obtained by selecting List Pattern
Clusters from the Tools menu was not correctly updated after saving
changes to the dendrogram was resolved.

An additional menu item, Show Graphics Toolbars, was added to the
Display menu. This allows the toolbar visibility to be set persistently
for an entire session.

The program installer now creates a shortcut to PolySNAP on the
Windows Desktop which is available to all users, and not just the
user who initially ran the installer.

An issue where the currently selected graph was reset to the initial
view when switching to the report or logfile panes was fixed - the
current view is now retained. 

An issue where the colours used to display peak profiles in the Peak
Compare window were reversed from those used to display the
profiles in main graph window was resolved.

A display bug where the Cell Display was failed to draw correctly
when the Display window is first created with some datasets was
fixed.

Various small issues with the tutorial documentation were corrected,
and some wording changed to make certain steps clearer.

Version 1.0.4 - Build 1-11-03

Feature Additions and Bug Fixes

The PolySNAP Run On... window has been redesigned to make it
easier to use. Options are given to turn on processing controls such as
background subtraction and allowing x-shift calculation on a per-run
basis. It has also been made the first entry in the PolySNAP main
menu.



Version 1.0.3 - Build 7-10-03
The security feature that prevents users without Administrative
privileges to access the program options can now be disabled if
required. Admin privileges are required to toggle this particular
option however.

A new preference option has been added to allow the location of any
installed GADDS software to be specified. Upon specifying a
location, the PolySNAP copies a script file to the GADDS script
directory automatically. This script file, DisplayFrame.slm, allows
for the basic integration between the Display window and GADDS
software.

A bug where a manual match against a known phase database failed
to work with certain patterns has been resolved [Bug ID: 000121].

A problem where turning off the option to separate amorphous
samples caused the cluster analysis to fail was fixed [Bug ID:
000122].

Version 1.0.3 - Build 7-10-03

Feature Additions and Bug Fixes

A bug where the program sometimes crashed when attempting to
view the numerical results pane after performing a match with an
offset has been resolved.

Version 1.0.2 - Build 13-8-03

Feature Additions and Bug Fixes

The program has been updated to read in and display the revised,
expanded format of sample preparation information. Fields that are
empty of information are now no longer shown in the sample
information pane.

It is now possible to view two patterns that have had a best x-offset
calculated shifted by the correct amount. This is accessed by
selecting the two patterns of interest in the Numerical Results display
pane, when the Display menu item Show Calculated x-shift is
selected. Additionally, the calculated offset values are shown in the
tooltip text for that cell after clicking.

A new option, Include Detailed Sample Information In Report, lists
each pattern by Well ID (if present), and the corresponding sample
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information fields, in the standard order and separated by semi-
colons. When the saved report is opened in Word, the Convert to
Table feature can then be used to turn this into a table for easier
reading.

Fixed a problem that prevented 6D customisable plots from working
in View Results mode, or when a database was used as the pattern
source [Bug ID #000117].

A bug that could cause patterns that were not mixtures to appear as if
they were after some settings has been changed has been fixed [Bug
ID #000116].

An issue where using the Reset All option for preferences did not take
effect for the matching settings has been fixed [Bug ID #000115].

PolySNAP no longer asks if you want to save the report when it has
no actual content.

A problem where a predefined masked pattern region in a SNAP
database would be lost when running PolySNAP on the data has been
resolved.

A bug which prevented the Most Representative Pattern (MRP) from
being highlighted on the 3D plots has been fixed.

The bug in which only the first page of the report or logfile would
print should hopefully be resolved.

A serious memory leak that occurred when non-linear shifts were
being calculated has been repaired [Bug ID #000118].

Version 1.0.1 - Build 7-7-03

Feature Additions and Bug Fixes

Added the facility to allow for a non-linear offset x-shift that varies
with sin q. This is accessed through the Options -> Matching Options
screen, and slows the matching operation down by around a factor of
4. Output from this is saved in the file distances_offsets.txt in the
program output folder.

A new facility, accessed through an extra checkbox in the PolySNAP
Options dialog that enables a 'strict' background subtraction on
import has been added.

To speed up the analysis, the default clustering method is now Group
Average Link (previously known as the Ward Method), instead of
Auto-Select. 



Version 1.0 - Build 30-4-03
A new option in the Display menu to toggle between showing
profiles with or without processing has been added.

If one of either of the PCA or MMDS plots are giving markedly
better results than the other, then that display will have two stars (**)
next to its name in the tab bar header to highlight that fact.

Fixed a bug that caused all but the first cell to be grey with a question
mark under it after the dendrogram cut-level had been modified
manually (Bug ID: 000054).

The default program wait between loading each pattern has been
changed to 4 seconds.

Fixed an issue where the standard background subtraction checkbox
setting was not being retained.

An issue where the program timeout was triggering far too soon
when loading data from a network drive should now be resolved.

An irritating problem where spurious error messages about images
were displayed when opening main results window has been fixed.

Fixed an issue that prevented Bruker Frame (*.gfrm) files from being
viewed in the GADDS software despite it being installed correctly.

Fixed an issue where the amorphous indicator failed to behave as
expected when any of the background subtracting options were
turned on.

Fixed a bug where the well identities on the dendrogram/cell display
were lost after changing dendrogram method.

Fixed a problem where DSC data was not importing correctly.

Version 1.0 - Build 30-4-03

Feature Additions and Bug Fixes

PolySNAP now pre-screens for patterns that have no signal, and does
not include them in the analysis. The logfile is updated accordingly.

After selecting a particular pattern in the cell or dendrogram display
with the mouse, the left and right arrow keys can be used to quickly
select and scan through adjacent samples.

The mechanism used to highlight the currently selected sample on
the 3D plots has been improved.
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The algorithm to identify samples that are entirely amorphous has
been enhanced, and now has a much higher success rate. See the
program manual for a description of the modified method. 

The algorithm to calculate components of a mixture has been
improved to make it less likely spurious phases are included in the
answer. See the program manual for a description of the modified
method. 

The dialog box that allows the user to list and examine all the
samples marked by the program as amorphous now lists patterns by
filename, rather than chemical ID field, as the latter is not always
present. It also now optionally displays the amorphous-subtracted
profile calculated by the program to allow the user a better
understanding of why a particular sample may have been flagged.

The clustering method previously known as Ward is now referred to
in the program and documentation by its correct name of the Group
Average Link method. Additionally, the option to use the Sum of
Squares method has been removed due to its poor performance.

Program instability and occasional crashes that occurred when a
large number of samples were marked as 'amorphous' has been
corrected.

An issue, also present in SNAP-1D, where the calculated error on
quantitative analysis could produce unrealistic values when going
from a scale to a weight fraction is now fixed.

A serious bug where changing the cluster method several times on a
large dataset, and then returning to original could give different
results in certain situations has been corrected.

Amorphous phases are now correctly labelled as such on the cell
display.

An issue where the automatic report generation could cause the
program to crash was resolved.

The 6D customisable plots are now more robust and reliable.
Additionally, the initial 'large' ball size no longer dwarfs the entire
display.

An issue where the Simplified Dendrogam option was not selecting
the expected patterns for display has been corrected.

Known problems/bugs in this build

Opening a Frame file in GADDS is untested and requires the user to
manually install a script file.



Version 1.0 - Build 30-4-03
Printing from the report or logfile panes can be unreliable at times,
depending on the current printer and operating system combination.
The recommended workaround is to save a copy of the document,
open it in Microsoft Word or similar, and print from that application.
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Beta Version - Build 10-04-03

Feature Additions and Bug Fixes

The pattern profile graph has been replaced with a more flexible
OpenGL based version. This allows for overlaid profiles to be offset
in the x or y directions, and individual profiles can be identified by
'tooltips' containing the corresponding pattern filename. The limit on
eight overlaid profiles has been lifted, and up to 1000 profiles can be
shown at once on the same display. The graph can now be copied to
the clipboard and pasted into the report or elsewhere. New options
have been added to the Display menu to allow control of these
features.

A basic automatic report can now be generated to order using the
Generate Report option in the Tools menu. The use can select a
detailed or summary report, and whether or not to include copies of
the graphics output.

Added the ability to directly import all current types of Bruker RAW
format files, including Diffrac-AT.

Code to change the behaviour of the program to prevent a non
Administrator user from changing program settings has been added.

When importing data from a network drive, the program should
recover transparently from most types of temporary network failure.

A goodness of fit indicator has been added to the 3D MMDS plot
(shown in the upper left corner), to give an indication of the quality
of the clustering results. Numbers closer to 1.0 are more reliable.

A new option in the preferences allows a backup copy of any report
to be automatically saved to a pre-defined location whenever a report
is saved manually.

Added the ability to save the report in ASCII text format.

Added the ability to open Bruker Frame files in the GADDS
software, assuming it is installed on the current machine, and the
relevant script file (DisplayFrame.slm) is installed in the GADDS
software scripts directory.

If filenames include the well ID of a sample (e.g. 1A01) this may
optionally be shown automatically in the cell and dendrogram
displays.

If sample images are present in the data directory, they are by default



Beta Version – Build 04-02-03
shown in thumbnail format next to the pattern profile when a
corresponding sample is selected. Clicking on the thumbnail opens
the full-size image in the system image viewer.

Fixed a problem where re-running the same datasets multiple times
could cause a memory overflow, resulting in nonsense results being
generated.

An issue where the Run On… dialog box did not remember the last
number of files set to import was resolved.

An issue that prevented the program from running to completion
when a database was selected as the data source in the Run On...
window was fixed.

An issue where the busy cursor was not shown during Change
Cluster Method operations was fixed.

The label to identify the 'Simplified' dendrogram has moved to the
top-left to be more obvious.

The program installer now checks to ensure that the system is
Windows 2000 or more recent, and refuses to install if this
requirement is not met.

Known problems/bugs in this build

Opening a Frame file in GADDS is untested and requires the user to
manually install a script file.

Printing from the report or logfile panes is not yet fully implemented.
The recommended workaround is to save a copy of the document,
open it in Microsoft Word or similar, and print from that application.

Crystallinity Problems - the program occasionally mis-identifies
patterns as being non-crystalline. This is currently being investigated
and a revised methodology is planned for the next release.

Mixture problems - the mixture identification routines are
unfinished. Additionally, the facility to manually override a program
suggested mixture component is not yet available.

Beta Version – Build 04-02-03

Feature Additions and Bug Fixes
An issue with the parsing of the sample info where the 11th data field
was not being read in was corrected.
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Added a 'None' button available in Options for the Known Phase
Database location, and fixed issue where it didn't work. The default
location for Known phases is now '<None>'.

Beta Version – Build 17-01-03

Feature Additions and Bug Fixes

The underlying SNAP-1D program is now upgraded to version 1.2.
See the SNAP-1D Release Notes for more information on changes.

A new menu item in Pattern Menu, Open Pattern Using EVA, allows
a selected pattern to be opened for viewing in EVA from PolySNAP.
This only works for single RAW files in the standard data directory,
and assumes EVA is set as the default editor for RAW files.

The Toggle Mode option in the right-click menu for the dendrogam
display now switches between the standard dendrogram, and a
'simplified' dendrogram. The latter displays only the first, last and
middle pattern in each cluster.

Upper and lower confidence bounds on the suggested number of
clusters are now plotted as dotted lines on the dendrogram display.

A new option in the right-click menu of the numerical results pane
brings up a window to show a difference plot for the selected pair of
patterns.

A new button has been added in the Options window to allow the
user return all preferences to their default values.

The program now checks that the weights entered by the user for the
selected matching tests sum to 1.0, and warns when they do not.

The Find Peaks preferences option is now no longer available as a
separate preference in PolySNAP, as there is no good reason for it to
ever be turned off.

The selection of the default input, known and output directories for
Automatic runs of PolySNAP has been simplified, and the user
interface improved.

Within a given program instance, the Run On... dialog box now
remembers the last location for each folder used each time it is
opened. The first time it defaults to the default program locations set
in the Options dialog box.

The interface to override the default amount of pattern smoothing has
been simplified to being a value from 0 to 10. 1 is the default amount.



Beta Version – Build 17-01-03
The contents of the PolySNAP data import window now resize
correctly when displayed on screens larger than 1024x768. 

The print mechanism for the report and logfile panes has been
changed in an attempt to circumvent printing problems where
spurious extra pages were being printed. There are now separate
Print Selection and Print options in the right-click menus; the latter
uses the experimental new printing mechanism, but requires to be
tested on-site.

A problem on slower machines where the Pattern Editor window was
opened, and the pattern display flickered badly, has been fixed. 

An issue where the directory listing in the Select Folder screen was
not updating after the New Folder button was used has been resolved.

Fixed a problem where the program would sometimes not exit
properly after an automatic run had been cancelled by the user.

Experimenting with the changing the clustering method in the results
screen no longer changes the default cluster method for the next run.

Fixed a problem where trying to plot too many profiles on the graph
caused the same error message to be repeatedly displayed.

Pattern filenames instead of chemical names are now shown in
results fields of the match window. 

Fixed a problem where nonsense values were sometimes being
written to the distances_offsets.txt file.

A problem with the parametric Pearson test behaviour, where results
between -1.0 and 0.0 were not reported correctly, has been rectified.

The Match All progress bar is now only displayed with more than 50
patterns, or more than 15 when an x-offset calculation is being
performed.

A new version of the program installer is now being used to prevent
problems that kept occurring when trying to install on certain
Windows 2000 systems.

Known problems/bugs in this build

[Bug ID: 000100] Amorphous phases are not correctly labelled as
such on the cell display yet.
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[Bug ID #000085] Customised 3D plots (aka “6D Plot”) are still
largely untested due to lack of data containing varied sample
information.

[Bug ID #000084] Graph Pane cannot be copied to the clipboard.

[Bug ID #000083] Button to open Frame files not working yet.

[Bug ID #000071] Amorphous Indicator calculation not always
reliable.

[Bug ID #000064] Preference setting to Subtract Background is not
always retained correctly.

[Bug ID #000056] Hardware graphics acceleration needs to be
switched off on some PCs or graphics display strangely.

[Bug ID #000054] View Results option does not take any notice of
known phases.

Beta Version – Build 17-12-02

Feature Additions and Bug Fixes

Match All code has now been optimised, resulting in roughly halving
the time taken for that part of an average calculation. For example,
performing Match All on 300 patterns took 3 minutes 20 seconds in
the previous beta version, and now only takes 1 minute 20 seconds.

A new option to allow a variable 2q-offset to be calculated for
patterns that may incorporate a shift has been added. This is accessed
through the Edit menu -> Options -> PolySNAP tab -> Matching
button -> Allow x-offsets of up to... checkbox. Note that the process
greatly adds to the program run-time, and at present, only offsets for
the Spearman and Parametric tests are calculated. A new results file
in the program output folder, distances_offsets.txt is now created.
This resolves [Bug ID/Feature Request 0000075].

New code has been added to improve system performance when the
program is waiting for the input directory contents to change during
an automatic run - the program now goes to sleep until it is sent a
signal by the system to wake and continue processing. This new
function does mean the interface is unresponsive during the sleep
period however. The maximum sleep time has been changed to one
minute as a result since system resources are not being used
otherwise in that time.



Beta Version – Build 17-12-02
It is now possible to change the number of files expected by the
program once an auto-run importing has started; the display and
internal counters are updated accordingly [Feature Request/Bug ID
#000061].

An option is added in the Display menu to view the dendrogram-
generated version of the cell display even when known phases are
present. This resolves [Feature Request/Bug ID: 000086].

A new feature is added that displays the multiple-pattern overlay key
in appropriate colours for the patterns, thus making it easier to see
which profile corresponds to which filename; this resolves [Feature
Request/Bug ID: 000069].

A new standardised function is used for all operations that involve
writing to the program logfile. This is more robust, as it checks for
the existence of the file, and creates it if necessary. It also uses more
modern file-handling methods, and resolves [Feature Request/Bug
ID 000096].

PolySNAP will no longer allow the user to set the program output
directory to the same location as the input directory. Error checking
of the input directories is also improved.

A problem where writing the cluster members list to the logfile with
more than 26 groups caused strange ASCII characters to appear has
been fixed, resolving [Bug ID 000046].

A problem where in some cases, switching between display modes,
or clicking twice in succession on the Dendrogram tab, causes a
saved, modified cut-level to be lost & replaced with the original
calculated version should now be resolved [Bug ID #000048].

The known phases key on cell display no longer repeatedly uses the
first file name for all entries; this key is limited to 8 characters, so the
last 8 characters of the filename (minus the extension) are used,
resolving [Bug ID: 000099].

Fixed [Bug ID: 000101] where the Match Now button on the import
screen did not work correctly in some situations.

Some problems with parsing sample data should now have been
resolved [Bug ID 000102].
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Beta Version – Build 08-11-02

Feature Additions and Bug Fixes

The most representative pattern (MRP) for each cluster can be
(optionally) shown in the 3D plot (it has spikes coming out of it);
selecting it brings up a dialog box reporting the mean pattern-pattern
distance for that cluster.

The colouring of the different clusters has been improved using
shading, so larger numbers of separate clusters can be told apart more
easily.

The quality of the plotting of the spheres in 3D plots can now be
user-controlled (press F2 when 3D plot is shown).

Improved cluster analysis code automatically selects the best
clustering method for the problem; this can be manually set or
overridden by the user if required.

The option to re-run using a different clustering method is much
faster than in previous versions.

Added an option to use an external graphics viewer (whatever the
system default for JPEG format images is) to look at sample images,
rather than the internal SNAP viewer.

[Bug IDs #000094 & #000095] Progress bars are now shown and
correctly updated during long, computationally intensive pattern
matching and cluster analysis calculations.

[Bug ID #000073] Fixed very annoying bug where changing the
dendrogram cut-level manually caused colour assignations in Cell
and 3D plots to become incorrectly sorted into ascending numerical
order.

[Bug ID #000066] Fixed a bug where some RAW data files were not
being fully imported correctly, and as a result data points were being
lost (e.g. with pattern DOMAXL_A01.RAW).

[Bug ID #000076] Fixed a problem parsing pat names of known
phases in certain situations that caused more known phases than
actually existed to appear in the cell display key.

[Bug ID #000070] We now display the short not full path name in
multiple pattern overlay key.

[Bug ID #000065] Fixed parsing code of sample information to not
expect units in the concentration field.
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[Bug ID #000050] We now hide 'x pats loaded out of y' labels on
import screen when doing View Results only.

[Bug ID #000074] On import screen, long file-paths no longer wrap
and look messy; they are truncated if necessary, and the full path can
be revealed via a tooltip.

[Bug ID #000077] The icon for 3D (PCA) plot is now no longer
incorrect in display screen toolbar - was showing icon for 2D plot.

[Bug ID #000052] Groups written to log file now do not use incorrect
carriage return character and thus display all on one line.

[Bug ID #000060] Online run with GADDS should not now cause
targets.txt file to be mistakenly imported as a pattern.

[Bug ID #000081] The graphics configuration preference files (*.cfg)
are checked for consistency before saved settings are read; this
should prevent problems where dendrogram lines appear to vanish
due to corrupted preferences values.

[Bug ID #000072] The estimated number of clusters and dendrogram
cut-level should now be correct and internally self-consistent.

[Bug ID #000097] Cell display no longer sometimes incorrectly
shows results as if known phases present even when they are not.

[Bug ID #000098] Re-running the clustering method no longer
causes tree3d.dat and score.dat files to be deleted incorrectly.

[Bug ID #000055] Hourglass cursor no longer often appears
randomly and for no good reason when left hovering over the
graphics displays.

A problem where program could hang when the return key was
pressed to dismiss the ‘Save Modified Dendrogram?’ dialog was
shown has been fixed.

Beta Version – Build 17-10-02

Modified test version.

Fixed bug where program would not run correctly given data on a
network drive.

Added an option to allow a re-run of the cluster analysis using a
different clustering method, via an option in the Tools menu of the
display screen.
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